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Introduction 
• • • • • • • • • • • • • • • • • • • • • • • • 

The Slick Tricks series is based on a simple idea: You don't have to 
know a lot about a computer or program to unleash its power and 

put it to work for you. By knowing a handful of useful, time-saving tips 
and tricks, you can get your work done faster and with much less effort 
than you might think. 

Today's sofnvare-even the operating system software that comes 
with your Macintosh- is rich in features . Most people don't take advan
tage of the features that can help them most because they don't have 
time to page through manuals or work through lengthy, often pointless 
tutorial exercises. But beyond the software's interface lies a wealth of 
tricks you can master easily, without wading tl1rough thick volumes of 
sofnvare documentation. You can flip tl1rough the pages of this Slick 
Tricks book and find hundreds of tips, tricks, and shortcuts to make 
your work easier. 

What Are Slick Tricks? 

Each and every page of this book is fuJI of tips, tricks, and shortcuts that 
make working on a Macintosh quicker, easier, and more productive. 

xiii 



xiv Introduction 

Most of the tricks are either short statements describing a specific short
cut you can use to do something faster or sequences of steps you can 
follow to perform a more complicated task. Actual screen illustrations 
help guide you along the way. You' ll find basic tricks you'll use all the 
time, like tricks for managing documents, customizing the interface, 

printing, and getting the most out of popular Macintosh applications. 
You'll also find more powerful customization tricks you can use to make 
your Macintosh look and work the way you want it to. 

This book won't start from the ground up to teach you the basics, 
though. You'll need to be familiar with basic Macintosh operating pro
cedures, li ke clicking, dragging, and using menus and dialog boxes, to 
get the most from this book. In addition, if you're still using System 6, 
it would be a good idea to upgrade before getting started, since many 
of the n·icks in this book apply only to System 7 sofuvare. Otherwise, 
you ' II miss out on some of the best tips this book has to offer. 

What You Need to Use These Tricks 

What will you need to get the most out of this book? In most cases, 
nothing but your Macintosh, the software that comes with it, and the 
willingness to try things for yourself. Most of the tricks presented in this 
book will work with just about any Macintosh model running System 7 
or later-including the new Power Macintoshes. And if you've got a 
PowerBook or Newton, you' ll find a chapter just for you. 

Your Macintosh system software is powerful, flexible, and fu ll of hid
den tricks that are covered within the pages of this book. It doesn't 
waste a lot of pages telling you how to use expensive utility software you 
might not have. But as you' ll see throughout this book, there are a 
number of useful utilities you can use to get more out of your Macin
tosh. You'lllearn what these utilities are and where you can get them
often for fi·ee! 



bJtrodttction xv 

Using a Slick Tricks Book . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

l. 
Trick 

Tip 

Trap 

Sidebar 

You can think of a Slick Tricks book as a cookbook-browse its pages 
and try out a " recipe" or two. Since these are fairly " right-brained" 
books, you may need to browse until you find the recipe you need. 
These short, friendly books can't possibly cover all the features of a system 
or program-if they did, you'd wind up spending more time wading 
through useless bits of information than learning the tricks you can re
ally use. 

You 'U see a number of icons in a Sliclz Triclzs book. A "Trick" is a 
hands-on procdure that shows you how to do something. A "Tip" 
gives you a helpful , general hint about how to approach a task or work 
out a solution to a problem. "Traps" tell you about procedures you 
should avoid. "Sidebars" provide background material for a particular 
topic. 

Each Slick Tricks book follows the general conventions of the system 
or program it's about. You'll find the keys you need to press in boldface 
type and any text you need to type in sans serif type, like this: Press 
Spacebar and type Letter. Ifyou need to press two keys at once, you'll 
see them with a hyphen between them, like this: Press Command-S. 
You'll see lots of keyboard shortcuts throughout this book because us
ing the keyboard is often faster than choosing from a menu. 

let's Get Started! . . . . . . . . . . . . . . . . . . . . . . . . . 
That's enough of an introduction. You can figure out the rest as you go 
along- there's nothing really complicated. Turn the page and start 
learning how you can tap the hidden power ofyour Macintosh. 
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Chapter 1 
• • • • • • • • • • • • • • • • • • • • • • • • • • • • 

Finder Tricks 

This chapter covers a wide variety of tricks you can use in the 
Finder-the program that creates the desktop interface of your 

Macintosh. Some of these might seem exu·emely basic if you've been 
using a Macintosh for a while, but even experienced Macintosh users 
will find plenty of treasures tucked away in tlus chapter. 

Keyboard Shortcuts and Other Tricks 

One of the toughest tl1ings for new Macintosh users to get used to is 
the mouse. After a little practice, however, mousing around will become 
second nature. Still, which do you think is quicker, using your mouse to 
select a menu command or pressing two or more keyboard keys to
get11er? If you'd like to reduce the number of times you need to reach 
for your mouse as you work, this section is for you. 

l 
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Use Your Keyboard to Choose a Menu Command 

Keyboard shortcuts for menu commands are among the most basic of 
Macintosh tricks. Because of standardization among the Macintosh 
operating system and most applications, many of the menu shortcuts 
are the same from program to program. This makes them easy to re
member. But even if you can't remember them, don't worry. The 
menus d1emselves provide a cheat sheet of keyboard shortcuts: 

0 Use yom mouse to pull down any Finder menu, like the File 
menu shown in Figme l.l. 

0 Note the keystroke indicators down d1e right side of d1e menu 
for most of the commands. Pressing one of these keystrokes 
performs the command mouselessly. So, for example, you can 
press Command-O to open a selected icon since d1at's the 
shortcut for the File menu's Open command. 

Use Extended Keyboard Keys for Menu Commands 

If you have an extended keyboard (one with the Function keys along 
the top), you may prefer to use the first four function keys for Edit 

mil 
New Fol'der :JflN 
Open 3€0 
Print 3PP 
Close Window 3€UJ 

Get Info 3€1 
Shar:irig: •• 
Ollplieate 000 
Make Alios 
Put Away agy 

Find ••• :Jflf 
Find Rgain 886 

Page: Setul:J ... 
Print W,lndow ... 

Figure 1.1 Keyboard 
shortcuts on the 
Finder's File menu 



Chapter 1: Finder Tricks 3 
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The Finder uses .th'e Commcfnd key (symbolized by What Those Symbols Mean • . ! ---~ - :~ -: . . - " ' -1- ' 

00) for all keyboard shortcJ!§tn~t lC!PP;~ar ;on its 

1 ... l· :~ :· ".: • , . 'menus: '11\ oth~r ~r;~grarT)~, ~?,~·?~eri Yq~~:rnavsee: 
. 9t~~r :s.v,~bpls forother keys. Rere's,a .completeillst: ' 

J 

Command KeVi 
1 

, , 

Option' Key , ·. 

Contrql Key" ' ' 
' 

Shift Key 
. ' 

Return: Key 

Enter'.K~Y ' 
·: Delete Key 

. , I , ; 

· Spacebar 

menu commands. These keys work in many (but not all) Macintosh 

applications: 

Fl Undo 

F2 Cut 

F3 Copy 

F4 Paste 

Use the "Secret" Keyboard Commands 
Not all keyboard shortcuts are documented on the Finder's menus. Apple 

provides four built-in FKEYs that you might find useful: 

+ Press Command-Shift-! to eject the floppy disk in the internal 

floppy drive. This is an especially useful command when your 
Macintosh is locked up or busy \Vith another task and you can't 

eject a disk any other way. If you have two floppy disk drives, 
Command-Shift-! ejects the disk in Drive l and Command-
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Shift-2 ejects the disk in Drive 2. (There's more on ejecting 
disks later in this chapter.) 

+ Press Command-Shift-0 to eject the floppy disk in an external 
floppy disk drive (if one is connected). 

+ Press Command-Shift-3 to create a picture in PICT format of 
your entire screen. This screen shot, which is saved to your 
startup disk, can be opened with TeachText version 7.0 or later, 
SimpleText, or any other graphics program. 

Use Your Keyboard to Select Icons 
On a System 7 Macintosh, you can also use your keyboard to select 
icons on the Desktop or in an open Finder window. 

+ Press a letter key to select d1e first icon with a name beginning 
with d1at letter. For example, pressing S selects d1e file called 
"Statement" in Figure 1.2. (If no icon name begins with d1e 
letter you pressed, the icon with a name that follows that letter 
alphabetically is selected.) 

+ Press Tab to select the next icon alphabetically. In Figure 1.2, 
if "Statement" is selected and you press Tab, "Teach Text" 
becomes selected. You can also press Shift-Tab to move back
ward alphabetically. 

Stuff 
16 items 151 .7 MB in disk 9.1 MB available 

Disinfectant fm 
Other Stuff f 

Address Book Mortgage 

" 

~ 
Teach Tex t fi 

Statement 

II 
MT&T V3,18 

OneNet Member D 
~ 

EP Sounds 

\ Fax~hio 
ResEdit 

[i 
Read Me Voting Booth For m 1 .1.sit 

Ele-ctronic Pen ~ 
Important Stuff '{i. Macintosh Tips & Tricks, 08/94 

1¢ 1 

Figure 1.2 Working with icons in Icon view 
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+ Press an arrow key to move from one selected icon to the next 
one to its right, left, top, or bottom. In Figure 1.2, if "State

ment" is selected and you press Right Arrow, "MT&T V3,I8" 

becomes selected. (The Right Arrow and Left Arrow keys work 

in icon views only.) 

Use Your Keyboard to Rename Icons 

Once you've selected an icon, you can use your keyboard to rename it. 

0 Press Return or Enter while an icon is selected to select its 

name. This is illustrated in Figure 1.3 . 

G To change the name, type in a new name while the entire 

name is selected. 

0 To move the insertion point to the end of the name, press the 
Right Arrow key while the entire name is selected or the 

Down Arrow key while the insertion point is within the name. 

To move the insertion point to the beginning of the name, 

press the Left Arrow key while the entire name is selected or 
the Up Arrow key while the insertion point is within the name. 

8 To move the insertion point one character at a time, press the 
Right or Left Arrow key while the insertion point is within 

th e name. 

8 To accept th e nan1e change, press Return or Enter while the 
insertion point is within the name. 

Use Your Keyboard to Open Icons 
Once an icon is selected, you can use your keyboard to open it or its 

parent folder. 

+ Press Command-Down Arrow to open a se lected icon. (This is 
the same as pressing Command-O which activates the Open 

command on the File menu. ) 

Figure 1.3 Selecting an icon name 
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+ Press Command-Up Arrow to open the window that the cur
rent window is in (it's "parent" folder or disk) . For example, if 
the "Stuff' folder were inside the "Documents" folder, pressing 
Command-Up Arrow while the "Stuff' window was open 
would open the "Documents" folder. 

+ Press Command-Shift-Up Arrow to make the Desktop active. 

Use Your Keyboard to Expand and Collapse Outlines 
The keyboard also lets you expand and collapse outlines in list views. 

+ Press Command-Right Arrow to expand the outline of a folder. 
This is shown in Figure 1.4. Press Command-Left Arrow to col
lapse a selected, expanded folder. 

+ Press Command-Option-Right Arrow to expand all levels of 
an outline of a selected folder. Press Command-Option-Left 
Arrow to collapse all levels of a selected, expanded folder. 

Use Your Keyboard to Scroll Through Finder Windows 
If you have an extended keyboard (the one with the function keys along 
the top), you can use yom keyboard to scroll through Finder windows 
displayed in List view. 

~ Siu Kind 

~ Addre-ss Book 69K 

\I) Dis infPchnt 351K 

~ El e-ctronic Pen 6K 

~ EP Sounds 5 16K Ru Edit documeont 

00 Fax Graphic 3K Mac Dr a \If Pro docu .. . 

""• - folder 

'II Loiter to Bob 6K 

'il Leiter to Bob2 15K 

'i!l Loitor to Laura 12K 

'il l etter to Mikt 6K 

'il Leiter to Norbert 9K 

'il letter to Tom 3K 

I> (i:J 
m 183K 

12K 

Figure 1.4 Working with icons in List view 
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• Press Page Up or Page Down to scroll the window contents up 
or down. 

t Press Home to view the first group of fi les in the window. 

t Press End to view the last group of files in the window. 

These keys also work in directory list windows inside Open and Save 
As dialog boxes. Note that pressing one of these keys does not select an 
item-it only changes the window view. 

Use Your Keyboard in Dialog Boxes 
You can use some keystrokes to select buttons and navigate through 
folders inside the dialog boxes displayed by many applications. Here's a 
list of keystrokes that you can try: 

Keystroke 

Enter (and often Return) 

Esc or Command-. 

Up or Down Arrow keys 

Page Up or Page Down 

Home or End 

Command-Up Arrow 

Command-Left Arrow or 
Command-Right Arrow 

Tab 

Results 

Chooses the default button (the one 
with the dark border around it). 

Chooses the Cancel or Close button. 

Selects previous or next item in a 
directory window. 

Displays the previous or next window
fu l of information in a directory win
dow. 

Displays the first or last windowful of 
information in a directory window. 

Selects parent folder in a directory 
window. 

Displays the contents of the previous 
or next mounted disk in a directory 
window. 

Moves from one edit box to the next 
in most dialog boxes; moves from di
rectory list to name edit box in a di
rectory window. 
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Command-D 

Letter key 

In a directory dialog box, displays 
the desktop level (the same as click
ing the Desktop button). 

Choose the first file or folder begin
ning with that letter in a directory 
window. 

In some applications, pressing the key that corresponds to the first 
letter on a button chooses that button. For example , in a dialog box 
with buttons for No, Yes, and Cancel, pressing N chooses No. In other 
applications, you may need to hold down the Command key while 
pressing the letter key for this to work. 

Use the Type-Ahead Buffer 
Your Macintosh can store up to 20 keystrokes in a buffer. It does this 
when it's busy performing other tasks (like saving a file, sending a file 
to the printer, or opening a dialog box), so you don't have to wait until 
it finishes. 

You can use this feature to your advantage by entering keystrokes you 
know your Macintosh will expect. For example, say you want to print 
two copies of pages l through 3 of a document. With the document 
open, use the keystrokes listed on the left side of the following table 
without bothering to wait for your Macintosh to catch up. The right 
side of the table explains what each keystroke does . 

Command-P 

2 

Tab 

l 

Tab 

3 

Return 

Opens the Print dialog box 

Enters 2 in the Copies box 

Moves to the From box 

Enters l in the From box 

Moves to the To box 

Enters 3 in the To box 

"Clicks" Print 
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Don't Overtype the Buffer 

If you type more than 20 characters ahead, your Macintosh will loose 
some of the characters you type, beginning with the first ones. In 
other words, yom Macintosh remembers only the last 20 characters 
you type. So don't type too much while your Macintosh is busy do
ing other things. 

Option Key Tricks . . . . . . . . . . . . . . . . . . . . . . . . . 
In the Finder, holding down the Option key often changes the way 
menu commands and mouse actions work. Sometimes, you can even see 
the command name change on the menu. For example, hold down Op
tion and pull down the Finder's File menu. Back in Figure l.l, the 
second command was Close Window. In Figure 1.5, however, you can 
see how the command changes to Close All. In this section, you 'll find 
some ways the Option key can change a command. 

New Folder 3€N 
Open 3€0 
Print 3€P 
Close Rll 

Get Info 3€1 
Sharing ..• 
Duplicate 3€D 
Malee Alias 
Put Away 3€Y 

Find ••• 3€F 
Find Rgoln 3€6 

Poge Setup ... 
Print Deskto ... 

Figure 1.5 The File menu with 
the Option key held down 
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1.:~ - Close All Windows 

Hold down Option and choose Close All from the File menu to close 
all open Finder windows. This also works if you hold down Option 
while clicking in the topmost window's Close box. If you prefer to do 
this mouselessly, press Command-Option-W. 

Open One Window While Closing Another 

Hold down Option and choose Open from the File menu to open a 
selected icon and close the window the icon is in. This also works if you 
hold down Option while double-clicking an icon. If you prefer to do 
this mouselessly, press Command-Option-0 or Command-Option
Down Arrow. 

You can also do this in reverse. Press Command-Option-Up Arrow 
to open the parent folder of the current window while closing the cur
rent window. 

Empty the Trash Quickly 

Hold down Option and choose Empty Trash from the Special menu 
to delete the contents of the trash without seeing a warning dialog box. 
This also makes it possible to delete locked files without tmlocking them 
first. 

Clean Up Icons 

The Clean Up Window (or Clean Up Desktop, depending on which 
is active) command on the Special menu organizes icons, or small icons, 
neatly within a window by moving tl1em into tl1e nearest available space 
in an invisible grid . Figure 1.6 shows a "cleaned up" version of the same 
window we saw in Figure 1.2. (If you want to organize only a few icons 
in a window, select the icons first, tl1en hold down tl1e Shift key while 
choosing Clean Up Selection from d1e Special menu.) 

Holding down tl1e Option key while pu lling down the Special menu 
changes this command to Clean Up by Name, Clean Up by Date, 
Clean Up by Size, or Clean Up by any other View menu option. This 
makes it possible to organize icons neatly in alphabetical, date, size, or 
other order. 
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~--i"'£' = Stuff Iii[ 

16 itoms 154.2 MB in disk 6 .7 MB avai1ab1o 

e Q 

Oisinftotant @;] 
~ 

> 

~ -Othor Stuff I 

TuchTox t Addrus Book Mcrtgago 

~ II ~ 
St atomonl MT&T Y3 ,18 \ Fax Graphic 

~ RosEdit it EJ EP Sounds Voting Booth Form 1.1 .sit 

a . 

~ R .. d Mo 

OnoNot Mombor @ E1~tronio Ptn [@] . 
Macintosh Tips & Tr icks, 08/94 Important Sluff ~ 

1¢1 Jc:> Iii 

Figure 1.6 A cleaned up window 

How do you specify which Clean Up option should appear? Try this 
example to Clean Up by Kind: 

0 Choose by Kind from the View menu. The active window's 
icons organize alphabetically by the type of icon (application, 
control panel, document, system extension, etc.). 

0 Choose by Icon from the View menu. The active window's 
icons appear as icons in the window. 

0 Hold down Option and pull down the Special menu. The 
Clean Up command should read Clean Up by Kind since by 
Kind was the last view you used before switching to Icon view. 

Not only does the Option key make it possible to organize icons by 
a certain view, but it also moves the icons closer together. It does this 
by moving icons into the first invisible grid spaces they fit into rather 
than the grid spaces closest to their original position. 

Zoom a Window to Fill Your Screen 
Hold down Option and click in a window's Zoom box to zoom the 
window to almost full screen size. The rightmost side of the screen re
mains uncovered by the window so you can still get access to disks and 
the trash. 
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Copy an Icon to a Different Location on the Same Disk 
H old down Option while dragging an icon from one window to an
other on tl1e same disk to copy that icon ratl1er tl1an move it. 

Command Key Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
The Option key isn' t the only key that can do tricks. Holding down the 
Command key while perfo rming certain actions witl1 the mouse can 
also yield a few useful surprises. 

Move a Window Without Making It Active 
H old down Conunand while dragging an inactive window's Title bar 
to move it wid1out making it active. 

Display a Window's Secret Menu 
H old down Command while clicking on the title of a window in its 
Title bar. A menu showing the path to d1at window appears. This is 
illustrated in Figure 1.7. To make anod1er window in that path active, 
choose it from tl1e menu. 

Reverse Grid Settings 
Hold down Command while dragging an icon to temporarily reverse 

the Always Snap to Grid settings in the View control panel. (More o n 
d1e View control panel later in tl1is chapter.) 

Multiple Icon Tricks 

Sometimes you need to work with more than one icon at a time. This 
section has some tips for selecting and moving multiple icons. 

16 ilems 

Figure 1.7 A w indow's secret menu 
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Shift-Click to Select Multiple Icons 

H old down the Shift key while clicking on each icon you \Vant to select. 
You can also deselect one or more already selected items by holding 
down the Shift key while you click on them. 

Draw a Selection Box to Select Multiple Icons 
Use yom mo use pointer to "drag" a selection box around the icons you 
want to select. You can see an example of this in Figure 1.8. Any icon 
that is even partially inside the selection box will be included in the 
selection. 

Select All/cons in a Window 
Choose Select All (Command-A) from the Edit menu. This selects all 
the icons in a window. 

Select Almost All/cons in a Window 
If there are 20 icons in a window and you need to select, say, 18 of 
them, do you Shift-click on each one? You could, but there's a better 
way. Try this : 

0 Choose Select All (Command-A) from the Edit menu to 
select all the icons in the window. 

16 lttms 

Dlsinftct•nt 

~ 
TtaohToxt 

OntNot Mombor 
Ru dMt 

~ 
M•clntosh Tips & Tricks, 08/94 Important Stuff 

Figure 1.8 Dragging a selection box to select 
icons 
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0 Hold down Shift and click on the icons you don't want 

included in the selection. 

Use Outline Views to Select Icons in Different Folders 
I f you need to select a group of icons but they're in differen t folders, an 
outline in a List view can help. Here's how: 

0 Open tl1e window containing the folders witl1 icons you want 
to select. 

0 I f tl1e window is not in a List view, choose any opti on except 
by Small Icon or by Icon from tl1e View menu. 

0 Click on ilie u·iangle icon before the folders containing the 

icons you want to select so that the triangle points down and 

ilie folder opens as part of an outline. Do this for each folder 
containing an icon iliat you want to select. When you're fin 

ished, all icons should be displayed. You may have to use tl1e 

vertical scro ll bar to see them all. 

8 Hold down Shift and click on each icon you want to select. 

Use tl1e scroll bar if necessary to sec and click on them all. The 

results are illustrated in Figure l. 9. 

Move or Copy Multiple Icons 
Once you've selected multiple icons, you can drag all of tl1em by drag

ging only one. Use your mouse to "grab" one of tl1e selected icons (be 
sure you are not pressing the Shift key when you grab it or you may 

deselect it) and drag it to a new destination. When you let go of your 

mouse, all selected icons wi ll move to tl1e new location. 

View Customization Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
The Views control panel (illustrated in Figure 1.10) lets System 7 users 
customize window views and ilic commands on tl1e View menu. 

Change File Name Size 
U se the font and font size pull-down menus to change the way fi le
names appear in windows. Having trouble reading the defau lt 9-point 
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Figure 1.9 Selecting icons in different folders 
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Geneva font? Make it bigger! You can type just about any number into 
the font size edit box. Just be aware that a large font size might cause;; 
part of a filename to get cut off in List views. 

Choose a Straight or Staggered Grid 
Use radio buttons to choose a Straight or Staggered Grid for Icon 
views. Staggered grid is especially useful if the files ctisplayed in icon 
view have long names. 

1 Ulews --

Font for vi•ws: ~G_e_ne_u_o ________ T~I ~~~ 

Figure 1.10 The System 7 Views control panel 
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Turn Snap to Grid On or Off 
Click the check box beside Always Snap to Grid if you want your 
Macintosh to always position icons in an empty space on its invisible 
grid . (Holding down the Command key while dragging an icon tem
porarily reverses this setting.) 

Pick a List View Icon Size 
Use radio buttons to choose the icon size to appear in list views. T he 
middle size is especially useful because it shows the document's real icon 
yet does not take up much space in d1e window. 

Determine What Information Displays in a Window 
Check boxes at the bottom of the Views control panel let you deter
mine what should show in each window. 

+ Calculate Folder Sizes displays the total size of files within a 
folder. While this might be useful, keep in mind that it can also 
slow down your Macintosh since folder sizes must be calculated 
each time you open a List view window containing folders. 

+ Show D isk Info in H eader djspJays the number of items in the 
folder, d1e amount of disk space used by all items on the disk, 
and d1e amount of disk space available. 

+ The other Show check boxes let you determine what infonna
tion is provided to d1e right of each fi lename in d1e window. 
Choices are Size, Kind, Label, Date, Version, and Comments. 
\iVhatever you turn on here also becomes an option in the View 
menu. So, for example, if you want to be able to view by Label, 
you must have the Show Label check box turned on here. 

Other View Tips . . . . . . . . . . . . . . . . . . . . . . . . . . 
Here are two other View tips that you might fi nd useful. 

Click to Change List Views 
Ald10ugh the View menu lets you change views, you might fi nd it 
quicker to change a List view in an open window by clicking on the 
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header you want to view by. For example, if you are viewing a window 
by Name and want to view by Date, click on the Date header in the 
window to instantly change views. Notice that the header you are view
ing by appears underlined. 

Specify New Folder Views 
A new folder's size and view is determined by its parent folder. So, if you 
need to create a number of new folders inside a folder, you can deter
mine in advance what the new folders' sizes and. views will be by chang
ing the parent folder's size and view first. Then, when you choose New 
Folder (Command-N) from tl1e File menu, all the new folders have 
the desired settings. Mter the folders have been created, you can always 
change the parent folder back to the size and view you want for it. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
System 7 users can use the Labels control panel (see Figure l.ll ) to 
customize the labels that appear under the Label menu and in list views 
(with the Show Label option turned on in the Views control panel). 
Here are some tricks for changing ilie label name and color and using 
labels effectively. 

Customize Labels 
Customizing tl1e seven labels in the Labels control panel is easy. Simply 
select the name of the label you want to change and type in a new name. 
It can be anytl1ing you like. As shown in Figure 1.12, you will see your 
changes in the Label menu immediately. 

Figure 1.11 The Labels control panel 
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../None 

- Mac Slick Tricks 
- Letraset Project 
- BBS Stuff 
- Waiting for Re~pon$e 
-Personal 
- Mike's Stuff 
- Stuff to Rrchiue 

Figure 1.12 A customized Label 
menu 

Change Label Colors 
Ifyou have a color Macintosh, you can also change Label colors. Here's 
how: 

0 In the Labels connol panel, double-click on the color sample 
beside the label you want to change. A standard Macintosh 
color wheel like the one in Figure 1.13 appears. 

0 Select a new color by clicking on it withjn the color wheel. You 
can change brightness by sliding the vertical scroll bar up or 
down . 

0 Click OK to accept your change and close the color wheel 
window. 

View by Label Sorts in Label Order 

Some people think that the by Label command under the View 
menu displays windmv contents sorted by the name of the label. This 
isn't so. By Label sorts in the same order the labels appear under the 
Label menu. If you have more than one item with the same label, 
those items are then sorted in alphabetical order by name. 
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Color for "Essential" 

Hue 

Saturation 

Brightness 

Red 65535 00 
Green 103 10 00 

Blue 7805 00 ( Cancel ) n OK )J 

Figure 1.13 The standat·d Macintosh color wh eel 

Sound Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
The Sound control panel, which is illustrated in Figure 1.14, lets you 
select the system alert sound. Here are some sound tricks you can try 
with it. 

Turn Off the Sound 
If you work in a library-or in an office just as quiet as one-you might 
want your Macintosh to keep its sounds to itself. To turn off the System 
sound, open the Sound control panel and drag the sliding volume bar 

[' .... j Alert Sounds 

I ~~ 
I ~ 

Sound 

... j ......................................................... , 

Droplet 
Hey! 
Indigo 
Quack 
Simple Beep 
Sosuml 
Wild Eep 

Q 

1 .............. ~::: .. :: ...... - ... ~--:~-~~~-:--~=:~~~-·-
Figure 1.14 The Sound control panel 
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to its lowest setting. Instead of making a peep, your menu bar will flash 
inversely (white words on black background) when your Macintosh 
needs to get your attention. 

Record Your Own Sound 
If you've got a microphone attached to your Macintosh you can use it 
to record your own custom alert sounds. 

Get Info Tricks 

0 Open the Sound control panel. 

0 ClickAdd. 

8 A recording dialog box like the one in Figure 1.15 appears. 
Click the Record button to begin recording a sound. What
ever sound reaches the microphone will be recorded. 

8 Click Stop to stop recording the sound. 

G Click Play to play back the sound. If you're not happy with the 
sound you've recorded, repeat Steps 3 through 5 until you are. 

0 Click Save. 

0 Enter a name for the sound in the edit box and dick OK. 

0 Mter a moment, the sound name will appear in the Sound con
trol panel's main window. You can choose that sound for your 
aler t sound by clicking on it to select it . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
The File menu's Get Info command (Command-I) offers information 
about the selected disk, file, or folder. An example of the Get Info win
dow is illustrated in Figure 1.16. This window lets you perform a few 
tricks, too. 

[!] [!] 0:0 [I] <J 
Rtoord Stop P1urt Pl..., 

:02 
stcondJ: :10 

(§D 

I( Saue J 

Figure 1.15 Recording a sound 
with the Sound control panel 



§0 Disinfectant Info 

Q\ Disinfectant 
w;' Disinfectant 3.5 

Kind: application program 
Size: ~~I K on disk (~~:5 ,940 bytes used) 

Yllere: Hard Disk : Documents: Stuff : 

Created: Sat, Apr 2, 1994, 1 :17 PM 
Modified : Sat, Apr 2, 1 994, 1 :22 PM 
Version: 3.5, Copyright Northwestern 

University 1 988-1994 
Comments: 

II 

:-"Memory Requirements ........... ! 
i Suggt-sted size : 1 000 K i 
I Minimum size: 1300 I K l 

0 Locked 1 .... :.~~.~~~.~~.~-.:~=~ .. : ...... J.~.~?,~ ........ J..~ .... J 

Figure 1.16 The Get Info window for 
an application 

Add Finder Comments 
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The Comments area of the Get Info window lets you enter any com

ments you like about a fiJe. You can use this to provide information 
about the file for yourself or for od1er file users. Since it's possible to 
view by Comments, you can also use d1is area to enter information you 
may want to sort by for a window's list view. 

Get Info Comments Can Be Lost! 

Rebuilding the Desktop, \:vhich is covered in Chapter 9, deletes aJl 
comments from the Get Info window. Keep this in mind if you use 
the Comments feature. 
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Lock Files 
The Locked check box lets you lock a file so that it can't be changed. 
Use this to protect template documents from being overwritten. If you 
try to save a file with the same name, you will be told that you can't. 
You can also use tlus to prevent applications from becoming infected by 
viruses-just be aware tl1at it is nota foolproof virus protection metl1od. 
In addition, locking an application may prevent it from working since 
some applications actually read and write to their own files as you use 
them. 

Make Stationery 
The Stationery Pad check box lets you turn a regular document into a 
template. To use tll.is feature, check this box and then open the file with 
the application that created it. Although different applications treat sta
tionery pads in different ways, in most cases, the stationery pad docu
ment will be opened as an "Untitled" document. This will force a Save 
As dialog box even if you choose ilie Save command, thus making it a bit 
tougher to accidentally overwrite tl1e original stationery pad document. 

Set an Application's RAM Allocation 
The Get Info window also enables you to set tl1e RAM allocation for 
applications. Enter a value in the appropriate edit box and close the Get 
Info window. When you launch the application, it will use the RAM you 
specified. This is covered in much greater detail in Chapter 4. 

Stop the Trash Warning 
One of the most annoying features of System 7 is the trash warning tl1at 
appears when you empty tl1e trash: "The Trash contains 1 item. It uses 
6K of disk space. Are you sure you want to permanently remove it?" To 
get rid of this annoying message, do iliis: 

0 Click once on tl1e Trash icon to select it. 

0 Choose Get Info (Command-!) from ilie File menu. 

0 Turn off the check box for Warn Before Emptying, as shown 
in Figure 1.17. 

0 Close ilie Get Info window. 
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:=o Trash Info 

liB Trash 

When : On the d~sktop 

Co•tents: Th~ Trash is ~mpty. 

Modified : Mon, Apr I 8, 1 994, 8 :36 AM 

~Yarn before emptying 

Figure 1.17 Turning off the trash warning 

Change the Icon 
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System 7 users can also use the Get Info window to change the icon for 

one fi le, folder, or disk to the icon for ano ther file, folder, or disk. It's 
as simple as copy and paste. H ere's how: 

0 Click once on the icon you want to use to select it. 

0 Choose Get Info (Command-I ) from the File menu. 

0 Click once on the icon in the Get Info window to select it. A 

box appears aro und it. 

0 Choose Copy (Command-C) from the Edit menu . The icon 
is copied to the clipboard. Close the Get Info window. 

0 Click once on the icon yo u want to replace to select it. 

0 Choose Get Info (Command-!) from the File menu. 

0 Click once on the icon in the Get Info window to select it. A 
box appea rs around it. 

0 C hoose Paste (Command-V) from the Edit menu. The icon 
in d1e clipboard is pasted over d1e current icon. When you 
close the Get Info window, the icon is changed. 

You can also paste icons into the Scrapbook to store them for later 
use. 

To restore an icon to its original shape, simply click on the icon in the 
Get Info window and press the Delete key. 
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Ejecting vs. Unmounting Dis/cs There is a definite difference between eject
ing and unmounting a disk. When you eject a 
disk, it is physically removed from the Macin

tosh. That doesn't mean your Macintosh has forgotten all about it-it 
may ask you to reinsert the disk. When you unmounta disk (normally 
by dragging its icon to the trash), you tell your Macintosh to forget the 
disk exists. Your Macintosh will not ask you to reinsert it 

Here are some additional considerations: 

• When you unmount a floppy, the disk is also ejected. 

• You must unmount a SyQuest cartridge before you can physically 
eject it from the SyQuest drive. 

• You cannot unmount the startup disk. 

• You can unmount non-startup disks, including external hard disks, 
but you may see a message informing you that the drive will reap
pear when you restart. 

Disk Ejection Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Earlier in this chapter, you saw that Command-Option-! (and Com
mand-Option-2 on a two-floppy Macintosh) can eject a disk. Here are 
a few more disk ejection tips. 

Avoid the Eject Disk Command 

The Special menu 's Eject Disk command (Command-E) ejects a floppy 
disk. What you might notice, however, is that after the disk has been 
ejected, its grayed image remains on the desktop. This is because the 
disk has been ejected but not unmounted . Your Macintosh may display 
an annoying message like the one in Figure 1.18 asking you to insert 

~~ Pleose Insert the disk: 

~-' Sneoker Net 

Figure 1.18 The d readed insert disk 
message 



The disk "Sneaker Net" could not be 
opened, because it is not in any driue. 

fi OK D 

Figure 1.19 What your Macintosh says when it 
can't find a disk 
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the disk. This is especially bothersome if it happens after you've mailed 
the disk to your company's regional sales office in Sydney, Australia. 

Dismiss the Insert Disk Message 

The insert disk message that appears when your Macintosh asks you to 
insert a disk that wasn't unmounted (see Figure 1.18) is particularly 
frustrating since it doesn't offer any options other than to insert the 
disk. Here's a secret: You can usually press Command-. to dismiss the 

message. This might generate another message, like the one in Figure 
1.19, but at least you can click OK for that one. I f the insert disk mes
sage reappears, be persistent-press Command-. again. Your Macin
tosh usually gives up and unmounts the disk. 

Choose Put Away to Eject a Disk 

Choose Put Away (Command-Y) fro m the File menu to eject and un
mo unt a selected floppy or other non-startup disk. 
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Filing Tricks 

H aving trouble keeping track of your files? Tired of digging 
through folders to find applications and documents? Think back

ing up is too much of a chore to do regularly? This chapter may solve 
all these problems for you by providing tricks you can start using now 
to take control of your files. 

File Naming Tricks 

~~~ '• 

What's in a name? With up to 31 characters, there can be quite a bit in 
a Macintosh filename. Here are some file naming tips and tricks to help 
you find files when you need them. 

Save Files with Descriptive Names 
vVhich document name is more descriptive, "Letter" or "ABC Co. Job 
Cover Letter 10/ 16"? 'While "Letter" could be a letter about anything, 
"ABC Co. Job Cover Letter 10/ 16" is probably the cover letter accom
panying a resume for a jo b at ABC Co. that was written on 10/16. 

27 
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Those 30 characters reaJ ly can tell a story. Take advantage of every char
acter your Macintosh allows. Here are some suggestions: 

+ For letters, name the file with the name of the person the letter 
is addressed to and either the subject or date (or both if you 
can). Some examples include: "Tracy Smith, Contract 7 / 16," 
"Tom H , New Business 5/18," and "Town of Cresskill, Dog 
License." 

+ For flles related to a specific project, include the name of the pro
ject as part of the filename. This is especially useful if you don't 
keep these files together in the same folder. Some examples in
clude: "Slick Tricks Outline," "Slick Tricks Chapter 01," "Slick 
Tricks Chapter 11," and "Slick Tricks Acknowledgments." (Note 
that when you include a leading zero in a filename that includes 
a number, you can keep 2-digit numbers in order. "10" comes 
before "2" alphabeticaJ ly, but after "02.") 

+ If you use a fax modem to send documents, you may want to in

clude the word "fa.x" in the fil enames of documents you send by 
fax. This way, when reviewing correspondence sent to a particu
lar person, you can immediately identify which of the documents 
were faxes sent to that person's fax machine. 

There's one important exception to tills tip: naming files that will be 
used on IBM-compatible computer systems. If you're working with files 
that will ultimately be used by DOS or Windows users, you should follow 
DOS naming conventions. You can read more about that in Chapter 5. 

Include Oates in Filenames 
While your Macintosh can keep track of the dates that a file is created 
and modified and display the modification date in a List view Finder 
window, you might fi nd it useful to include a date in a filename anyway. 
This helps you to identify it in directory dialog boxes, like the one that 
appears when you open a file fi·om within an application. For example, 
in Figure 2.1 , can you tell which is the most recent letter to Norb L? 
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Colons in Filenames 

You can use any character in a filename except the colon (:). Your 
Macintosh reserves this character for use in path names (the complete 
name of a ftle , including parent disk and folders). Ifyou type a colon 
while nan1ing a file, your Mac will either ignore it or automatically 
convert it to a hyphen, depending on the application. 

Establish and Stick to a Standard File Naming Convention 
Using standard words, phrases, or even codes in filenames can make 
them easy to find when you need to. For example, if the name of every 
report you write contains the letters "RPT," you can use the Macin
tosh's built-in search feature-the Find (Command-F) command un
der System 7's File menu or the Find File desk accessory under System 
6 's Apple menu- to find all the documents containing those characters, 
that is, all of your reports. 

Force Filenames to the Top or Bonom of Alphabetical Lists 
Directory dialog boxes like the one in Figure 2.1 and Finder windows 
viewed by Name display fLies in alphabetical order. Sometimes, however, 
you might want a specific file to be at the beginning or end of the list. 
Rather than beginning these files with the letters A or Z (which is often 

Ia Project HY2 Flies ,.I 
1
.g_.Laum L, Payment Info 09/ 12 ... 0 
D Mike C, Specs 09/ 12/94 <=Hord Disk 

D Mike C, Test Results 11/ 1/94 
D Norb l , Bid 09 / 4/ 94 

Ejec t 

D Norb l , Contract 11/7/ 94 Desk top 
D Norb l , lntro 05/7/ 94 
D Norb l, Product Info 07/ 16/ 94 
D Norb l , lhonks fall 1 2/2~/94 [ Cancel l 

~ Open l) 
ro 

Figure 2.1 Dates in filenames can be helpful 
in directory dialog boxes 
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impractical ), use invisible or nonalphabetic characters. For example, the 
space character (which is invisible) comes before most other characters 
alphabetically. Naming a fil e " Fax Template" rather than "Fax Tem
plate" (note the space in the first example just before the letter F) will 
force it to the top of the list. Use as many additional leacling spaces as 
you like. If you want a file to appear at the end of a list, use a character 
that comes after the normal alphabetic characters, like the bullet ( •) 
character (Option-8). 

Table 2.1 shows some suggestions in alphabetical order. The list on 
the left includes characters that appear before the uppercase letter A. 
T he list on the right includes characters that appear after the lowercase 
letter z. 

There are more characters available, of course, but these are probably 
the most usefu l for beginning filenames since they're somewhat graphic 
in nature. Keep in mind that although these characters are standard, 
they do not appear in all fonts. They are included in Geneva (the stand
ard system font that can be changed in the Views control panel under 

Table 2.1 Characters Used to Position a Filename in a List 

Character before A Keystroke Character after z Keystroke 

Spacebar t Option-T 

Shift-1 • Option-B 

# Shift-3 :t. Option-= 

* Shift-B 00 Option-5 

+ Shift-= ± Option-Shift-= 

" Option-V 

< Shift-, /}. Option-J 

= = (( Option-\ 

> Shift -. )) Option-Shift-\ 

? Shift-/ Option-; 

@ Shift-2 0 Option-V 
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System 7) and Chicago (the standard font used in dialog boxes and 
menus). When you type a character that is not included in a font, it will 
either appear as a plain box or not appear at all. 

Document Management Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Naming files is only a small part of document management. The way 
you organize your files on disk can make a real difference in how quickly 
you can locate a specific file when you need it. While everyone has his 
or her own personal filing system, you may find the tips in this section 
helpful when setting up or fine-tuning your system. 

Organize Files by Project 

If you use your Macintosh to work on a variety of different projects, you 
may find that organizing files by project makes it easy to find files fast. 
For example, say you have three current projects: Project A, Project B, 
and Project Q. Create a folder for each project and store the files related 
to each one in the appropriate folder. If you have a lot of files for Project 
Q , you may want to create subfolders within the Project Q folder-say, 
for Correspondence, Financial Workups, Drawings, Work in Progress, 
Finished Work, or a combination of these. The kind of work you do will 
determine the way you organize files within each project folder. 

Use a Miscellaneous Folder 

If you often create documents that are not related to any specific pro
ject, store them together in one folder. Think of it as the "Miscellane
ous" drawer of a file cabinet. 

Use List Views to Organize Files 
The Finder offers a number of List views to view the contents of win
dows (check Chapter l for more details). You can even view different 
windows with different views. A folder full of correspondence to one 
specific person or organization may be best viewed by Date so that the 
most recent documents come to the top of the window. A folder full of 
miscellaneous documents for a variety of projects may be best viewed 



f 
32 Maci1ltosh Slick Tricks 

se your Macintosh's Label feature (which was also 
discussed i~ ter l ), you may want to view the contents of certain 
folders by La el~ con view and Small Icon view are useful if you like 

to grc;)llp icons manually within a window. Remember, you can view any 
window using any option under the View menu. 

Don't Save Documents with Applications! 

Many Macintosh users- especially new ones-fall into the trap of 
saving documents in the fo lder contai ning the application that cre
ated them. For example, if a document was created with Microsoft 
Word, these folks save it in the same folder as ·word and its accompa
nying files. Why? Because when they use the Save or Save As com
mand, the default folder (the one that appears in the directory 
window of the Save As dialog box) is the one that contains the 
Microsoft Word application. 

New Macintosh users often don' t know that they c e this dia-
.-lo~d-saveiJ'r'mhe.r.JQlders. More experienced Macin-· 

tosh users might be just plain lazy. 

-
This is not a good way to organize fi les for several reasons: 

+ To find..sJ.jile, you must remember which applicati~Q_ 

to create it. If you have only a few applications, this might not 
be a big deal, but when you've got a variety of different appli
cations you use regularly, keeping track of which one you used 
for each document can be quite a chore. 

+ I f you' re working on a project wi th fi les created with several 
different applications, those fi les are scattered throughout 
your hard disk, making them difficult to find and keep track of. 

• When you install a new version of an application, it may install 
a brand new folder on your hard disk. If you' re not careful , 
you may discard your documents when you throw away the 
folder containing the previous version . 

+ Scattering documents aU over your hard disk makes files diffi 
cult to back up efficiently. You'll learn more about backup 
strategies later in this chapter. 
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Save Temporary Files on the Desktop 

If you need to save a fi le that you expect to discard a short while later, 
save it on the Desktop. This makes it easy to find the file when you want 
to delete it. It also makes it tough to forget that the file exists since it's 
right out in the open for you to see. 

System 7 users can save files to the Desktop easily by clicking the 
Desktop button in a Save As dialog box just before clicking the Save 
button (see Figure 2.2). System 6 users cannot save directly to the 
Desktop, but they can move fi les out of disks and folders and leave them 
on the desktop. 

Create a Folder on the Desktop 
To create a folder on tl1e desktop, choose New Folder (Command-N) 
while no \:vindows are active. 

Put Away Files on the Desktop 
Choose Put Away (Conunand-Y) from the File menu to move a se
lected file on the Desktop back into the disk or folder it came from. You 
can find out where a file came from by choosing Get Info (Conunand
I ) from tl1e File menu and looking at the Where field of the Get Info 
window that appears. 

Ia File Cabinet ..-1 = Hord Disk 

0 Act Solutions BBS 
0 A lysis - 10/ 31 / 93 
0 Amell - o 1/25/ 94 

~ Eject 
p 

D Ash Joy - OBi 19/ 93 
D B&N Flyer il· 
D Beta labels lo~ 

0 Bio (Brief) :lji [,..-.c- o-n-ce-,1----.. 
0 Oio (Long) r;;1 

._D_B_io_f_or_ G_R_P _____ _..-6-..., t soue D 

®Et] ol Soue this document os: 

I Delete M e Loter! 

Figure 2.2 The Desktop button in a Save As 
dialog box 
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Application Management Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
If you have more than just a handfu l of application software packages 
on your Macintosh, you probably reaJize that managing all this software 
and the files that go with them can be quite a task. Like document man
agement, there is no right or wrong way to organize your programs so 
they're easy to find and use. Here are a few tips you might find useful 
vhen developing your own method. 

Store Applications Together 
While no one says you can't store applications on the main level of your 
startup volume, storing them in folders inside an all-purpose application 
folder is a good way to keep them organi zed. It aJso keeps your hard 
disk's main window neat, like the one in Figure 2.3. 

Don't Combine the Files of Several Applications in One Folder , "-"""-~""--

If you store more than one application in the same folder, be sure to 
create a separate folder for each application. Why? Because if you 
combine applications and their support files in one folder, you might 
find it tough to tell which files belong to which application. When it's 
time to upgrade software and you want to throw the old version's 
support ftles out, you might not be able to figure out which ones 
should be discarded. Not only that, but there's a slight chance that 
more than one application may use a file with a specific name. Since 
you cannot have more than one fi le with the same name in a folder, 
one of the files may get deleted on installation. 

Group Applications by Purpose 
If you have lots and lots of applications, you might want to group them 
by purpose. T he hard disk window illustration in Figure 2.3 illustrates 
a separate folder for general applications, utili ties, and telecommunica
tions software. You might want to go a step further and create separate 
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Figure 2.3 The real-life hard 
disk of an organized person 

folders for each of the kinds of application software packages you use, 
like word processing, business, and graphics. Your goal should be to 
limit the number of files and folders inside of each folder while avoiding 
filling your hard disk's main window with folders. It's a delicate balance 
to create, but once you set up a system, it'll make finding specific appli
cations easy. 

Put a Drag-and-Drop Folder on Your Desktop 

If you use System 7's drag-and-drop feature to open fi les or perform 
specific tasks, conside; keeping drag-and-drop applications (or aliases of 
them- more on that later in this chapter ) in a folder and leaving that 
folder on your Desktop, perhaps right beneath your hard disk icon. 
Then, when you need to use one of these fi les, double-click on the 
folder to open it and djsplay the applications. 

There are two main benefits to keeping these fi les in a folder rather 

than loose on your desktop: 

+ Keeping files in a folder on your Desktop keeps your Desktop 
neat and makes the fi les easy to find. 

• You can view the contents of a folder by any option under the 
View menu. Use Small Icon view or a List view and make the 
window long and narrow to limit the amount of desktop space 
the files take up when the folder is open. Figure 2.4 shows an 
example. 
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Alias Tricks 
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Figure 2.4 A drag-and-drop folder's 
contents in Small Icon view 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
In the days before System 7, if you wanted to open a fLle or folder, you 
had to locate it on the disk and either double-click its icon, or select it 
and choose Open (Command-O) from the File menu. Finding the ac
tual fi le or folder was also required to open it from within an applica
tion. System 7's alias feature changed all this by making it possible to 
create an alias or "pointer" file. Open the aljas and you open the file or 
folder it points to. You can make as many aljases of a file as you like and 
place them anywhere on your hard disk or desktop. This makes it very 
convenient to find and open often-used fLies. 

This section tells you how you can create aliases and provides some 

tips and tricks for using them. 

Make and Use Aliases 
To make an alias of a file or folder, follow these steps: 

0 Find the fi le or folder you \vant to create an alias for, and click 
once on it to select it. 

0 Choose Make Alias from the File menu. Mter a moment, an 
icon appears near the ori ginal file. It has the same icon and 
nan1e, but the name appears in italic characters and includes 
the suffix "alias." You may also notice that the filename 
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appears in an edit box so that you can type in a new name im
mediately. This is shown in Figure 2.5. Ifyou want to change 
the name at this point, type a new name in and press Return. 
Just remember that it can't be the same name as the original 
while both are in the same folder. 

8 Drag the file to a new location. (Chances are that if you both
ered to create an alias, you don't want to keep it in the same 
location as the original.) 

0 If you want to give the alias the same name as the original, do 
it now. Click on the name area. When the edit box appears 
around the name, type in a new name and press Return. 

An alias is not a copy of a file. It is a pointe1'-it points to the file. Dou
ble-clicking an alias does not open the alias. It opens the file that the 
alias points to. 

This is very important to remember if you want to copy a file . 
Dragging an alias to another disk copies the alias, not the original file. 
If you copy an alias onto a floppy disk and give the disk to someone 
else, an error message like the one in Figure 2.6 will appear when that 
person tries to open it on his Macintosh. Be sure to copy the original 
file for use on another Macintosh. 

Finding the Original File 
If you can't remember where an alias's original file is, use Get Info to 
find it. 

0 Click once on the alias to select it. 

Figure 2.5 An alias icon 
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Figure 2.6 What your Macintosh displays when 
it can't find an alias's original file 

0 Choose Get Info (Command-!) from the File menu. The 
Get Info window appears, as shown in Figure 2.7. 

0 Click the Find Original button. Your Macintosh displays the 
window containing the original icon with its icon selected. 

Leave Aliases on Your Desktop 

Your Desktop is one good place to leave alias files (you'll see another in 
the next section of this chapter). C reate aliases for the applications, 
documents, control panels, desk accessories, and folders you use most 
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Figure 2.7 The Get Info window for an 
alias 
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often and arrange them in a row across the bottom of your screen. If 
you size your Finder and document windows so that they don't block 
this area, they'll always be easily accessible. 

Don't Clutter Up Your Desktop! 

Keeping aliases and other icons on your desktop makes it convenient 
to find and use them, but the law of diminishing returns applies: As 

icons proliferate, cluttering up your desktop, they take longer and 
longer to find. Try keeping them in a folder on your Desktop, as sug
gested for drag-and-drop applications earlier in this chapter. Or put 
them in the other good place: the Apple Menu Items folder. 

Apple Menu Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
System 7 turned the Apple menu into something really useful, not just 
a place to store seldom-used desk accessories. By placing files into the 
Apple Menu Items folder inside the System Folder, you can add virtu
ally anything to the Apple menu. This gives you immediate access to 
files you'd otherwise have to dig through folders to find. This section 
provides some tips and tricks for using the Apple menu. 

Put Aliases in the Apple Menu 
Are there certain programs or files d1at you use every day? If so, the 
Apple menu is a perfect place to put them. But rather than put the ac
tual file into the Apple Menu Items folder, put an alias of the file there. 
Why? Several reasons: 

• Some applications must reside in the same folder as their support 
files. If you put one of these applications into the Apple Menu 
Items folder, the application may not be able to find the support 
files it needs. Error messages and inconsistent behavior may 
result. 
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+ Ifyou're trying to maintain a consistent organization strategy for 
your ftl es, placing onJy some of them in the Apple Menu Items 
folder probably won't fit into your strategy. As a result, you may 
have trouble remembering exactly where files are located on disk 
and some files may get missed when making backups. 

Remove Unused Desk Accessories from the Apple Menu 
Apple's System Software Installer automatically installs desk accessories 
in the same old place it always installed tl1em: under the Apple menu. 
But under System 7, you don't have to keep them mere. You can use a 
desk accessory no matter where it is installed. 

Do yourself a favor-delete the Apple-provided desk accessories you 
never use, like the Puzzle and the Notepad. Move the ones you use 
once in a while to anotl1er folder where you can find them when you 
need iliem. This shortens your Apple menu and makes more room for 
tl1e files and folders you access most often. 

A quick note for System 6 users: Don't be afraid to delete desk acces
sories you don't use. Use Font/DA Mover to remove unwanted desk 
accessories from your System file. 

Use Folders in the Apple Menu 
As you add more and more items to your Apple menu, ilie menu be
comes longer and longer until it can't fit on your screen . This reduces 
ilie efficiency of the Apple menu by forcing you to scroll all ilie way 
down the menu to choose items at tl1e bottom. 

You can use folders in your Apple menu just as you use folders on 
your hard disk to organize files. Apple provides a good example: the 
Control Panels folder. Choose it from the Apple menu and ilie folder 
opens. Use folders to organize items under your Apple menu by cate
gory, type, or purpose. Use them to group the items you usually use 
together. This helps keep the length of tl1e Apple menu within reason. 
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! ' 

The Benefit of a Hierarchical 
Apple Menu 

What Apple should have done when it pro-
grammed the Apple menu is make it into a 

, , hierarchical menu, one wi' h pop-out menus 
iii~playing the contents of each folder. Although Apple didn't do this, 
other software developers did. NowMenus, a component of Now 
Utilities by Now Software, Inc. does this and much more. You might 
wantto check'into this and other hierarchical menu utilities if you find 
yourself making extensive use of the Apple menu. 

Customize the Order of Items in the Apple Menu 
The items on the Apple menu always appear in alphabetical order. You 
might find it more useful, however, to put the items you use most often 
at the top of the menu. That's easy enough to do-check the File Nam
ing Tricks section at the beginning of this chapter for details on how 
you can cheat the alphabet. 

Add Separators to Your Apple Menu 
If customizing the order of items in your Apple menu isn't enough for 
you, you can also add separators. 

0 Open your Apple Menu Items folder. 

0 Choose New Folder (Command-N) from the File menu. 

0 A new folder appears. Change the name of the folder so that it 
begins with a character that will position it alphabetically where 
you want a separator line to appear. After that first character, 
complete the name with either period characters or hyphens. 
Both are illusu-ated in Figure 2.8. 

8 Repeat Steps 2 and 3 for as many separators as you want 
to add. 

Pull down the Apple menu to admire your handiwork. It might look 
something like the illusu-ation in Figure 2.8. 
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Customize the Puzzle 

If you decide to keep the Puzzle desk accessory, you might consider 
changing the picture on it for a new challenge each time you play with 
it. It's easy to do: 

0 Use the Copy (Command-C) command to copy a black-and
white or color PICT image onto the Clipboard from within 
any application. For best results, it should be at least the same 
size as d1e Puzzle area. 

0 Open the Puzzle. 

8 Choose Paste (Command-V) from the Edit menu. The image 
is resized to fit into d1e Puzzle area. 

Some additional points: 

+ To remove a custom picture from rl1e Puzzle, choose Clear from 
the Edit menu. 
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+ To switch from the Apple logo puzzle to a number puzzle, 
choose Clear from the Eclit menu when the Apple logo puzzle is 
displayed. To go back to the Apple logo, choose Clear from the 
Eclit menu when the number puzzle is displayed. 

Hard disks, floppy disks, SyQuest cartridges, Bernoulli drives, CD
ROM disks, optical storage-the list goes on and on. How do you keep 
track of the files stored on these disks? How do you protect them from 
damage? How do you use them efficiently and effectively? The answers 
to these questions are here in this section. 

Dislc Labeling and Cataloging Tools 
That Won 't Break Your Budget 

If you're interested in inexpensive soft
ware to help you manage files stored 
offline, consider these two shareware 
gems: 

• Loodle is a disk labeling utility created by Josh and Nick Franco 
that automatically reads floppy disks as you install them, and cre
ates nice looking labels that print on standard label stock. It also 
includes a HyperCard stack that you can use to keep track of all 
those disks and files. Loodle is a shareware program that you can 
find on many online services and bulletin board systems. 

• FileList+ is a disk cataloging utility created by Bill Patterson that 
automatically reads floppy disks as you install them, and keeps a 
complete list of all files and their volumes (disks). It can also read 
higher-capacity media like SyOuest cartridges, hard disks, and 
even CD-ROM drives. FileList+ is shareware- send the author 
what you think it's worth if you use it. You caa Jind it on many online 
services and bulletin board systems. 
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Organize and Catalog Offline Files 
If you store files offline-on floppy disks, removable media like SyQuest 
cartridges, or even hard disks that you don't regularly mount on your 
Macintosh-organize them the same way you organize ftles on your 
hard disk so they're just as easy to find. Label floppy disks so you know 
what's on them. Print a l.ist of the contents of files and folders on re
movable media and hard disks, and store the lists with the media. 

Don't Trust Important Files to Floppy Disk! 

Of all storage media, floppy disks are perhaps the most fragile. Their 
plastic cases aren't always enough to protect them from magnetic 
fields, heat, dust, moisture, and the banging around they get inside 
briefcases, purses, and envelopes. Even when stored properly in a 
protective case, floppy disks sometimes just go bad. And, when they 
do, data can be lost forever. 

Never trust a floppy disk to store the only copy of an important 
file. If you must store an important file only on a floppy disk, store 

another copy on another floppy disk. This goes for documents as well 
as your original program disks. Although program disks can be re
placed, it sometimes take days or weeks for the replacement to arrive. 
What do you do while you're waiting? To be on the safe side, make 
backup copies of all original program disks before you install the soft
ware. 

Use the Finder to Duplicate Disks 
The Special menu's Eject Disk command (Command-E) ejects a 
floppy disk. As discussed in C hapter l, however, after the disk has been 
ejected, its grayed image remains on the desktop. This makes it possible 
to copy one disk.to another. Here's how: 

0 With a floppy disk you want to copy inserted in the disk drive, 
choose Eject Disk (Command-E) from the Special menu. 
The floppy disk is ejected but its image remains on the desktop . 
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0 Insert a blank disk of the same capacity into the disk drive. If it 
hasn't been formatted yet, let your Macintosh format it when 
it offers to. 

0 Drag the grayed image of the disk you ejected onto the disk 
you inserted. This tells your Macintosh to copy one disk's con
tents onto the other disk. 

G When your Macintosh asks ifyou're sure you want to com
pletely replace the contents of one disk with the contents of 

the other disk, click OK. 

0 Your Macintosh ejects the blank disk and prompts you to insert 
the original or "source" disk. Insert it. A progress box appears 
on the screen to indicate reading progress. Your Macintosh 
then ejects the source disk and prompts you for the blank or 
"destination" disk. Insert it. The progress box indicates writing 
progress. You may have to switch disks more than once, de
pending on the disk capacity and your Macintosh's installed 

RAM. 

0 When the copying is done, the gray source disk image remains 
on the desktop, along with the destination disk's icon. The des
tination disk is in the drive. You can eject (or unmount) either 
disk by dragging its icon to the trash. 

Lock Original Program Disks 
Most software comes on floppy disks. To help protect your investment 
from being accidentally overwritten or damaged by a computer virus, 
lock original program disks before inserting them into your Macintosh. 
This makes it impossible for your Macintosh to write any information 

to the disk. 
You can find the floppy disk lock on the back of the disk. Hold the 

disk with the sliding metal door facing down and you'll see the disk Jock 
in the upper-left corner. Slide it up (open the hole) to lock the disk . 
Slide it down (close the hole) to unlock the disk. If you have trouble 
sliding the lock tab, insert the tip of a ballpoint pen in the tiny half
moon-shaped hole near the top. 
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Spring Cleaning Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
The original Macintosh hard disks were seldom larger than 10 or 20 
megabytes. Imagine that! Most people have System folders bigger than 
that these days. 

Although hard disks are getting bigger and bigger, they seem to be 
shrinking. Often, there's hardly enough room for all the files you accu
mulate. But therein lies the key: accumulation. Do you ever throw away 
the files you don't really need? This section will help you find and re
move old files so you can make room for new ones. 

View by Date to Find Old Files 
Possibly the quickest way to find the oldest files in a folder is to choose 
by Date from the Finder's View menu. This sorts all files by their last 
modification date, putting the oldest at the bottom. 

Use the Find Command to Find Old Files 
System 7 users can find old files with the Find command. 

0 Choose Find (Command-F) from the File menu. 

0 Click the More Choices button to expand the dialog box. 

0 From the first pop-up menu, choose Date Modified. 

8 From the second pop-up menu, choose Is Before. 

8 Use the arrows beside the date to change the date to the new
est file you want to find. Your Macintosh will look for files 
oldet· than the date you select . When you're finished, the dialog 
box should look something like the one in Figure 2.9. 

0 If you want your Macintosh to display all found fil es at once, 
turn on the All at Once check box. 

0 From the Search pop-up menu, choose the location to be 
searched. If you want to search a specific folder and its subfold
ers, make that the active window befm·e you choose the Find 
command and it will appear on the list. 

0 Click Find. Your Macintosh looks for files matching the date 
criteria you set and displays them. 
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Figure 2.9 Using the Find dialog box t o find old files 

0 I fyou didn't have the All at Once check box turned on, 
choose Find Again (Command-G) from the File menu to 
ftnd each ftle, one at a time. 

Store Seldom-Used Files Offline 
Often you'll have files on your hard disk that you need to keep, but you 
don' t need to use on a regular basis. When free hard disk space becomes 
tough to find, these files should be the first to go. Store them on other 
storage media, like floppy disks, SyQuest cartridges, or spare hard disks. 
This way they're available when you need them, but are not taking up 
space better used by the .fi les you need on a regular basis. 

Delete Applications You Seldom Use 
If your hard disk is playing host to one or more applications you rarely 
use, free up some space by deleting the applications. You may be sur
prised by how much space an application takes up. You can always rein
stall from the original program djsks when you need to. 

The same holds true for programs you no longer need after a certain 
date. Income tax programs arc a great example. The 1994 version of 
MacinTax takes up 7 . 5 MB of hard disk space, not to mention the fonts 
it installs in your System. 'Who knows how much disk space it' ll eat up 
in 1995? ·when April 16 rolls along, delete this program. Also be sure 
to delete old versions of programs you update. No need to keep old 
software around. 
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Find and Delete Teach Text 
TeachText, the Apple text editor, is often provided with software and 
installed automatically on your hard disk when the software is installed. 
Trouble is, if you install five programs and all five include Teach Text, 
you'll end up with five copies of it. No one needs more than one copy 
ofTeachText. Choose the Find (Command-F) command from the File 
menu to find TeachText and remove all copies except one. 

Store Applications and Documents on Removable Media 
Ifyou've got access to a high-capacity removable-media disk drive, like 
a SyQuest or Bernoulli drive, use it to store applications and documents 
you use together. Say, for example, that you use a page layout program 
like QuarkXPress or PageMaker to create a monthly newsletter and an 
occasional flyer. Rather than install the application on your hard disk 
(PageMaker 5.0 takes up 17MB of hard disk space! ), install it onto the 
removable media. Store all the files you create with that program on the 
same cartridge or disk. Then, when you need to work with that pro
gram, pop in the cartridge and get to work. 

Defragment Your Hard Disk 
Your Macintosh tries to store each file you save on disk in one piece on 
a contiguous area of disk space. After a while, however, it's forced to 
break flles into multiple pieces, either because a file is resaved with more 
information than th.e last time it was saved or because there's simply less 
contiguous disk space available. This is called fragmentation and it's a 
normal occurrence. Your Macintosh can keep track of all the pieces of 
every file on disk. But accessing a flle saved in five pieces takes more 
time and effort than accessing a flle saved in only one piece. This slows 
down your Macintosh's operation. When more than 5 percent of the files 
on a disk are fragmented, the slowdown can become very noticeable. 

To help cut down on the time it takes your Macintosh to run pro
grams and open and save files, you can defragment your hard disk. This 
process takes all the file pieces and moves them around on disk until 
they're all reassembled properly. Unfortunately, Apple doesn't provide 
software to do this. That gives you two options if you want to defrag
ment your disk. 
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+ Use the Finder to copy all the files from your hard disk to an
other disk or set of disks. Then reform:lt your hard disk and copy 
all the files back onto it. As you can imagine, this can be quite a 
chore. But it's free and it does work. 

+ Use a defragmenting or optimizing utility sofu~are package. 
Some popular ones include CP Optimizer (part of Central Point 
Software's MacTools), Speed Disk {part of Symantec Corporation's 
Norton Utilities for Macintosh) , and Dislz Exp1·ess (part of ALSoft, 
Inc.'s ALSoft Por11e1' Utilities). While it might not be worth the 
cost of these packages just to defragment your hard disk, all 
three include other useful disk utilities. 

You back up your hard disk regularly, don't you? Well? The sad truth of 
the matter is that most computer users don't back up their files until 
after they lose information. They learn their lesson the hard way. Don't 
let this happen to you! 

This section covers a few backup tricks that can help make backing up 
software less of a chore. Perhaps it'll even encourage you to do it more 
regularly! 

Use the Find Command to Find New Files Created 
Since the Last Backup 
In the "Use the Find Command to Find Old Files" trick described in 
the "Spring Cleaning Tricks" section earlier in this chapter, you saw 
how you could use Find (Command-F) to locate old files. You can fol
low almost the same exact steps to locate new files created since your 
last backup. Rather than choosing Is Before in Step 4, choose Is Mter. 
Then set the date in Step 5 to the date of your last backup. The files 
your Macintosh fmds are the files that haven't been backed up yet. 



50 Mnciutosh Slick TI·icks 

Don't Back Up Applications 
Unless you have plenty of backup media, don't bother backing up ap
plications. Why? You should be able to reinstall all applications from 
their original program disks in the event of a problem. In fact, since 
many programs tend to store support fi les (preferences files, fonts, etc.) 
inside your System Folder these days, it's acutally better to reinstall a 
program from the ori.ginal disks than from a backup. This assures that 
all the files the program needs to run arc properly installed where they 
should be. 

What if you have a backup drive the same size as the drive you use for 
your day to day work? By all means, duplicate your hard disk on that. 
In the event of a hard disk crash, it's certainly easier to plug in another 
drive and keep working than to reinstall software and documents from 
backup disks. 

Store Documents and Applications Separately 

Documents stored separately from applications are much easier to back 
up. Simply drag the document folder icon onto your backup media icon 
and let the Finder do the rest. Even if you're forced to back up to floppy 
disks-don't worry, you' re not the only one-it's much easier to drag 
file icons onto floppies when they're all located in the same place on 
your hard disk. 

Back Up Important Documents Frequently 
If you back up all your documents on a weekly basis, great! That's bet
ter than most people. But what about documents that you work on 
every day, like long reports, complex spreadsheets, or even chapters of 
a book? A few day>s worth of changes could take days to reproduce if 
the originals were lost- if you could reproduce them at all. If you're 
working hard on files for an important project, back those files up at the 
end of each day. It shou ld be a simple matter of dragging file or folder 
icons to a floppy disk. That's another reason why organizing files by 
project, which we discussed at the beginning of this chapter, is such a 
good idea. 
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Use Compression Software on Backups 

If you've got lots offiles to back up but are stuck with floppy disks or 
other low-capacity media, compression softvvare may help by enabling 

you to fit more information on each disk. Although Apple doesn' t pro
vide compression software for the Macintosh, other companies do . 
There are two kinds of software to consider: 

• Standard compression software like Aladdin Systems' Stz~fflt 
Deluxe, Bill Goodman's Compact Pro, and Now Softv,rare, Inc. 's 

Now Compress can help you squeeze more files onto disks, 
whether you want to back up the files, store them offline, or sim
ply free up more hard disk space. 

• Backup software products ljkc Central Point Software's CP 

Baclzttp (part of Central Point Software's lvfacTools), Fifth Genera
tion Systems Inc.'s FastBaclz Plus, and Symantec Corporations's 
N01'ton Brtcllup (part of the N01-ton Utilities jo1· Macintosh) have 
file compression built in. That means they compress files auto
matically as they back them up. They also have other useful fea
tures that help make backing up easier to do. 

Store Backups Away from Your Computer 
Once you've backed up your files, store them in a safe place away from 
your computer. 'iVhy? Because if yom computer is destroyed by a fire, 
flood, or some other major catastrophe, your backup files will probably 
be desu-oyed, too. Don't take chances. 
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System Tricks 

M acintosh System software is unique in the world of computers be
cause it provides resources and instructions that other software 

uses- things ljke dialog boxes, windows, and error messages. In a way, 
it stands between the hardware and the application software, enabling 
them to communicate. 

This chapter provjdes you with tricks for installing the System soft
ware and making it slimmer, trimmer, and faster. You ' II also find a few 
simple customization tricks to help you give your Macintosh some per
sonality. 

Installation and Upgrade Tricks 

The System software comes on a number of rusks, complete with an 
Installer that makes installation easy. There are a few installation tricks 
you can take advantage of to make sure your System has o nly the 
components you really need. This may reduce the System's RAM 

53 



54 Macintosh Slick Tricks 

requirements, leaving more RAM for your applications. You' ll find 
those tricks, as well as tips for upgrading to a new version of the System 
software, in this section. 

Start Your Computer from the Install Disk 
If you're installing System software on your startup disk, you'll have to 
start your Macintosh with the first Install disk. Depending on the ver
sion of System software you ' re using, this disk could be labeled Install, 
Install l , or even Utilities l (System 6). T he System software that 
comes with PowerBooks sometimes has a disk called Install Me First. 

Do a Custom Install 
Apple's System Software Installer offers a number of options. Most peo
ple take the easy way out and click the Install button in the Easy Install 
window (see Figure 3.1 ) that automatically appears. This won't hurt 
your Macintosh, but it will install a lot of files you probably don't need. 
This increases the size of the System heap (the amount of RAM the 
System requires to run ), thus reducing the amount of RAM available for 
your applications. It also uses up additional disk space (although not 
much). The Customize button lets you override the Installer's recom
mended installation. 

Easy Install 

3.4 

Click I nstoll to ploce Uerslon 7.1 of 

• Moclntosh Fomlly System Softwore 
• All Printing Software 
• File Shoring Software 

on the hord disk named 

= Dr. Bob's Old Disk 

Help 

n Install D 

Eject Dislc 

( Switch Dlslc ) 

( Customiz e ) 

Quit 

Figure 3.1 The System 7.1 Installer's main installer screen 
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Install Only What You Need 
To do a custom installation, follow these steps: 

0 If you are installing the System software on your startup disk 
(usually your internal hard disk), start your Macintosh with the 
first Install disk in the drive. O n System 7 installation disks, 
this will automatically launch the Installer. If you are installing 
another system version , simply insert the first Install disk, dou
ble-click its icon if necessary to open it, and double-click the 
Installer icon to launch the Installer. If you're instaJling System 
6, you may have to double-click the disk icon to open it and 
double-click the Installer icon to launch the Installer. 

0 A "Welcome to the Apple Installer" screen appears. Click OK. 

0 The Easy Install window, which is illustrated in Figure 3.1, 
appears. Click Customize. 

8 The Custom Install window, which is illustrated in Figure 3.2, 
appea rs. Scroll down the list to fi nd the components you need 
to install. For example, say you have a Macintosh Ilcx and a 
StylevVriter printer and you're not interested in networking soft
ware. Scroll down in the list until you find Software for Style
Writer and click on it to select it. Its information appears 

Click the Items you wont to se lec t ; 
Shift-click to select multiple item s. 

System for Macintosh SE/ 30 ~ 
System for Macintosh II 
System for Macintosh IIH .......... ~~ .. ·~= System for Macintosh LC & LC II ' 
Syst em for Macintosh ll si 
System for Macintosh ll cl {)-

Sljstem for H~cintosh llcx 

Size : 3249K 
o .. te : Frl, Aug 29, 1992 

Ve r sion : 7 .1 
This package contains a compt.tt stt of Stj sttm Softwart for 
us• on the M•ointosh llcx . It is Intended for ust on a hard disk 
that .,;n only bt ustd v i\h the M•clntosh I lex. 

Figure 3.2 Performing a Custom Install 

n I nstoll JJ 

=Dr. Bob's Old Dislc 

( Eject Disk ) 

( Switch Disk ) 

(Easy I nstoll) 

Quit 
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below the scrolling window. Continue to scroll down until you 
find System for Macintosh Hex. Hold down the Shift key 
and click on it. The list under the scrolling window changes to 
a list of the software you've selected. You can select whatever 
options you need from the scrolling list . Just be sure to hold 
down Shift while selecting each one. When you're finished, 
click Install. 

0 The installation process begins. Your Macintosh will prompt 
you to insert disks. Follow the instructions that appear on the 
screen. 

0 When installation is completed, a message appears, telling you 
that it was successful. Click Quit (or Restart). 

Don't Choose Min System 

When doing a Custom Install, the Installer's scrolling window of 
options includes some for Min System. If you are installing System 
software on your startup disk, don't use these options! They create 
smaller System files that may exclude resources some programs need. 
They also omit desk accessories and control panels. 

Make Sure PrintMonitor Is Installed 
One possible drawback to doing a Custom Install and not choosing 
the Software for All Apple Printers option is that PrintMonitor 
may not be installed. Ifyou use PrintMonitor for background print
ing, you'll have to install it manually. 

0 Insert the Printing disk that is part of the set of System soft
ware disks. If necessary, double-click its icon to open it. 

0 Drag the PrintMonitor icon from the Printing disk window 
to the System Folder on your bard disk. 

8 Under System 7, your Macintosh will offer to place it in the 
E>.."tensions folder. Click OK. 
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Install the System Update 3.0 

The Macintosh System Update 3.0 is a two-disk set of software "en
hancements" that can improve the performance and reliabili ty of 
Macintosh models running System 7.1, 7 .1.1 (System 7 Pro) or 7.1.2 
(for the Power Macintosh). It is available for free (or for the cost of a 
disk) from Apple dealers, some online services, and many Macintosh 
user groups. 

System Update 3.0 consists of a wide variety of System enhancements 
and bug fixes-far too many to list here. The enhancements improve 
the way the System wo rks by adding features, like the ability to display 
color icons in standard Open and Save As dialog boxes. The bug fixes 
fix System problems that have been discovered since the release of the 
software. 

System Update 3.0 also contains updates to many control panels, 
desk accessories, and System Enablers used by certain Macintosh mod
els. It also includes updates to utility programs that ship with Macintosh 
computers: 

• Apple HD SC Setup 7.3.1 

• Disk First Aid 7.2 

• SimpleText 1.0 (which replaces TeachText) 

Reinstall the System Software 
When reinstalling System softvvare on a disk that already contains a Sys
tem folder, it's a good idea to start from scratch. There are two good 
reasons for this: 

• The System Softv,rare Installer tends to update existing System 
files. If your System or Finder are corrupted, the corruption may 
remain in the updated files. 

• The System Sofuvare Installer may delete non-Apple fonts, exten
sions, and control panels that you need. Replacing them from 
original disks can be very time consuming. 

Follow these steps to reinstall System software on a clisk that already 
has a System fi le. 
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0 Start your Macintosh with a boatable floppy. The Disk Tools 
disk that comes with the System software is a good choice. 
Don)t start with the first Install disk because it may not 
include a Finder file. 

0 Open the System Folder on the disk you are reinstalling on 
(not the floppy disk you started from). 

8 Drag the Finder fi le to the Trash. 

8 Ifyou're running System 7.0.x, double-click the System file 
icon to open it and drag all the non-Apple fonts , sounds, and 
keyboard layouts out. You may want to put them into a sepa
rate folder so d1ey're all together. If you're running System 
7.l.x, double-click the System fi le to open it and drag all the 
non-Apple sounds and keyboard layouts out. Ifyou're running 
System 6.0.x, use Font/DA Mover to copy all non-Apple 
fonts and desk accessories to one or more suitcase files. 

0 Drag the System ftle to the Trash and choose Empty Trash 
from the Special menu. 

0 Rename the System Folder to somed1ing else, like "Old Sys
tem Stuff." 

0 FoiJow the instructions in Install Only What You Need above 
to install the System software . Restart your Macintosh. 

C) If you're running System 7, open the old System Folder and 
drag the non-Apple Extensions, Control Panels, Fonts, and 
Desk Accessories onto your new System Folder icon. Don't 
drag the folders containing d1ese items- drag d1e items them
selves so your Macintosh puts d1em away properly and doesn't 
overwrite existing folders. Open your old Preferences folder 
and drag its contents onto your new Preferences folder. If 
you' re running System 6, open d1e old System Folder and drag 
non-Apple initialization devices and control panels onto your 
new System Folder. Use Font/ DA Mover to reinstall non
Apple fonts and desk accessories. Copy any preferences files in 
your old System folder to your new one. 

0 Drag the old System Folder to d1e Trash and choose Empty 
Trash from the Special menu. 
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Use this method to reinstall System software whether you're 
an upgrade or reinstalling because of corrupt files. 

Run the Compatibility Checker 

If you 're upgrading from System 6 to System 7 (what took you so 
long?) , run the Compatibility Checker that comes with the System 
software disks. This program analyzes your System 6 system to make 
sure all your software is compatible with System 7. It creates a report of 
its results and may move incompatible items out of your System folder 
into another folder. If all your application software is up to date, how
ever, you shouldn't find any major conflicts with System 7. If you don't 
have the Compatibility Checker, get it from your Apple dealer or look 
for it on online services or BBSes. 

Install the System Software on Another Disk 

You can install the System software on a disk other than your startup 
disk by clicking the Switch Disk option in the Easy Install or Custom 
Install window (see Figures 3.1 and 3.2) until the name of the disk you 
want to install on appears. 

De install Part of the System Software 

The System Software Installer has a Remove option hidden away in the 
Custom Install window. Select the component of the System software 
you want to remove (like a printer driver) and hold down the Option 
key. The Install button changes to a Remove button, as illustrated in 
Figure 3.3. Click that button to remove the component from the Sys
tem Folder on the selected disk. Note that this will only remove certain 
components from your System. 

Create a System 7 Boatable Floppy 
System 7 is big, but not too big to fit on a high-density floppy. You can 
create a System 7 install disk two ways: 

+ Duplicate the Disk Tools disk and remove the applications you 
don't need (like Disk First Aid and Apple HD SC Setup). In Sys
tem 7.1, that'll leave you with about 220 K of disk space you can 
use for applications. If you want another 369 K of disk space, 
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Click the items you want to se lect ; 
Shift-click to select mul tiple items. 

System for Macintosh SE/30 
Sy stem for Macintosh II 
System for Macintosh 1111 

System for Macintosh LC & LC II 
System for Macintosh I l si 
System for Macintosh I I ci 

S~st~m for Maointosh llcx 

Si.:": 3249K 
Dat~: Fri, Aug 28, 1992 

v~rsion : 7.1 

r 

This package contains a complete s•t of Syst•m Softwar e for 
us• on the Macintosh I lox. It fs intendod for use on a hard disk 
thai will only be used 'Wflh the Macintosh llox. 

D Install IJ 

= Dr. Bob's Old Disk 

( Eject Disk I 
( Switch Disk I 

(Easy Install ) 

Quit 

Figure 3.3 The Remove button appears when you hold down 
the Option key. 

Startup Tricks 

delete the Finder. Just remember that you must have an applica

tion on a disk in order to start from it. If you delete the Finder 

and replace it with another application, that application will 

launch when you boot fi·om the floppy. You will not be able to 

quit to the Finder. 

+ To create a custom boatable disk that will only work on a certain 

Macintosh model, you' ll need to be able to create a System file 

without overwriting the one on your Startup disk. That means 

you need either two floppy disk drives or a spare, non-startup 

hard disk or removable media. Follow the instructions in Install 

Only What You Need above to install the Min System for the 
specific computer on this disk. The resulting System folder 
should fit on a high density fl oppy disk. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
T he Macintosh startup process begins with a friendly sound, features a 
parade of icons across the bottom of your screen, and ends with the 

display of the Finder on your desktop. You might not realize it, but you 
can control this process. This section tells you how. 
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Disable System Extensions 

The parade of icons across the bottom of your screen at startup indi
cates that certain installed extensions and control panels are being 
loaded. System 7 users can easily prevent all of these programs from 
being loaded by holding down the Shift key on startup. When the 
"Welcome to Macintosh" startup screen appears, they'll see the added 
message: "Extensions off." This disables al l System extensions, control 
panels, and startup items. 

lfyou're a System 6 user, you must manually remove all initialization 
devices (the old name for extensions) and control panels before restart
ing your Macintosh to disable them. 

Specify Extension Loading Order 

You can specify the loading order of system extensions and control pan
els two different ways: 

+ Change the name of the extension or control panel so that it 
comes before or after others alphabetically. In the "File Naming 
Tricks" section of Chapter 2, you'll find some ideas for getting 
files to the beginning or end of the list. 

+ System 7 users can also force one control panel to load before 
the others by simply moving it into the Extensions folder. (The 
contents of the Extensions folder are loaded first .) Or, load one 
extension after the others by moving it into the Control Panels 
folder. Or, load any extension or control panel after all the others 
by moving it into the System folder (extensions and control pan
els found there are loaded last). 

Customize the Startup Screen 
You can change the standard "Welcome to Macintosh" screen to almost 
anything you Like. To do it, you'll need a program that can save graphics 
files in StartupScreen format, like Kevin Mitchell's GIFConverter 
(shareware), Thorsten Lemke's GraphicConverter (shareware), or Aldus 
Corporation's SuperPaint. 
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Extension Management Software Although extensions and control panels 
add all kinds of features-both useful and 
frivolous, depending on the program-to 

your Macintosh, they can also cause problems: 

• IN IT conflicts can occur when two {or more) of these files try to tell 
your Macintosh to do two things at the same time when your 
Macintosh simply can't do it. System bombs and unusual behavior 
result. 

• These files expand the size of the system heap, taking up valuable 
RAM so less is available for your applications. 

• Some of these files tell your Macintosh to do so much work in the 
background that your Macintosh's overall performance drops and 
operations become very sluggish. 

While some extensions and control panels are absolutely neces
sary for your everyday work, others aren't. If you have more than one 
full row of icons parading across the bottom of your screen, chances 
are you should consider removing the ones you can do without. 

Another option is to use an extension manager software product. 
Some good ones include Ricardo Batista/ Apple Computer, Inc.'s Exten
sions Manager {freeware), Now Software Inc.'s Startup Manager 
{part of Now Utilities), and In line Design's /NITPicker. 

0 Use a graphics program that can save in StartupScreen format 
to create or open a graphic that you'd like to see on your 
Macintosh screen when you start up. 

0 C hoose Save As from the File menu. Save the file in Startup
Screen format-a menu or radio button should give you this 
option. Name the file "StartupScreen" (without quotes, of 
course) and save it into the System folder. 

When you restart your Macintosh, your startup screen graphic will 
replace the "Welcome to Macintosh" box. 
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Use the Startup Items Folder 

On a System 7 Macintosh, anything placed in the Startup Items folder 
inside the System Folder is automatically opened on startup. Here are 
some ideas for taking advantage of this feature. 

+ To automatically launch an application on startup (like a calendar 
program or a word processor that you always use), put an alias of 
that application icon in the Startup Items folder. 

+ To automatically open a document on startup (like your calendar 
file, an address, book, or perhaps a Things to Do document), 
put an alias of that document icon in the Startup Items folder. 

+ To automatically play a sound at startup, put a System 7 sound 
file (or an alias of one) in the Startup Items folder. 

You can have as many items as you like in the Startup Items folder. 
All items will be opened in alphabetical order. When the dust settles, the 
last opened application or document will display the active window. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
One of the things that set the Macintosh apart from other computers 
years ago was its ability to use multiple fonts or typefaces in documents. 
Macintosh users take this for granted now and often collect and install 
dozens of fonts in their Systems. Here are a few tricks for using and 
managing your fonts. 

Use True Type Fonts or ATM (or Both) 

If font characters appear jagged on screen at certain sizes, you're miss
ing out on the benefits of two font technology gems: TrueType fonts 
and Adobe Type Manager (ATM). 

TrueType, which is incorporated into System 7 and can be added, 
with the use of an INIT to System 6.0.7 or 6.0.8, is an Apple Computer 
font technology. It makes it possible to smoothly scale any TrueType 
format font to virtually any size on screen or on paper. TrueType fonts 
come with the Apple System software. Other TrueType fonts are avail
able from many font vendors. 
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Which Font Is Used on Screen? With bitmapped, True Type, and PostScript 
fonts installed in your Macintosh, you may 
wonder which font is actually used to dis

play characters on screen. Your Macintosh looks for fonts for screen 
display in the following order: 

• Bitmapped in required size 

• TrueType 

• PostScript (processed with ATM if ATM is installed) 

• Bitmapped !scaled) 

ATM is a utiliry by Adobe Systems Incorporated. It makes it possible 
to smoothly scale any PostScript Type l font to virtually any size on 
screen or on paper. ATM is a " must-have" utility for anyone who uses 
PostScript fonts and does not have a corresponding TrueType version 
of the font installed . I f you don't have PostScript fonts, however, you 
don' t need ATI"\t/. 

Find and Use Special Characters 
Most fonts include more characters than just d1e letters, numbers, and 
punctuation marks you see on the keyboard . The characters you don't 
see- the special characters-can be ryped right from your keyboard if 
you know the proper keystrokes. 

Apple gives you a desk accessory you can use to identify all the char
acters in a fo nt: Key Caps. It's illustrated in Figure 3.4. H ere's how you 
can use it. 

0 Choose a font from the Key Caps menu. The tops of the keys 
on your screen change to that font. 

0 Press Shift to see uppercase characters and regular symbols. (If 
Caps Lock is turned on, you'll see uppercase characters, but 
you won' t see regular symbols unless you press Shift.) 

0 Press Option to see some of the special characters. Note their 
positions on the keyboard iUustration-pressing that character 
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Figure 3.4 Key Caps displays special characters with the 
Option key held down . 

with the Option key held down produces that character. For 
example, the bullet character (which is available in most fonts) 
appears at the 8 position. Pressing Option-S produces a bullet 
in most fonts. (Characters that appear as boxes are undefined 
and shouldn't be used in that font.) 

8 Press Option-Shift to see some more special characters. These 
work the same way as the Option characters, but you must 
press Option and Shift together while you press a keyboard 
key to get the special character. 

0 You can type characters right into the Key Caps edit box if you 
like. Or, if you prefer, you can click on the characters you want 
to use to put them into the edit box. 

0 You can select the contents of the Key Caps edit box and copy 
them to d1e Clipboard with the Copy (Command-C) com
mand under the Edit menu. You can then paste them into any 
document with the Paste (Command-V) command under the 
Edit menu. 

Once you know the keystrokes for d1e characters you want to use, 
you don' t need Key Caps. Just type the characters right into your docu
ments using d1e appropriate keystrokes. 

Type Accented Characters 
Your Macintosh also lets you type accented characters, such as e, a, fi, 

and i. T his is a two-step process. The first step tells your Macintosh 
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A Great Utility for Special Characters Although Key Caps works, it 
doesn't have any bells or whistles 
that make it stand out from other 

programs. Gunther Blascheck's Pop Char, however, does. This free
ware control panel puts a hot spot in your menu bar. Press your 
mouse button down on this spot and a display of all available charac
ters in the current font appears. Click on a character to insert it into 
your document instantly. No fooling with desk accessories, no remem
bering keystrokes. Best of all, this little shareware program is free. 

which accent character you want. T he second step tells it which charac
ter to put under the accent. 

Here's a list of the keystrokes to get the accented characters: 

Accent Character 

fl 

Keystroke 

Option-' 

Option-E 

Option- U 

Option-! 

Option-N 

So, to type e, press Option-E and then E by itself. To type a, press 
Option-U and then A by itself. Get the idea? Give it a try. Just remem
ber that not all accented characters are available in all fonts. Your best 
bets are T imes, Helvetica, and Courier. 

Remove Seldom-Used Fonts 

Fonts take up ctisk space, increase the size of your System heap, and 
make Font menus long. Remove fonts you don't use to make your Sys
tem slimmer and trimmer. 
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Font Utility Software If you've got lots of fonts installed in your system, you may 
be interested in a few utilities that can help you manage 
and use them. 

Monitor Tricks 

• Fifth Generation Systems' Suitcase and AI Soft Inc.'s Master Juggler 
(part of ALSoft Power Utilities) let you store fonts outside your Sys
tem file or System folder. This makes it possible to quickly and eas
ily install those fonts you need just when you need them. 

• Adobe Systems Incorporated's ATM was mentioned earlier in this 
chapter. It's a PostScript interpreter for your Macintosh that can 
scale PostScript fonts to any size on screen. This eliminates the 
jagged characters that may appear when your Macintosh tries to 
scale bitmapped fonts. SuperATM can also substitute standard 
fonts for missing fonts in a document and includes Adobe Type 
Reunion to group font families in menus. 

• Now Software, Inc.'s WYSIWYG Menus (part of Now Utilities) dis
plays fonts in their actual typefaces in application Font menus. 

. . . . . . . . . . . . . . . . . . . . . . . . . . 
If you've got a Macintosh with a color monitor, you'll see that it can do 
tricks, too. 

Reduce Colors to Increase Speed 
The more colors (or shades of gray) your Macintosh monitor needs to 
display, the harder it needs to work to display them. You can often speed 
up your Macintosh simply by reducing the number of colors it displays. 

0 Open the Monitors control panel. The color depth options 
offered in the scrolling window at the top of the control panel 
will vary depending on your system's color capabilities . (See 
Figure 3.5.) If your system supports 8-bit color, the maximum 
will be 256 colors. I f it supports 32-bit color, the maximum 
will be billions of colors. 
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IS€¥ Monitors 
Ch•roott rlstios of stltott d monitor : 7.0 

QGn ys: Bl•ck & 'o'hllt If-
®Colors : i6 t (Options ... ] 

...l.! 
Thousands + 

Dr19 monitors and mt nu b•r to r u rr•ngt them. 

-
( Identify J 

Figure 3.5 The Monitors 
control panel lets you 
change color depth. 

0 Click one of the options for fewer colors than your system can 
support. You might want to try 4 or 16. If your system can 
support thousands or millions of colors, try 256 colors. If you 
want a radical change, try Black and White. 

Keep in mind that some graphics programs and games require a cer
tain color depth. If that's the case, you '11 have to reopen the Monitors 
control panel and change the color depth back to at least the minimum 
required for that program before using it. 

Working with Multiple Monitors 
If you've got more than one monitor connected to your Macintosh, you 
can set them up so that you can use both at the same time. 

0 Open the Monitors Control Panel. The monitor arrangement 
appears at the bottom of the control panel window. (See Fig
ure 3.6.) 

0 Drag either monitor icon to position it beside, above, or below 
the other. 

0 If desired, drag the menu bar from one monitor to the other. 
The monitor with the menu bar becomes the primary monitor. 
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Ch.r act•ris tlcs of s•l•c t•d monitor : 7.0 

[Options ... ] 

[ Identify J 

Figure 3.6 Setting up two 
monitors 
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8 You can also set the color depth for each monitor. Click on 
one of the monitor icons in the control panel to select it, then 
chan ge the color dep th at the top of the control panel. They 
don't have to be the same. 

You may have to restart your Macintosh for changes to take effect . 
Once you've set this up, you'll find that your mouse can move off one 
monitor and onto the other. You can place document windO\:vs on either 
monitor. 

See a Happy Mac 

To see a happy Mac, open the Monitors control panel and hold down 
the Option key. 

RAM, like disk space, is another computer component there never 
seems to be enough of. Fortunately, many Macintosh models can accept 
lots of RAM-up to 256 MB in some models. This section offers some 
tips and tricks for using the RAM you have and getting more RAM 
when you need it- all witho ut opening your Macintosh. 
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Examine RAM Usage 
Check the amount of RAM in use and free by choosing About This 
Macintosh from the Apple menu. (The Finder must be the active ap
plication to do this.) Check Figure 3.7 for an example. 

Use the Cache 
A disk cache is a special area of RAM set aside for frequently used infor
mation. Your Macintosh uses tl1is area to store instructions it thinks it 
might use again. Since it's faster for the CPU to get instructions from 
RAM than the hard disk, a RAM cache can speed up your Macintosh's 

operations. 
System 7 users can set the Disk Cache with the Memory control 

panel, which is illustrated in Figure 3.8. System 6 users can set the 
Cache in the General control panel. Use tl1e arrows to increase or de
crease tl1e setting. Keep in mind tl1at the larger you make the cache, the 
larger your System heap will be. This decreases the amount of RAM 
available for applications. 

Don't Set the Cache Too High! 

If tl1e disk cache can speed up your Macintosh by giving it a place 
to store and retrieve freq uently used instructions, the bigger the 
disk cache, the faster your Macintosh should run, right? Wrong. 
The CPU searches the cache for needed instructions before it 
looks on your hard disk. If the cache is very large, it spends a lot 
of time searching for instructions that may or may not be there. 
Mter a certain point, this can actually slow down your Macintosh. 
Most hardware gurus recommend setting the cache to 32 K per 1 
MB of RAM. That means about 256 K for an 8 MB Macintosh. 

In addition to all tl1is, some graphics programs have their own 
recommended cache settings. Consult tl1e documentation for the 
applications you use most to see what they recommend. Then set 
your cache at a level tl1at shou ld be acceptable to all of them. 
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~Ei - ~---- About This Motlntosh • -- li!E 

Sy s l • m Softvar" 7 . I 
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~ Capture Viewer 1 ,SOOK I I 

• Microsoft Word 2 ,000K 
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Figure 3.7 About This Macintosh shows RAM 
usage. 

Use Virtual Memory to Add RAM for Free 

Q 

0 
0 

If you see the "Not Enough Memory ... " message too often on your 
Macintosh and aren' t ready to invest hard cash on additional RAM, vir
mal memory might be the answer. Virtual memory fools your Macin
tosh into thinking that an invisible fi le it creates on disk is really RAM. 
You turn on virtual memory with the Memory control panel. 

0 Open the Memory control panel. 

0 Choose the On radio button in the Virtual Memory area. 

0 Use the Hard Disk pop-up menu to choose a hard disk. The 

IJ,iD ·- --

v7.1 

amount of hard disk space and real RAM will determine the 
amount of virmal memory you can create. Use the arrows that 

- 1 Memory -- · 

Disk Cacho 
Always On 

Virtual ~morv 

Qon 
@Off 

32-Bi\ Addr .. sing 

Oon 
@)Off 

Cacho Sizo 

S•l.ot Hard Disk : 
r-------------·--·--------------
1 c7, lhml Ois~ ..,. I 

Available on disk: 6M 
Available bu ilt -in memory : SM 

( Use Defoult s J 

Figure 3.8 The Memory control panel 



72 Macintosh Slick Tricks 

appear to select the total amount of virtual memory you want. 
(See Figure 3.9.) 

A quick note here: You can't use removable media like a SyQuest 
cartridge for virtual memory. The Memory control panel just won't let 
you do it. 

Virtual Memory Isn't Always the Answer 

When using virtual memory, there are two important things to keep 
in mind: 

+ Virtual memory is slower than real RAM. This can slow down 
your Macintosh. Because of this, it's not a good idea to de
pend on virtual memory to meet long-term RAM needs. 

+ Virtual memory uses up hard disk space. The invisible file it 
creates on disk will be equal to the total RAM you end up 
with. So if you've got 13 MB of virtual memory, that's 13 MB 
of hard disk space you can't use for file storage. 

Get Beyond the 8MB RAM Barrier 
If you want to install more than 8 MB of RAM in your Macintosh, 
you'll have to turn on 32-bit addressing to use it. If your Macintosh 
supports 32-bit addressing, you can turn it on in the Memory control 
panel. (See Figure 3.8.) 

All the newer Macintosh models with 68030 or 68040 processors 
have "32-bit clean" ROMs. Older 68030 Macintoshes, like the Mac II, 
Ilx, !lex, or SE/ 30 need a little help: a control panel called Mode32. 
This program, which was originally developed by Connectix Corporation, 

Virtual Memory 

@on 
Oott 

Select Hard Disk : 

I CJ Quantum 80 T I 
Available on disk : 13M 

Available built-in memory : SM 

After restart l:i1EL:] [ID 

Figure 3.9 A closer look at Virtual Memory settings 
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If you want more RAM but don't 
want to buy and install RAM chips, 
check out Connectix Corporation's 

RAM Doubler. This program can double the amount of installed RAM 
on your Macintosh. Connectix makes a number of other RAM-related 
software products, too. 

was licensed by Apple Computer, Inc. and is freely distributable. You 

can find it on many online services and BBSes. 

Create and Use a RAM Disk 

A RAl\11 disk is the opposite of virtual memory. \iVhen you create a RAM 
disk, you' re using RAM as disk storage space. When used properly, it 

can reduce the number of times your Macintosh accesses its hard disk. 

This is especially useful for PowcrBook users who need to extend bat

tery life . 

About RAM Fragmentation In order to launch an application, you must have 
enough free contiguous RAM to meet its RAM allo-
cation needs. For example, to open a program that 

requires 1024 K of RAM, you must have that much contiguous space. 
You can see how much contiguous RAM is available in the About This 
Macintosh window beside Largest Unused Block. (See Figures 3.7 
and 3.10.) 

As you work with your Macintosh, opening and closing applications 
throughout the day, RAM gets fragmented. This is a normal occur
rence and has no side effects other than reducing contiguous RAM. 
You can tell if RAM has been fragmented by consulting the About This 
Macintosh window. lfthe total RAM used by applications plus the 
Largest Unused Block does not equal the Total Memory, your RAM is 
fragmented. This is illustrated in Figure 3.1 0, where the total RAM 
used is 7017 K, the Total Memory is 8192 K, and the largest Free 
Block is only 622 K. The missing 553 K of RAM is not part of the 
Largest Free Block and cannot be used. 
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- About This Macintosh 
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Apple provides a RAM disk utility with PowerBooks. If you don' t like 
Apple's utility, check out Connectix Corporation's Maxima and Mark 
Adams' AppDisk (shareware). AppDisk is especially useful because it's 
an application and doesn't require you to restart your Macintosh to use 
it. With it, you can create and remove a RAM disk on the fly. 

Even when RAM is used as a disk, it's still RAM. That means that if 
your Macintosh shuts down because of a System bomb, power out
age, or you choose the Shut Down or Restart commands, everything 
on the RAM disk will be lost. A good RAM disk utility will automat
ically copy the contents of the RAM disk to real disk space peri
odically. Be sure the contents of your RAM disk are copied to real 
disk before you shut down your Macintosh. 

Defragment RAM 

There are two ways to defragment RAM: 

• Quit all open applications. Often, this is enough to restore the 
Largest Free Block to its maximum size. 

• Restart your Macintosh to completely clear RAM and start fresh. 
This is a foolproof way to maximize the Largest Free Block. 
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Map Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Many people d1ink that the Map control panel is nothing more than a 
cute map of the world . It does have a practical use, however: You can 
use it to localize your Macintosh. Here are some tricks for using and 
customizing the Map. 

Tell Your Macintosh Where It Is 
By localizing your Macintosh, you tell it where it is. While d1is might 
not be important for desktop Macintosh models, it's useful for Power
Books. Localizing your Macintosh automatically adjusts the system 
clock. 

0 In the Map control panel (i llustrated in Figure 3.11), type in 
the name of the closest major city and click Find. 

0 If it finds the city you've entered, an asterisk blinks there on 
the map. Click Set to select that as the current location. If it 
doesn't find d1c city, read on to learn how you can add a city 
and view all cities. 

Find Out Distances Between Two Cities 
When you use the Find button to find a city, d1e Map control panel 
automatically displays the distance between that city and d1e "set" city 
as well as d1e local time in the found city. 

Latitude 

Long1tude 

T i me Zone 

mi 0 1:50PM 

Figure 3.11 The Map control panel 
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Add a City to the Map 
I f your city isn't one of those programmed into the map, you can add it. 

0 In the Map control panel type in the name of the city, its 
Longitude, its Latitude, and the number of hours its time is 
before or after Greenwich mean time. Use the N and E check 
boxes to specify locations north of the equator or east of 
Greenwich. Use the + check box to specify whether the hours 
in the time zone difference should be added to or subtracted 
from Greenwich mean time. If you don' t know a city's longi
tude and latitude, you can click on the map to indicate its 
approximate location. 

0 Click Add City to add the city to the list of cities on the map. 

Scroll Through All Map Locations 
If you 're curious to see what cities are included on the Map, hold down 
the Option key and press Return to cycle through all of them in alpha
betical order, beginning with the last one you found. The map view 
changes to show each city. 

Zoom In to the Map 
To zoom in on the map view, hold down the Option key while opening 
the Map control panel. 

Colorize the Map 
If you have a color monitor and would like to replace the boring black 
and white map wi th something a little more interesting, follow these 
steps: 

0 Open the Scrapbook desk accessory. 

0 Scroll through the images until you fi nd the one with tl1e color 
map. 

0 Choose Copy (Command-C) from the Edit menu. 

8 Close the Scrapbook. 

8 Open the Map control panel. 

G Choose Paste (Conunand-V) from the Edit menu. 
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0 A dialog box with the following message appears: "Paste will 
replace the current map with the picture in the Clipboard. Are 
you sure you want to do this?" Click Replace. 

The color map image replaces the standard one. 

Find the Middle of Nowhere 
If you've ever wondered where the middle of nowhere is, use the Map 
control panel to find it. 

Miscellaneous System Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Here are a few tricks that couldn't be categorized elsewhere in this 
chapter. You might find them useful. 

Customize Your Keyboard 
The Keyboard control panel, which is illustrated in Figure 3.12, lets you 
customize the way your keyboard works. 

+ Click a radio button to choose a Key Repeat Rate. This specifies 
how quickly a key should repeat when you hold that key down. 

+ Click a radio button to choose the Delay Until Repeat. This 
specifies how long your Macintosh waits before it starts repeat
ing a key you hold down. 

~0- : Keyboard 

Key Repeat Rat e Delay Until Repeat 

000®0 0 0®00 
Slov Fast Off Long 

Koyboard Layout 

~ 

~U.S. - System 6 

Figure 3.12 The Keyboard 
control panel 

Short 

0 

~ 
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Switch Keyboard Layouts 
System 7 users can install additional keyboard layouts by dragging them 
onto the System file icon. This can be very handy if you often have to 

type in foreign languages or if you prefer a Dvorak keyboard layout for 
faster typing. Keyboard layouts are often available from font vendors 
and on online services and BBSes. 

If you have more than one keyboard layout installed in your System 
fi le, you can switch among them depending on your needs. There are 
two ways to do this: 

+ Open the Keyboard control panel (see Figure 3.12), choose the 
one you want from the scrolling list, and close the Keyboard con
trol panel. 

+ Press Command-Option-Spacebar to select the next layout 
alphabetically without opening the Keyboard control panel. 

Customize Your Mouse 
The Mouse control panel , which is illustrated in Figure 3.13, lets you 
customize the way your mouse works. 

+ Click a radio button to choose a Mouse Tracking speed. Thjs 
changes the speed the mouse moves on screen in relation to the 
actual mouse movement. 

+ Click a radio button to choose Double-click Speed. If you just 
can't seem to double-click fast enough to satisfy you r Macintosh, 
this is where you can tell it to expect slower double-clicks. 

MousP Trackin9 

[1J ~ ~ 
0 0000®0 

Very Sl ow Slow Fast 

+ + + 
• o •o + ® 

Double-Click SpePd 

Figure 3.13 The Mou se 
control panel 



Chapter 3: System Tricks 79 

Maintain More Than One System Folder 
If you find yourself needing to switch back and forth between two ver
sions of the System software-perhaps System 6 and System 7-having 
two System folders can help. Although it is not a good idea to have both 
System folders on the same disk (your Macintosh can get confused and 
look at the wrong files), there's no reason why you can't have one on 
your internal hard disk and another one on an external hard disk or re
movable media. 

To do this, use Apple's System Software Installer to install a second 
System Folder on another disk. To switch from one to the other, do 
this: 

+ With System 7 running, use the Startup Disk control panel, 
which is illustrated in Figure 3.14, to choose a disk you want 
your Macintosh to boot from when you restart. Then restart. 

+ With System 6 running, open the Control Panel desk accessory 
and choose the Startup Device icon. Then choose the disk you 
want to boot from. Close the Control Panel and restart. 

If you do this a lot, you may want to check into a handy freeware 
program called Switcher by Keisuke Hara. It automatically searches for 
all mounted disks that contain System Folders and lets you pick the disk 
to boot from. If you pick a System 6 System Folder, it even lets you 
choose between Finder and MultiFinder. 

~= Startup Disk 

Stltct ~ St~rtup Disk : 

Q - G:::::::l - Seven-Oh 

G:::::::l G:::::::l 
Quantum 80 BBS 

0 

Figure 3.14 The Startup 
Disk control panel 
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O ne thing to keep in mind here: When you switch from System 6 to 
System 7, your Macintosh will rebuild its Desktop file automatically. 
Don't stop it; it needs to update this information. You'll then have two 
versions of this invisible file on your disk. In Chapter 10, you'll see how 
you can delete one of them. 

Try a System Optimizer 
Several shareware products can "optimize" your System, adding key
board shortcuts, changing the way things work to speed them up, and 
letting you customize the appearance of your Macintosh. Among these 
are Speedy Findet· 7 by Victor Tan, System 7 Pack! and System 7 Compan
ion Pack! by Adam Stein, and Finde1,·Edit by Dan Weisman. Look for 
these products on online services and BBSes. 
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Software Tricks 

A computer is completely useless without software. Macintosh users 
depend on applications like Microsoft Word, Claris MacWrite Pro, 

Claris FileMaker Pro, ClarisWorks, Microsoft Excel, QuarkXPress, and 
Aldus PageMaker to create documents and get their work done. 

In this chapter, you'll find some tricks for installing, launching, and 
using applications. Although most of the tricks in this chapter will work 
with any application, you'll find a few application-specific tricks as well. 
For even more tricks for your favorite applications, check out the rest of 
the Slick Trick series of books. 

Installation Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Before you can use software, you need to install it. In the old days, most 
programs carne on just one floppy disk. You'd drag the program icons 
from the disk window to your hard disk and get to work. Nowadays, 
many programs come on multiple disks and have fancy installers like
Apple's System Software Installer-that let you decide what to install. 

81 
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How do you decide? How can you install software quickly and easily? 
That's what d1is section is about. 

Read the Read Me File 
The first installation disk for many programs includes a "Read Me" file. 
This file, which is normally in plain text or TeachText-readable format, 
provides important information about installation and program features 
that is not included in the software or installation manuals. Read this file 
before you install the software. It could contain installation instructions 
you ' II need to install it right on the first try. 

Install Only What You Need 
When a program comes on seven high-density floppy disks, you can bet 
it's . going to take up a lot of space on your hard disk when you install 
it. But it doesn't have to be that way. Like Apple's System Software In
staller, most installers let you choose what to install. (In fact, many in
stallers are based on Apple's Installer so they look and work the same 
way. Check Chapter 3 for details on Apple's Installer.) Figure 4.1 shows 
an example of d1e main installer screen for Microsoft Excel4.0. Notice 
how it offers Complete, Custom, Minimum, and Network installa~ 

tion options. If you click Custom, d1e installer offers check boxes to 
choose components of the program. You can see this in Figure 4 .2 . 

Microsoft EHcel I nstollot ion Types 

lnstoll Microsoft EHcel ond oil its 
options. 

Ins toll oil or port of Microsoft EHce l ond 
Its options. 

I nstoll the minimum set of files required 
to run Microsoft EHcel. 

Install Microsoft EHcel onto o network 
seruer for others to install. 

Quit Setup. 

Figure 4.1 Microsoft Excel's main installer screen 

K Complete n 

[ Custom ) 

[ Minimum ) 

[ Network 

Quit 
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ICS! Applications "" I 
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0 FlleM11Icer Pro 
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n OIIHrl ~ 
[ Setup l 
[ Quit l 
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0 (New Folder) 

Space Ruailllble: 
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47616K '-------------' 
lnst11llation folder: Applications 

Figure 4.2 Microsoft Excel's custom install screen 

Not all installers work the same way, but if you need to install soft
ware, always check the custom installation options first. You can save 
disk space and reduce the amount of RAM a program requires to run 
by installing only the features and components you need. 

Install Other Components Later 
If you've installed an application with Custom or Minimum installa
tion options, you may find later that certain features you need are miss
ing. In most cases, you can use the software's installer to simply add the 
missing features, rather than reinstalling all the software from scratch. 
This can save a lot of time and disk swapping. 

Use Disk Images to Install Software Without Swapping Disks 
If the software you need to install is in disk image files, you can often 
install it without swapping disks at all. To do this, you need a disk image 
mounting utility. Mountimage by Steve Christensen is a freely dis
tributable control panel that you can find on many online services and 
BBSes. 

0 Open the Mountlmage control panel, which is illustrated in 
Figure 4.3. 
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Figure 4.3 The Motmtimage 
control panel 

0 Click an icon beside d1c words "click me-I'm a disk 
wannabe." 

8 Use d1e standard Open dialog box iliat appears to locate and 
Open a disk image file. A fl oppy disk icon appears on your 
Desktop. 

8 Repeat Steps 2 and 3 for each disk you want on your Desktop . 
You can open up to eight disk images this way. Your Macintosh 
minks each icon that appears on your Desktop is a real fl oppy 
disk, no matter how many floppy disk drives your Macintosh 
has. 

0 Close MotmtTmage. 

Mount/mage and Mt.lmage System 7 users can mount disk images with a drag
and-drop interface with Mt.lmage, a freeware 
drag-and-drop application by "Basuke." Although 

it requires that Mount/mage be installed properly in your Control Pan
els folder, it enables you to bypass Mountlmr:tge's control panel inter
face. To mount a disk image file, simply drop its icon onto the 
Mt.lmage file icon. 
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0 If necessary, double-click on the first installer disk's icon to 
open it. Launch the installer and follow the instructions that 
appear on your screen to start the installation process. Now go 
get a cup of coffee or soda while your Macintosh installs the 
software. You will not be asked to insert any disks. 

RAM Allocation Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
The amount of RAM an application takes up when it's launched is de
termined by the settings in the Get Info window for that application. 
Chapter l looked at this briefly. In this section, you' ll learn more about 
an application's RAM needs. 

Find How Much RAM Is Really Used 
As discussed in Chapter 3, the About This Macintosh window shows 
RAM usage. For each open application, it displays a bar. The total bar 
length is determined by the amount of RAM allocated to the program 
in the Get Info window. This is called the application heap. The dark 
gray portion of the bar represents the amount of RAM actually used by 
the application at that moment. The light gray portion represents the 
amount of additional RAM in the application heap that is not in use by 
the application. Here's how System 7 users can find out exactly how 
much is in use. 

0 Witl1 at least one application (other than the Finder) open, 
choose About This Macintosh from the Apple menu. (The 
Finder must be the active application for this option to appear.) 

0 Choose Show Balloons from the Help (or Balloon Help) 
menu. 

0 Point to the bar for one of the open applications. The amount 
of RAM in use is displayed in the balloon, as illustrated in 
Figure 4.4. 
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Figure 4.4 Balloon Help has at least one practical usc. 

Find Out How Much RAM an Application Really Needs 
Using the information you get from balloon help in the About This 
Macintosh window, you can determine approximately how much RAM 
an application needs to run. 

0 Launch an application you use often. Use it to open the num
ber and type of documents you normally work with at once. 

0 Follow rl1e instructions under "Find How Much RAM Is 
Really Used" above to find out how much of the application 
heap the application uses during an average session. 

Generally speaking, the application heap bar should always have some 
light gray area. Recommendations on how much of the application heap 
should remain free range from 5 to 25 percent of the total heap size. In 
Figure 4.4, .Microsoft Word is using only 1286 K of the 2000 K set 
aside for it. T hat means nearly 36 percent of the application heap is free . 
(You can calculate the percentage of free space by taking the difference 
between the actual amount used and the amount set aside and dividing 
that by the amount set aside: (2000-1286)/ 2000 = .357.) If the num
ber and type of documents currently open is a good representation of a 
normal session, the RAM allocation for Word could be reduced to free 
up RAM for more applications. Of course, if the amount of free space 
were only 5 percent, the RAM allocation should probably be increased 
to give the application some "breailiing space." 
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Whatever you decide, keep in mind that additional RAM allocated to 
an application could make the application run faster. Only through mak
ing changes and evaluating results can you get an idea of how the RAM 
allocation should be set for the best results. 

Set the RAM Allocation 
Setting the RAM Allocation in the Get Info window lets you tell you r 
Macintosh exactly how much RAM to use. 

0 If the application is open, choose Quit from tl1e File menu to 
quit it. 

G Click once on the application icon to select it. 

0 Choose Get Info from the File menu. 

The application's RAM allocation can be set in tl1e bottom oftl1e Get 
Info window. How this area of tl1e Get Info window looks depends on 
tl1e version of the System software you're using, as illustrated in Figure 4.5. 

+ On a System 6.0.x Macintosh, you can only change the RAM 
allocation when you're using MultiFinder. The Suggested Mem
ory Size is what the programmer recommends for the program. 
The Application Memory Size edit box is where you can enter 
a new value. 

+ On a System 7.0.x Macintosh, the Suggested Size is what the 
programmer recommends for the program. The Current Size 
edit box is where you can enter a new value. 

+ On a System 7. l.x Macintosh, tl1ere are three RAM allocation 
numbers . The Suggested Size is what tl1e programmer recom
mends for the program. The Minimum Size edit box is where 

Suggested Memory Size (K): 1 000 

Application Memory Size (I<): 1000 

, ... Memory ................ · ... , 
: S•Jggt-sled :;1:e · 1 ,000 K i 

:. ~~m:en~ .. :i=.~ · ..... ~ ... ~: ... .J 

Figure 4.5 RAM allocation options for System 6 .0.x, System 7.0.x, 
and System 7 .l.x 
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you can enter a minimum RAM allocation for launching the 
application when there is a RAM shortage-in this case, your 
Macintosh will use whatever RAM is available to launch the pro
gram, but will never use less than the Minimum Size you spec
ify. The Preferred Size edit box is where you can enter the 
amount of RAM you really want the program to use. When you 
launch the program, your Macintosh will check available RAM 
and then use whatever it can, up to this value. 

If you enter a value less than the Suggested Size in a RAM Alloca
tion edit box, a warning dialog box like the one in Figure 4.6 may 
appear when you close the Get Info window. Heed this warningt 
Running an application with less than the RA.i\1 recommended by 
its programmer can cause unreliable program operation and loss of 
data. 

Drag-and-Drop Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
System 7 introduced drag-and-drop applications. Simply drag a docu
ment file onto an application icon and the document opens with that 
application (provided the application can open that type of document). 
Here are some tricks for taking advantage of the drag-and-drop features 
of System 7. 

You houe set the Minimum size below 
300K, which moy couse "Oislnfectont" to 
eros h. 

Are you sure you wont to continue? 

[ Concel J fi OK D 

Figure 4.6 A warning you should heed 
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Open a Document Created by One Application with Another 

You can use drag and drop to open a document created by one applica
tion with another application- fo r example, opening a Microsoft Word 
document with Claris MacWrite Pro. Simply drag the document icon 
onto the icon for the application you want to open it with and let go. 
When d1e oudine of the document icon moves on top of the application 
icon, the application icon becomes highlighted, as illustrated in Figure 
4.7. If the application is already running, the document simply opens in 
that application. If the application not already running, the application 
launches first, then opens the document. 

There are two things to keep in mind when using drag and drop to 
open documents: 

• Not all applications can open all documents. If you drag a 
document icon onto an appucation icon and t11e application 
icon does not become highlighted, the application will not 
open that document. 

• When you save a document, it gets the type and creator code 
of the application you saved it in . So ifyou open a Word docu
ment with MacWrite Pro and save it, it becomes a MacWrite 
Pro document. 

Open Multiple Documents at Once 

You can use drag and drop to open more than one document at a time. 
Simply drag multiple document icons on to an application icon to open 
them all. 

Figure 4.7 Drag and drop opens a document 
created by one application with another. 



90 Macintosh Slick Tricks 

Drag and Drop onto Aliases 
If you use drag and drop to open documents on a regular basis, make 
aliases of your favorite drag and drop applications and either keep them 
on your Desktop or in a folder on your Desktop. Drag and drop works 
with aliases as well as original application files. 

Template Tricks 

A template is a formatted document file that you use to create new 
documents with similar layouts. Templates can be used as forms for 
memos, fax transmittal sheets, reports, letters, newsletters, fmancial re
ports-almost any kind of document that is created repeatedly with 
consistent formatting. Templates save time and effort by eliminating the 
need to format documents. 

The trick to creating and using templates is to make sure the original 
template file is not overwtitten by a completed document based on the 
template. System 7 offers Stationery files just for this purpose. This sec
tion tells you how to create templates as well as how to take advantage 
of templates in some popular Macintosh applications. 

Create Templates with Get Info 
The Get Info window offers two ways to turn a regular document into 
a template . 

0 Create and save a document you want to use as a template. 

0 Quit the application that you used to create the document. 

0 Locate the document icon and click once on it to select it. 

0 Choose Get Info (Command-!) from the File menu. 

8 Turn on either the Locked check box or the Stationery pad 
check box, as shown in Figure 4.8. T he Locked check box, 
which is also available to System 6 users, makes it impossible to 
save the same file with the same name. The Stationery pad 
check box turns the document into a System 7 Stationery file. 
Opening a Stationery file automatically opens an Untitled 
document with tl1e same exact formatting and contents of the 



I 0Lock~d 0 StaHonerg p~d I 
Figure 4.8 The Get Info window offers 
two options to create templates. 
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Stationery file. Note that if you turn on Stationery pad, the 
ftle's icon may change. 

0 Click the close box to close the Get Info window. 

Create Templates with Save As 

The Save As command in most applications offers an opportunity to 
save a file as a Stationery file. Opening Stationery automatical ly opens 
an Untitled document with the same exact formatting a~d contents as 
the Stationery file. 

0 Create a document you want to use as a template. 

0 Choose Save As from the File menu. 

8 Use the directory portion of the window to open tl1e folder 
you will save the file into. 

0 Enter a name for the file. You migh t want to include the word 
"Template" as part of the file name so you can identify it easily 
in directory dialog boxes. 

8 Look for a pull down menu, radio button, or otl1er method to 
specify that the ftle should be saved as a Stationery fi le or Tem
plate. Usually, this option is offered right in the dialog box, as 
shown in Word's Save As dialog box in Figure 4.9. Some pro
grams, like Excel, hide it behind an Options or File Type but
ton. If you can't find a way to specify tl1at the file should be 
saved as Stationery, consult the documentation that came with 
the program. ("'When all else fails, check the manual." ) 

0 Click the Save button. 

Word Templates in Work Menu 
You can have a Microsoft \.Yord template automatically appear in a cus
tom Work menu on your menu bar, as shown in Figure 4.10. This 
makes templates quick and easy to open. 
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Ia Word Templates ... I t=HIIrd Disk 
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Figure 4.9 The Save As dialog box of Microsoft Word 
lets you create Stationery files when you save. 

0 Create the template document with Word. 

0 Choose Save As from the File menu. 

0 Use the directory portion of the Save As dialog box to open a 
folder to save the file into. It can be saved in any folder. 

0 Choose Stationery from the Save File as Type pop-up menu. 

8 Enter a name for the template . 

8 Click Save to save the document. 

Figure 4.10 Adding Word 
templates to a Work menu 
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0 With any Word document active on screen, press Command
Option-Shift-=. The mouse pointer turns into a bold plus 
sign (+). 

0 Use the plus sign pointer to choose Open (Command-O) 
from the File menu. 

0 Use the Open dialog box to locate and Open the template 
document you want on the menu. When you click Open, the 
dialog box closes and the file is listed under the Work menu. If 
you did not already have a Work menu, Word creates one for 
you. 

Add Excel Templates to New Dialog 
You can have a Microsoft Excel template automatically appear in the 
scrolling list of document types in the New dialog box, as shown in 
Figure 4.11. 

0 Create the template document with Excel. 

0 Choose Save As from the File menu. 

8 Use the directory portion of the Save As dialog box to open 
the Excel Startup folder inside the Preferences folder inside the 
System Folder. 

8 Click Options. 

0 Choose Template from the File Format pop-up menu. 

0 Click OK. 

0 Enter a name for the template. 

0 Click Save. 

Figure 4.11 Displaying Excel templates 
in the New dialog box 
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ClarisWorks Templates in New Document Dialog 
You can have a ClarisWorks template automatically appear in the pop-up 
Stationery menu of the New Document dialog box, as shown in Fig
ure 4.12. Claris calls this Easy Stationery. 

0 Create the template document with ClarisWorks. 

0 Choose Save As from the File menu. 

0 Use the directory portion of the Save As dialog box to open 
the ClarisWorks Stationery folder inside the Claris folder inside 
the System Folder. 

0 Choose Stationery from the Save As pop-up menu. 

8 Enter a name for the template. 

0 Click Save to save the document. 

Word Processor Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Although word processors have been steadily sending typewriters to the 
trash heap for at least the past ten years, many Macintosh users continue 
to "type" with their word processors. What does this mean? Simply that 

New Document 

® Wont Processing 0 Spreadsheet 
0 Drawing 0 Database 
0 Painting 0 Communications 

v'None 

RBOUT Stationery (WP) 
Business Stationery (WP) 
FoH Couer Sheet (DR) 

Internal morandum (WP) 
Mall Merge Letter (WP) 
Name & Address-Standard (DB) 
Newsletter-WP (WP) 
Personol Stationery-Std. (WP) 
Presentation-Outline (WP) 
To-Do List-Outline (WP) 

Figure 4.12 Displaying ClarisWorks templates in the New 
Document dialog box 
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they are not taking advantage of all the features their word processors 
have to offer. In this section, you'll find some tips and tricks for getting 
more out of your word processing application. 

View Invisible Characters 
Spaces, Tabs , and Returns are aU examples of invisible characters-you 
can't see them when you print, but they're there. Most word processing 
applications enable you to view invisible characters on your screen. This 
can be handy when formatting text. You can see examples of hidden 
characters in Figures 4.13 through 4.16. 

Here's how you can show invisible characters in some popular Word 
processors: 

• In Microsoft Word, click the Show /Hide , button on the Stand
ard toolbar. 

• In Claris MacWrite Pro, choose Show Invisibles (Command-;) 
from the View menu. (If Hide Invisibles is displayed on the 
View menu, invisible characters are already showing.) 

• In ClarisWorks, choose Preferences fi.·om the Edit menu. In the 
Preferences dialog box that appears, make sure the Text icon is 
selected and turn on the check box for Show Invisibles. Then 
click OK 

Use Tabs Correctly 
Most popular word processing applications, like Microsoft Word, Claris 
MacWrite Pro, and the word processing module of ClarisWorks, have 
full-featured tab controls. Use them to set tabs to create small tables of 
information, like the tables you'll find throughout this book. Here are 
some things to keep in mind: 

• Word processors offer several types of tabs. Use the appropriate 
type for the alignment you need. Figure 4.13 illustrates the types 
of tabs (and the setting markers) you 'II find in Word and 
MacWrite Pro. (ClarisWorks is virtuaJiy identical to MacWrite 
Pro.) Note the similarities. If you use a different word processor, 
your tab controls may look like these. 
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Figure 4.13 Tabs available in two popular word processors 

+ In order to use a tab stop setting, you must press the Tab key on 
the keyboard to move the insertion point to the tab stop indica
tor. Then type. 

+ Tabs can be different for every paragraph in a document. Once 
you set tabs for one paragraph, and you press return at the end 
of that paragraph, the settings arc carried forward to the next. 
To change the tab settings for multiple paragraphs at the same 
time, you must select the paragraphs first. 

Don't Press Tab Repeatedly or Use the Space Bar! -~-0. '-"'-~ ~'-~""' 

If you think you can get around setting tabs by simply pressing the 
tab key repeatedly until your text lines up, don't kid yourself. Doing 
this-or, what's worse, using the space bar to line up text-may come 
back to haunt you when you make formatting changes later on. Re
member, most Macintosh fonts are proportional: Each character in 
each font has a different width. Figure 4.14 shows a table in a Word 
document created by a lazy person. The gray dots, arrows, and back
wards P's are Space, Tab, and Return characters, none of which print. 
Look what happens when the font changes from Times to Helvetica! 

Use Indents Correctly 
Most word processors also have fu ll-featured indentation settings. Use 
them to set three different indents: left first line, left (other than first 
line), and right. Figure 4.15 shows the indent markers and the effect on 
a short paragraph in Word and MacWrite Pro. 
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Figure 4.14 Using multiple tab and space characters can get 
you into trouble when you reformat. 

Here are some additional tips and tricks for using indents correctly: 

+ To indent tl1e first line of a paragraph, set the left first line indent 
to the right of the left indent. This is illustrated in Figure 4.15. 

+ To create a "hanging indent" (often used for bulleted or num
bered lists), set ilie left indent to the right of ilie left first line 
indent. 

+ Indent settings can be different for every paragraph in a docu
ment. Once you set indents for one paragraph, if you press 
Return at tl1e end of that paragraph, the settings are carried for
ward to ilie next. To change indent settings for multiple para
graphs at ilie same tinle, you must select ilie paragraphs first. 

Figure 4.15 Three indent settings in two word processors 
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Don't Confuse Indents with Tabs ... or with Margins! ~~ ~ ~ ~ ~-~ ~ 

Indents and tabs are very different. Indents work with the word wrap 
feature of the word processor to ensure that text lines up properly on 
the far left and right sides, even after it is edited. Tabs work to line 
up information in columns. Figure 4.16 shows an example of tabs 
used improperly for indentation. Look what happens when additional 
text is inserted into the paragraph! 

Indents and margins are also different. While indents determine 
where text will begin and end on a line, margins determine the overall 
print area for d1e page or document. Indents can be different for each 
paragraph. Margins must be the same for an entire page-and usually 
for an entire document. 

Use Style Sheets 
Most word processors offer a Style or Style Sheet feature . Whenever 
possible, use this feature to create a number of formats you plan to use 
throughout your document. Then, when you want to format some text, 
you can apply d1e style to the text and see the changes instandy. 

Here's an example. Say you're creating a report with headings, num
bered lists, and standard or normal text. Each of these components re
quires different formatting- different fonts, sizes, styles, indentation 
settings, line spacing, etc. By creating a separate style for each of d1ese 
components, you can apply all the necessary formatting to the compo
nent with one easy command-or perhaps even a keystroke! This saves 
time and ensures consistent formatting. 

1 )+ Never. use tabs-vhen-indents.vould·be more-appropriate.-This·is-&good-<i 
+ examp1e.of-how-things.could get-messed up!<!! 
<II 
1) + Never. use-tabs. when. in den IS· vould· be-more-appropriate .. When-you insert· or. 
de1ete-text-wrd· wrap. changes.· This-is-a-good<!! 
+ example-of. how·things.could-get-messed. up!<JI 

Figure 4.16 What happens when tabs are used improperly for 
indentation 
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Here are some additional things to consider when working with styles: 

+ Word processors provide paragraph style (for entire paragraphs), 
character style (for selected characters), or both. Ifyou're not 
sure which one your Word processor supports, check the manual 
that came with it. 

+ You can override an applied style by either applying another style 
or simply selecting text and making formatting changes to it. 

+ If you change the definition for a style, all the text in your docu
ment that uses that style will change accordingly. This is perhaps 
the best advantage of using of styles. 

+ Styles can be incorporated into Template documents. They can 
often also be copied from one document to another in the same 
application. 

+ Styles created in one program can often be read by another. For 
example, QuarkXPress, a popular page layout program, can read 
styles from a Word document. 

llse Find and Replace to Save Keystrokes 
You've created a 12-page report that refers over and over to "XYZ 
Company." Well, this week XYZ Company changed its name to ABC 
Company. ·what do you do? Use the Find and Replace (or just plain 
Replace) feature of your word processor to search for the old text and 
replace it with new text. Most word processors let you replace occur
rences one at a time or all at once. 

With a little imagination, you can use Find and Replace for other 
tasks as well. Here are some examples that should work in most word 
processors: 

+ Your friend created a long word processing document and used 
the word "pretty" (as in "pretty big," "pretty tired," and "pretty 
boring") in at least five dozen places. You want to remove this 
word. Use the Find and Replace feature to search for occur
rences of the word "pretty" with a Space in front of it and re
place it with nothing. Not only does this remove the word, but it 
ensures that spacing remains correct. 
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+ Your friend also pressed Return twice at the end of each para
graph to add a blank line between paragraphs. You don't want 
the blank line. Use the Find and Replace feature to search for 
occurrences of two consecutive Return characters and replace 
them with one Return character. 

+ This same friend indented each paragraph by pressing the Space
bar five times. You'd rather use a Tab for this. Use the Find and 
Replace feature to search for occurrences offive consecutive 
Spaces and replace them with one Tab. 

+ This friend (to whom you really ought to give a copy of this 
book) also underlined al l book and magazine names. You know 
that italics should be used for titles. Use the Find and Replace 
feature to search for occurrences of underlined characters and 
replace the bold style with italic style. (Be sure to turn off under
lining at the same time. ) 

Use a Spelling Checker to Proofread 

Typos are a common problem, even among the best typists. You can use 
the spelling check feature built into most word processors to check for 

typos. 
One important thing to remember: A misspelled word that spells an

other word will not be caught by a spell ing checker. For example, if you 
meant to type the word "if' and your fingers typed the word "of," the 
spelling checker will not noti fY you of the error. Always proofread your 
documents the old-fashioned way before distributing them. 

Automation Tricks 

Ever stop to consider why you use a computer? There are many reasons, 
of course. Among them should be automation. When properly in
structed, the computer can do things automatically for you. In this sec
tion, you'll see some examples of how you can automate tasks. 
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Use Publish and Subscribe 

One of the great features of System 7 is called Publish and Subscribe. It 
enables you to create a document, "publish, it, and then have another 
document "subscribe, to it. This means that whatever information is in 
the published document-or edition, as it is called-automatically ap
pears in the documents that subscribe to it. If the edition changes, the 
documents that subscribe to it also change as soon as the changes are 
saved. This works as long as the computer has access to the edition
even if that file is available on another computer connected via network! 

Here's an example of Publish and Subscribe in which part of a small 
Microsoft Excel worksheet is incorporated into a Microsoft Word docu
ment. lfyou have these two programs, give this a try. Even ifyou don't 
have these two programs, you can probably follow along with one or 
two applications you do have. 

0 In Microsoft Excel , create and save a small worksheet. 

0 Use your mouse to select a portion of the worksheet to pub
lish. It might look something like Figure 4.17. 

0 Choose Create Publisher from the Edit menu. 

8 Use the directory portion of the dialog box that appears to 
open a folder to save the edition into. 

0 Enter a name for the edition. 

0 Click Publish. 

Figure 4_17 Selecting a portion of an Excel 
worksheet to use as an edition file 
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0 If desired, choose Quit (Command-Q) from the File menu to 
quit Excel. If prompted to save changes, click Yes. 

0 Create or open a Word document that yo~ want to use the 
edition in. 

0 Position the insertion point where you want the edition to 
appear. 

C!) Choose Subscribe To from the Edit menu. 

G Use d1e directory portion of the dialog box that appears to 

locate d1e Excel edition file you just created. 

G Select the fi le and click Subscribe to insert it in your docu
ment. It might look something like Figure 4.18. 

CD Choose Save (Command-S) from the File menu to save d1e 
Word document wid1 the edition incorporated into it. 

To see how changes in the original worksheet file will affect the Word 
file that has subscribed to it, open d1e worksheet, make a change, and 
save it. When you look at d1e Word file, the new value automatically 
appears, as shown in Figure 4.18. 

:;r:J Pocking Peonuts Annuol Report ~= ~f 
lt!•w York I~ IILJ!i!l lr. ll711UI ~ ~ lllllllib q ~ 
~rmal I~ lti~~L·J 1 -L-.1~1 1..8 lCJ 1 t. ut f. 1 
0 I 2 3 5 I 

I 
~ 

1.; : Packing.Peanuts .Company<ll 
Annual. Report 11 il 
<lJ .f' •lJ 

1: Sales. by.:IQp~p~p_a<u 
<u 
Our· top. sales people·<li<ltheir jobs ea:ein by selllni even more Of· OUT· 
premium.packini .peanuts than· last· year. The results of their efforts· 
<:an· be· seen· in· fii ure 1- 1. Top-Salespeople sales.<;! 
<lJ 
<lJ ; 
11livbion• Ral oh• Tom• Hi lee• Total• • I 

East• 1 000.00 145.0 487.00 1 632.00. 
·f' wlisf;;---·-·- --·-·'·2s6'."!i"o 

--·-~il!1 
--- ·:35ifij'0 ·--·"'lJ'7'3']fo • 

iio'i'tii•··--- ...... r;24's-:tl'o ----6"4'7':tiil ·-·2""r3'7~oo • 

II 
s·o·ufile .......... .......... T2<[ll'o "'"'""'4ll'il . .. .. r;-7·'7'~·:~ro '""t~"lj'ij',(ili• 
Total• 2 625.00 I 837.00 3 270.00 7 732.00 -: 
'i I 
figure 1-l: Top.Salespeopte.Sales<l! :· qr 

~ <ll 
Poge I JNormol I~I"!J +, 1· 'iH1 Ill> 1!1 

Figure 4.18 A Word document with an Excel edition 
incorporated into it 
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Create and Use Macros 

A macro is a series of commands that can be automatically executed. 
T hey save you time by letting your Macintosh , which can work a lot 
faster than you, perform repetitive tasks. If a task is time consuming, 
you can instruct your Macintosh to complete it while you're away from 
the computer- perhaps even overnight. (Unlike most workers, your 
Macintosh will never demand overtime pay o r coffee breaks. ) 

Macros or scripting capabilities are built into many applications, like 
Microsoft Word , Microsoft Excel, Claris FileMaker Pro, and Claris
·works. Whenever possible, take advantage of macro features to auto
mate repetitive tasks. Here are some examples: 

+ Create a Microsoft Word script that automatically opens mail 
merge documents, merges the informatio n, prints the completed 
letters, and deletes the data file. (Be careful with any macro that 
deletes ftles.) 

+ Create a Microsoft Excel macro that automatically imports main
frame information, parses it into columns, formats it, performs 
calculations on it, sorts it, and prints it in multipage formatted 
reports. 

+ Create a Claris FileMaker Pro script that automatically imports 
comma-deJimjted text files, elimjnates unnecessary data, exports 
data into other FileMaker Pro fi les, and prepares reports from 
each file. 

If you want to get serious about automation, CE Software, Inc. has 
just the program for you: QuicKeys. This full -featured macro soft
ware package can automate virtually any repetitive task that you 

can perform on a Macintosh. Best of all, since it isn't application
specific, you can have it perform tasks with multiple applications, all 
within the same macro or "quickey." It even works with the voice 
recognition features built into some of the newer Macintosh models 
(like the AV machines) so you can put your Macintosh to work with a 
single word. 
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t Create a ClarisWorks macro that automatically converts curly 
quote characters in a document into standard quotes and then 
saves the file as a plain text document that can be read on any 
computer. 

Miscellaneous Application Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Here are a few other application tricks that really didn't fit into any of 
the other sections of this chapter. Just because they're last, don't think 
they're least usefttl. 

Go Through the Tutorial 
Need to learn a program fast? Go through the Tutorial or Getting 
Started section of its documentation. It's like attending self-paced, 
hands-on training class where you can learn what the program does and 
how it does it. Best of all, it comes free with many software packages. 

Set Preferences to Customize 

Most applications have a Preferences command that lets you customize 
the program for the way you like to work. Always take advantage of the 
options offered by this command. You could save yourself a lot of re
petitive formatting and setup time when creating new documents. 

Customize Menus and Too/bars 
All applications have menus. Nowadays, many also have toolbars. But 
did you know that more than a few of these applications also give you 
a way to customize the menus and toolbars? Here are some examples in 
popular applications: 

t Customize a Word menu by choosing Commands from the 
Tools menu. You can also add or remove Word menu commands 
by installing or removing Word plug-in modules . 

• Customize an Excel toolbar by choosing Toolbars from the Op
tions menu. You can also add or remove Excel menu commands 
by installing or removing add-in macros. 
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+ Customize the Claris FileMaker Pro's Scripts menu by choosing 
ScriptMaker from the Scripts menu, creating a script, and set
ting it so it is displayed on the menu. 

+ Customize a ClarisWorks Shortcuts Palette by choosing Edit 
Shortcuts from the Shortcuts submenu under the File menu 
with the Shortcut Palette showing. (Use the Shortcuts submenu 
under the File menu to show the Shortcut Palette first, if 
necessary. ) 

Switch Applications 
With more than one application open, there are three good ways you 
can switch from one to another: 

+ Use the System 7 Application menu to choose another open ap
plication. This is shown in Figure 4.19. 

+ Click anywhere in a window for another open application. If you 
want to make the Finder active, click anywhere on a Finder win
dow or the Desktop. 

+ Hold down the Option key while clicking anyvvhere in a window 
for another open application. This not only switches to that appli
cation, but it hides the current application. If you want to make 
the Finder active and hide the current active application, hold 
down Option while clicking anywhere on a Finder window or 
the Desktop. 

Hide Microsoft Word 
Hide Others 
Show All 

Figure 4.19 The System 7 Application menu 
lets you switch, hide, and show applications. 
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Hide Applications 
If you have multiple applications open, your screen can soon become 
cluttered with windows. 

+ Use the Hide command under the System 7 Application menu 
(see Figure 4.19) to hide either the current application or all 
other applications. 

+ As discussed above, you can hide the current application while 
switching to another, by holding down the Option key while 
clicking in a window of the other application or while selecting 
its name from the System 7 Application menu. 

+ Use the Show All command under the System 7 Application 
menu to unhide all hidden applications. 

Duit by Force 
Here's the situation: You have three documents open in three different 
applications. Suddenly, while working with one application, your Mac
intosh freezes up. Your heart seems to stop because you haven't saved 
any of the open documents. What do you do? 

The first d1ing you should try is the save command- press Command
S since you won't be able to use your mouse. Ald1ough this usually 
doesn)t work, it is worth a try. 

The next d1ing you can try is to Force Quit the application that froze. 
System 7 users can do this by pressing Command-Option-Esc. A Force 
Quit dialog box appears . Try clicking Cancel-you might get control of 
the program again. If that doesn't work, press Command-Option-Esc 
again and click Force Quit. If the problem is restricted to that program, 
the program should quit and you should regain control ofyour Macin
tosh. You should then save the od1er two documents and restart. 

Some d1ings to remember about the Force Quit command: 

+ Force-quitting doesn't always work. Sure, you'll usually get the 
Force Quit dialog box, but about half the time, neither the Force 
Quit nor Cancel button will work. That's when it's time to reach 
for the restart button or power switch. 
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+ Always restart your Macintosh after force-quitting an application . 
'When you use the Force Quit command, RAM gets messed up 
and weird things can start happening. Your Macintosh may not 
function reliably. By restarting, RAM is cleared out and you can 
start fresh. 

+ If you force-quit a program like FileMaker Pro whkh saves files 
automatically as it works, any open document files can be dam
aged . Of course, if you hit the power switch to restart without 
force-quitting, the same thing would happen. Just something to 
keep in mind. 



Chapter 5 
• • • • • • • • • • • • • • • • • • • • • • • • • • • • 

Telecommunications and 
Networking Tricks 

Telecommunications is the process by which information can be 
transferred- either by voice or computer-over telephone lines. 

Sounds boring, doesn't it? In reality, telecommunications is one of the 
most interesting things you can do with your computer. It can open up 
the whole world to you. 

This chapter will help you teach your Macintosh to communicate 
more effectively. You'll get some solid telecommunications tips and 
tricks for logging on, communicating effectively, and minimizing online 
time (to save money). You'll also learn tricks for using your fax modem, 
exchanging files between your Macintosh and non-Macintosh systems, 
and working with networks. 

109 
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Telecommunications Basics Telecommunications, as discussed in this chap
ter, refers mainly to using your computer to 
connect to another computer, known as the 

remote system. Once the two computers are connected, you can 
exchange information in the form o~ electronic mail messages, share
ware and freeware tiles, and database contents. 

This chapter is mostly concerned with two kinds of remote sys
tems. One is a commercial online service like America Online, Com
puServe, Apple link, eWorld, or Prodigy. These services offer a wide 
variety of features but charge a fee for access, The fee can be based 
on actual usage, a monthly charge, or some, comb.ination of the two. 
The other kind of remote system is called a bulletin board system or 
BBS. BBSes are usually run by hobbyists and, due to limited size and 
resources, offer far fewer features than their commercial counter
parts. There are well over 100,000 BBSes worldwide. Some of them 
charge a fee for access, some don't. 

In order to connect to either kind of remote system, you need a 
, computer, a modem, a phone line, and telecommunications software. 

You know what a computer and a phone line are. A modem is a device 
that turns the computer's outgoing digital signals into analog signals 
that can be transferred over phone lines and takes the remote com
puter's incoming analog transmissions and converts them back into 
digital signals that the computer can understand. Modems generally 
range in price from $50 to $500, depending on transfer speed capabil
ity I baud rate) and features. 1elecommunicafiGris software controls 
the modem and acts as a translator between you and the signals go
ing in and out of the modem. Some popular telecommunications soft
ware packages include David Alverson's ZTerm (shareware), Software 
Ventures Corporation's MicroPhone, Aladdin Systems' S/TComm, and 
The Frees oft Company's White Knight. 
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Log On Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
You can't do much telecommunicating if you can't connect. Here are a 
few tips and tricks for finding and logging on to a remote system. 

Find a BBS Near You 
Finding a good, local BBS isn' t always easy. Here arc some tips: 

+ Start with a BBS list. You can often find these in books that dis
cuss telecommunications. Write down numbers for at least ten 
systems. BBSes don't have long life spans and even the best BBS 
list is usually o ut of date within six months. 

+ Call BBSes. While online, look arou nd for other BBS lists. BBSes 
are possibly the best sources of BBS lists. Download or capture 
any lists you find to review them offline. 

+ While online with a BBS, send a message to the appropriate pub
lic area asking if other callers know of any BBSes in the area. 
Most people don't call just one BBS. You might run into some
one who knows of a system you can call near your home. 

+ When you Jog off or disconnect from a BBS, check the log off 
notes that appear on your screen. You ' II often find area BBS 
phone numbers Listed there. 

+ Although you can connect to almost any BBS with your Macin
tosh, you may want to concentrate on finding a good Macintosh 
BBS where you can find Macintosh-related message areas and 
shareware and freeware fi les. IBM BBSes tend to overlook the 
needs of Macintosh users . 

Choose an Online Service That Meets Your Needs 
Commercial online services offer far more than any BBS can offer. 
When choosing an online service to subscribe to, don't join one just 
because you saw an ad for it on television or your friend uses it. Find 
out what the service has to offer, how much it costs , and whether yo u 
can access it through a local network connection. Check into all the ma
jor services and compare. Then make your decision. Only computer 
book authors are crazy enough to subscribe to all the services. 
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Why a Local BBS? A local BBS should be the first choice of anyone interested in 
telecommunications- especia lly beginners. Why? Here are a 
few reasons: 

• Small local systems are generally easierto learn and use than mas
sive commercial on line services. They're a great place to get 
started with telecommunications. 

• If a local system is within your local ca lling area, there are no 
phone charges for connecting with it. 

• Local systems have information of interest to people in your area. 
You can meet other computer users- possibly peop le in your own 
town. The atmosphere is generally more friendly and intimate than 
on commercial online services. 

• There is often no fee to access small local systems. This makes 
telecommunications very affordable. Even if there is a fee, it's usu
ally much less than you'd have to pay for access to a commercial 
online service. 

• Some local systems have quite a bit to offer, including access to 
worldwide networks like Fidonet, the Internet, and OneNet, to on
line games, and to tens of thousands of shareware and freeware 
files. 

Buy the Fastest Modem You Can Afford 
T he speed of your modem will determine how qu ickly it (and you ) can 

exchange info rmati on. Not lo ng ago, the standard was 2400 baud o r 

ro ughly 24 0 characters per second. T hen it became 9600 baud ( al
tho ugh some o nline services were slow to make the change). Many 

BBSes can support connectio ns at 14400 baud, 19200 baud, and even 

faster. 

Don't bu y a modem for today's standard. Buy o ne for tomot'1'on,~s 

standard. A modem has virtually no moving par ts and can last for years 

if taken care of p roperly. Saving a few dollars today can cost you a few 

dollars mo re tomorrow. 
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Buy a Fax Modem 

If you're shopping for a modem, consider a fax modem. For not much 
more than the cost of a regular modem, you can buy one that can send 
and receive faxes. Some of them also include OCR (optical character 
recognition) software that'll enable your Macintosh to convert text in 
graphics to text you can manipulate with your word processor. Some
thing to consider, isn't it? 

Connect at a "Smart" Speed 

Some commercial onHne services charge a different rate for high speed 
(over 2400 baud) connections. The rate may be roughly twice the rate 
for slower connections. Before you connect to one of these services, 
consider what you'll be doing while online. 

+ If you plan to connect to read and write messages online, search 
for information like stock prices, or do a Httle shopping, connect 
at the slower speed. These tasks require that you read and re
spond to on-screen prompts. Since the average person can't read 
much faster than 1200 to 2400 baud, accessing the system at 
9600 baud for tl1ese tasks is pointless. 

+ If you plan to connect to download or upload files or capture 
and send messages prepared offline, connect at the higher speed. 
Exchanging prepared data requires much less interaction. You 
can send or receive data at four times the speed for only twice 
the price. That's a bargain. 

Turn Off Call Waiting 
If you have tl1e phone company's call waiting service, be sure to disable 
it before you let your modem dial out to a remote system. Call waiting 
produces tones tl1at your modem may "hear" as line noise or random 
characters. At high-speed transmissions, the modem could lose the con
nection. 

While the codes to disable call waiting vary in different areas, *70 or 
1170 usually does the trick. You can include tl1is in the dialing string for 
your telecommunications sofu¥are. In fact, some telecommunications 
software packages have an option just to disable call waiting. You can 
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sec an example of the option as presented in Aladdin Systems' SIT

Comm in Figure S. l. 

Turn Local Echo On or Off 
Ever connect to a remote system and find that the characters you type 

don' t appear on your screen? O r that each character you type appears 
twice on your screen? 

This is a resu lt of Local Echo being incorrectly set. Your telecommu

nications software should offer a way to set this properly. If the charac

ters you type don' t appear at all , turn Local Echo On. If the characters 

you type appear twice, turn Local Echo Off. 

Saving Your Password 

Many telecommunications software packages enable you to set up log 

on or connect scripts that include the remote system's name and 

phone number and your log on name and password. Think twice 

about including your password in one of these scripts! If you include 
your password in a script and someone else uses your Macintosh, 
they'll be able to use your account on the remote system. T his could 

jeopardize the privacy of your electronic communication and enable 

someone to usc a service on your dime. 

t - . =: Glob_ai_Preferences ; . 

e ~ 0 Access outside line with: I I r.a 
181 Disable call waiting with: 1•10, I Gt neral 

0 Use this Area Code if none supplied: C:=J 
Dialing Send Call ing Card Information 

It 0 before phone #: I I 
Sluffing 0 0 after phone #: I I -• o o •~• ow•-•-•--·-·----·--..,-•••----·----· --- --- -·-·- - -·-·-·-·--·· 

( Cancel ) ~ Saue ~ 
Figure 5.1 Include the codes to disable call waiting 
right in the dialing strings of software like Aladdin 
Systems' SITComm. 

I 
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Communication Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
In d1is section, you ' II find some tricks for getting ilie most out of an 
online service or BBS once you're connected. 

Practice for Free 

Although most commercial online services charge a fee based on access 
time, many services offer a free support or practice area. Once you've 
entered this area, you can spend as much time using the service as you 
want-wid1out paying a clime. This is a great way to learn how to use a 
system wiiliout the clock ticking away. Here's how you can enter the 
free area on two popular online services: 

+ On America Online, choose Members' Online Support from 
the Go To menu. (Or use the Keyword Help.) When a dialog 
box appears asking you to confirm that you want to enter ilie 
free area, click OK. 

+ On CompuServe, enter GO PRACTICE at any system prompt 
and press Return. 

Communicate with Others Worldwide - For the Cost 
of a Local Call 

Most commercial online services and many BBSes reach computer users 
like you worldwide. They do this by offering their services d1roughout 
ilie world (like CompuServe does) or by connecting to worldwide net
works like ilie Internet, Fidonet, or OneNet (just to name a few). On 
systems like these, when you write a message in a public forum, d1at 
message may be seen all over d1e world. In addition, if you have ilie user 
name or account number of a specific person on iliat system, you can 
exchange private messages wid1 them. Contact friends or family mem
bers across ilie coun try, make business connections, and learn more 
about life in a foreign land- all for the cost of connecting to your local 
system. 
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Private Mail Isn't Always Private 

The term "private mail " o r "electronic mail" may lead you to believe 

that private mail messages sent electronically can only be read by the 

sender and recipient. This is no t true. The adminisu·ato r(s) of any 

online service o r BBS may have the ability to read private mail mes

sages. (This fact is usually posted on every system you ctiaJ into. ) In 

addition , occasional system glitches can make the contents of private 

messages public. While administrato rs probably have better things to 
do with their time than read your mail and system glitches happen 

very infrequently, you should never include confidential information 

in a message. Ask yourself this question: "Would I want dozens (or 

even hundreds) of strangers to know t his?" If the answer is no, don't 

send the information electronically. 

E-Mail Anyone Through the Internet 
You have an account on CompuServe . Your friend in Peoria has an ac

count on America Online. Docs this mean you can never exchange elec
tronic mail ? Of course no t! Use the Internet gateway. 

T he Internet is a global network of computer systems, many of which 
are at coll eges, universities, and research insti tutions. All major o nline 

services have " gateways" into the Internet. That means if you address a 

message correctly, it can travel thro ugh the Internet to the recipient. 

Depending on the kind of gateway and connection, messages can arrive 

less than an hour after they' re sent-even if they have to travel across 

the country. 
Table 5.1 lists many of the services you can exchange mail with 

through the I ntcrnet, the service's Internet address, and an example of 
an address to someone on that service. For more details on how you can 
usc the Internet gateway from the service you subscribe to (America 

Online, CompuScrve, GEnic, etc.) , consult the online help area of that 

system, which is normally fi·ec of connect charges. 
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Table 5.1 Internet Addresses of Online Services and Networks 

Service or 
Network Internet Address Example Address 

America Online aol.com jdoe@aol.com 

Applelink applelink.apple.com jdoe@applelink.apple.com 

AT&T Mail attmail.com jdoe@attmail.com (be sure to 
exc lude any ! symbols that might 
be part of the address) 

BITNET append "bitnet" to the jdoe@pegasus.bitnet 
BITNET address 

BIX bix.com jdoe@bix.com 

CompuServe compuserve.com 12345.6789@compuserve.com 
(change the comma in the 
CompuServe address to a period) 

CONNECT connectinc.com jdoe@connectinc.com 

Delphi delphi.com jdoe@delphi.com 

Easylink eln.attmail.com 62123456@eln.attmail.com 

Fidonet use the format To send to John Doe, 1:123/456, 
"first_last@f<node>.n address it: 
<net>.z<zone>.fidonet.org" John_Doe@f456.n 123.z1.fidonet.org 

GEnie genie.geis.com jdoe@genie.geis.com 

HandsNET handsnetorg HN 1234@handsnet.org 

MCI Mail mcimail.com 0001234567@mcimail.com 
(be sure to pad any 7-digit user IDs 
to 10 digits with leading zeros) 

Prodigy prodigy.com abcd12e@prodigy.com 

The Well well.sf.ca.us jdoe@well.sf.ca.us 
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Use the Internet to Contact the White House and Congress 

You ca n even send a message to the President or Vice President via the 

Internet. Here are their add resses: 

president@whitehouse.gov 

vice-presidcnt@whitchouse.gov 

Many Cong resspeople are also o nline. To learn more about how you 

can send messages through the In ternet to members of the House of 

Representatives, send a message to: 

comments@hr.house.gov 

UseSmileys 

"Joe doesn ' t know what he's talking about. He only wrote five books 

on the subject." Is the author of that comment being sarcastic? Or does 

he mean it? And what do you think Joe will say when he reads it? 

One of the biggest problems with electronic communication is that 

the words you type into messages lack the visual and audible clues to 
meaning that arc so important fo r communication. There are no facial 

expressions, no stressed words, no shouts. A comment you make as a 

joke might be taken very seriously since the reader can't see the wink 

you intended to go with it. 

Smileys make it possible to accompany your written words with facial 

expressions. A smiley is a series of regular keyboard characters that rep

resent facial expressions like smi les, winks, and frowns. T here are hun 

dreds of smilcys; you can find lists of them on many online services and 

BBSes. Here is a list of the most basic ones-look at them sideways and 

you ' ll sec the smi le, wink, o r frown. Usc them in your messages to help 

readers understand what you're saying. 

Smiley Meaning 

:-) Smile 

;-) or,-) Wink 

:-p or ;-p Sticking o ut tongue 

:-( Frown 

:,( Tears 

:-o Shout 
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Use Abbreviations 

You can use a standard set of abbreviations to express yourself in elec
tronic messages. While not as cute as smileys, some of these can express 
the same kinds of emotions. Others say much more with only a few 
characters. Here's a list of some of the most popular ones: 

Abbreviation Meaning 

<g> 

BTW 

FWIW 

FYI 

IMHO 

LOL 

ROFL 

RTFM 

Grin 

By the way 

For what it's \vorth 

For your information 

In my humble opinion 

Laughing out loud 

Rolling on the floor laughing 

Read the [censored by author] manual 

One more thing to keep in mind: Typing your messages in all capital 
letters is considered shouting on online services and BBSes. Don't do it 
unless you really are sho uting. 

Pause, Continue, and Interrupt Text Streams 

On a command line interface system, text may appear at the bottom of 
your telecommunications window and scroll up. Sometimes, it might 
scroll too fast to read it. Try these standard commands: 

Keystroke 

Control-S 

Control-Q 

Control-C 

Command 

Pause text stream 

Continue text stream 

Cancel text stream 

Use a Graphic Interface 

As a Macintosh user, you're accustomed to a graphic user interface. So 
why use a command line interface to communicate online? While most 
online services and BBSes are command line systems, there are plenty 
of systems that utilize a graphic user interface, complete with icons and 
menus. It's just a matter of looking for them. 
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+ For a commercial online service, try America Online, e•World, 
AppleLink, and Prodigy. All of these systems have graphic user 
inter faces. T he software you' ll need to connect to these systems 
is usually provided free of charge or for a small setup fee, depend

ing on the service. 

+ Ifyo u' re a CompuServe user, check out a package called 
CompuServe Information Manager. This puts a graphic "front 
end" on CompuServe, making it somewhat easier to use. You 
can get this package from CompuServe. 

+ For BBSes, look for Macintosh-based systems on FirstC lass, 
TeleFinder, or NovaLink Pro. The special software you'll need to 
take advantage of the graphic user interface is usually made avail
able for free online; you can connect for the first time with any 
telecommunications software. 

Online Time Tricks 

While you're online with a commercial online service or BBS, the clock 
is ticking away. If the service you' re connected to charges by the minute 
or if the telephone call you made to the service is outside your local 
calling area, each tick of the clock is money out of your pocket . H ere 
are some tricks you can use to spend less time online-and save money. 

Use Navigation Commands 
A navigation command is any command you can type on an O nline 
Service that takes you quickly to a specific area. T he benefit of using 
these commands is that they let you avoid aU the menus that would 
normally appear on the way to that area. If you make a list of the com
mands you need to visit the areas you use most, you can soon speed 
around any system, reducing online time. 

+ On America Online, use Keywords. Choose Keyword (Command
K) from the Go To menu . Type in a Keyword and click OK. 

+ On CompuServe, use Go commands. At any system prompt, 
type the word GO followed immediately by the name of the area 
you want to go to. Then press Return. 



Chapter 5: Telecommunications and Net:JVorking T1·icks 121 

Customize the Go To Menu 

You can take the above tip a step further for America Online. Version 
2.0, or later, of its software lets you customize tJ1e Go To menu to in
clude the places you visit most. 

0 Choose Edit Go To Menu from tJ1e Go To menu. 

0 In the Go to Menu Editor window that appears (see Figure 
5.2), change or add menu entries and corresponding Keywords. 

0 Click Save Changes. 

The Go To menu immediately reflects the changes you made. In 
addition, you now have the ability to access up to ten favorite places 
with a keystroke. 

Read and Write Messages Offline 
One of tJ1e most time-consuming things you can do online is read and 
respond to messages. Yo u can easily cut tJ1e amount of connect time by 
reacting and writing messages offline. Here's how to do this on most 

systems. 

0 Connect to the online service or BBS and navigate to tJ1e mes
sage area you want to read. 

Goto Menu Editor --- -,..... 

Key Menu Entry 

8€ 1 I Computing & Sof t were 

8€2 Online Clock 

8€3 New Services 

W4 Sign one Friend 

365 File Search 

8€6 I Tech Lwe Audi t orium 

8€7 

8€8 

8€9 

8€0 I I 
U Soue Chon\i!J 

Keyword 

Compu ting 

Time 

New 

Fri end 

Qu i ckfinder 

CS L iv~ 

Figure 5.2 Editing America Online's Go To menu 
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0 Turn on your telecommunications software's capture or save to 
text feature. (You can usually find this under the File menu, but 
it varies from program to program.) This feature enables you to 
save everything that seroUs by on your screen to a file on disk. 

0 Instruct the online service or BBS to start displaying messages. 
If possible, display them continuously, without pauses. Don't 
worry about the information flying by faster than you can read 
it. It's all being saved to a file on disk. 

G If desired, navigate to other message areas you want to read 
and scroll those new messages by as well. 

8 When you are finished "reading, messages, turn off the cap

ture or save to text feature. (Again, the command to do this is 
usually under the File menu.) 

G Log off the system. 

0 Use a text editor or word processor to open the capture file 
and read the messages. Take your time. There's no billing 
clock ticking now. 

0 Write your responses to the messages you read. While you can 
write all the responses in one new file, you might find it easier 
to create a new file for each message you write. Save the file as 
a plain text file. 

8 Log on to the service again. Navigate to the message area you 
want to send a message to. If you want to reply to a specific 
message, you can instruct the software to display that message. 

0 Use the appropriate system command to tell the system you 
want to write a message or reply to the current message. 
Depending on the system, you may be asked if you want to 
send prepared message text. If so, say yes and use your tele
communications software to upload a text file containing the 
message text. If not, you can usually use copy and paste to 
paste the message text into the telecommunications window. 
Either way, you'Ll see the message entered right into the screen 
a lot faster than you could type it. When the message is fin
ished, use the appropriate system command to send or save it. 
Do this for each message you want to send, then log off. 
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One important thing to keep in mind here: some BBS software pack

ages are picky about having blank lines in a message. Blank lines some

times signal the end of a message. I f you wan t to use blank lines 

between paragraphs in your messages, type a space onto the line. It'll 
look blank, but the BBS won't see it as blank. 

Experiment with this until you get the hang o f it. It can save a lot of 

time if done right. 

Compress Files 
Sending fi les to a remo te system? Compress them fi rst! Compression 

softvvare packages like Aladdin Systems' Stttffit Deluxe, Bill Good man' s 

FlashMail and CompuServe Navigator 

offline. Here are two examples: 

America Online, CompuServe, and 
other online services offer easy 
ways to read and write messages 

• F/ashMail is a feature of America Online. It makes it possible to 
have your Macintosh dial in automatically, retrieve messages, and 
send messages you wrote offline. A typical FlashMail session can 
take only a few minutes to exchange dozens of messages. Flash
Mail is part of the America Online software which comes free to 
subscribers. One drawback: It doesn't enable you to exchange 
messages with forums- only individual accounts. 

• The CompuServe Navigator is a software package available from 
CompuServe. Set it up to log on, collect messages and send mes
sages in any forum, search libraries, download and upload files, 
and perform other tasks-all automatically. When it's finished with 
a session, view the results in a Review window. The main benefit 
of the Navigator is that it completely removes you from the hassle 
of dealing with CompuServe's somewhat complex command line 
interface. You can speed through the system without knowing a 
single command, snatching up messages and files on the way. Any 
serious CompuServe user should consider this package. 
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Compact Pro, and Now Software's Now Compress, can reduce the size 
of an average file by 50 to 80 percent. Smaller ftles take less time to 
transfer, saving you time and money. 

Selfj~vfi.acting Archives ,~ .. , ' 

Most compression software packages offer the ability to create self
extracting archive (or SEA) ftles. This makes it possible for the ftle's 
recipient to open (or decompress) the ftle without special software. 
The trouble with SEAs is that the self-extraction code can add from 
12 to 20 K to the file's size. When compressing a small (say, 25 K) 
ftle, you can actually end up with a compressed SEA that's bigger 
than the original ftle! 

Don't create SEAs unless you know that the file's recipient doesn't 
have the appropriate compression or decompression software. The 
"expand only" versions of compression software are freely dis
tributable. If you know you 'U be sending a lot of ftles to one recipi
ent, why not send him a SEA containing the "expand only" version 
of the compression software? From then on, you can send him regu
lar compressed files and save 12 to 20 K per file transfer. 

One more thing: Most BBSes do not allow uploads in SEA format. 
The reason: If a BBS system operator has 1,000 files, each 15 K larger 
than they need to be, he or she needs 15MB more disk space to store 
them. That's a lot to ask of someone who might be on a tight 
budget! 

Use the Best File Transfer Protocol 
When transferring ftles , you'll find that certain ftle transfer protocols are 
more efficient than others. ZModem is among the quickest and it has 
the added ability to continue file transfers that have been interrupted. 
XModem with 1 K blocks is a good second choice. Just remember that 
whichever file transfer protocol you choose, the selection must be the 
same on both the sending and receiving ends. 
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Turn Off Instant Messages 
Instant Messages is a feature of America Online that makes it possible 
to send and receive brief messages immediately to anyone online. When 
you send an Instant Nlessage, a message window appears on the recipi
ent' s screen. Of course, when you receive an Instant Message, that win
dov.t appears on yom' screen, interrupting whatever you were doing. If 
you're in a hurry to get something done on America Online, receiving 
a flood of Instant Messages can be downright annoying. 

You can turn Instant 1\'lessages on or off by sending an Instant Mes

sage. H ere's how: 

0 To turn off or " ignore" Instant Messages, choose Send 
Instant Message (Command-!) from America Online's 
Members menu. 

0 In the Name edit box, enter the following, exactly as it appears 

here: $im_off 

0 In the body of the message , type anytl1ing. It doesn't matter
whatever you type won't really be sent. (See Figure 5.3 for a 
creative example.) If you leave tl1e body of the message blank, 
you may get a dialog box telling you tl1at you can't send an 
empty Instant Message. 

8 Click Send. A dialog box appears with the fo llowing message: 
"You are now ignoring Instant Messages." Click OK to dismiss 
it and continue working. 

0 To stop ignoring Instant Messages, choose Send Instant Mes
sage (Command-I) from the Members menu. 

- Instant Messa e "' - liD 

Name: I $im_off 

I bloh bloh blo~ 

Send ;J I Ruailable? I 

Figure 5.3 Sending an Instant Message to turn off 
Instant Messages 
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8 In the Name edit box, enter the following, exactly as it appears 
here: $im_on 

0 In the body of the message, type anything; remember, you 
can 't leave it blank. 

0 Click Send . A dialog box appears with tl1e following message: 
"You are no longer ignoring Instant Messages." Click OK to 
clismiss it and continue working. 

Use the Download Manager 

The Download Manager is a feature of America Online that makes 
downloading fil es a bit more convenient. Use it to download batches of 
files together. This way, you can pick out a bunch of files to download , 
tell your America Online sofn:vare to download it, and leave your 
Macintosh unattended while it works. It' ll even Jog off for you when it 's 
done. Here's how: 

0 View the description for a file you want to download. 

0 Click tl1e Download Later button. 

0 A dialog box witl1 tl1e fo llowing message appears: "This file has 
been added to your Jist of files for later downloading." Click 
the OK button to continue choosing flies to download. 

0 Repeat steps l tl1rough 3 for each file you want to download. 

0 To begin the download, choose Download Manager from the 
File menu. 

8 The dialog box that appears, which is illustrated in Figure 5.4, 
shows all the files you've selected to download. You can use 
buttons to view fil e descriptions, delete files from tl1e list, and 
perform other tasks. 

0 Click the Start Download button. 

0 The dialog box that appears has a check box you can use to log 
offwhcn tl1e download is completed. Turn that check box on 
or off and click Continue. The download begins. 

America Online's FlashMail feature also enables you to download 
files. If this option is turned on, whatever files are listed in the Down
load Manager will be downloaded as part ofyour FlashMail session. 
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- If:- -=· -- - - Download Manager · . -- . - -· 0 E' 

Fil es 'r'ou've Selected 

Library Tit le Size XCo111p lete 
MBS- Ne" Fil es 8, F_ 11oc lntosh Tips 8, Tr i cke, 3/9'1 76K 0 ~ 
Greol Beginner's Pr_ Mac int osh Tips 8. Tr icks , 2/ 94 95K 0 
Greol Beginner ' s Pr_ Macin tosh Tips & Tr i cks 1/94 93K 0 

co 
Files will be downloaded to volume Hard Disk, folder Onli ne Downloads 
3 file(s) selected, totolinQ 264K . Download t1me ~about 8 minutes (9600 baud ) . 

D g cJ [f[f ' ij 
I[ Vi• w ,I Sol•cl Dol• I• Holp ShoW' Compl•l•d 
Ducriolion Download Doslinal lon list 11om Downlo•ds [0 

Figure 5.4 America Online's Download Manager window 

Do Several Things at Once 

Some online services and BBSes enable you to perform more than one 
task at a time. FirstCiass is an example. vVhen you connect to a 
FirstCiass system with the FirstCiass Client software, you can upload 
and download fil es, read and write messages, and even participate in a 
chat- all at the same time. Take advantage of this capability to read and 
write messages while exchanging files to save time online. 

Stay Online for Free 

Ifyou want to stay connected to a commercial online service but don 't 
plan to actively usc it for a while, try entering the service's free area 
(mentio ned earlier in dlis chapter). The billing clock stops but you re
main connected so you don't have to Log back o n later on. \Vhen you're 
ready to actively usc the service again, simply exit the free area and get 
back to work. 

Some things to keep in mind if you do this: 

+ On most services, the free area isolates you from the rest of the 
system, so you won' t be notified about incoming mail or other 
cal lers trying to contact you. 

+ Your phone will be tied up the entire time you' re connected so 
you won' t be able to use it to make or receive other calls. 
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+ Some systems may automaticaUy log you off after a certain 
period of inactivity. 

+ \Vhil e you're connected, there's one less network connection 
available for other callers. If everyone did this all the time, it would 
soon be very difficult for callers to connect. Don't be selfish
use this trick only when you need to and for short periods of 
time. 

Fax Modem Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
A fax modem is a modem that has the added abi li ty to send and receive 
fax transmissions. Fax modem software usually works like a printer 

driver: You select it from the Chooser and then "print" to the fax mo
dem. This makes it very easy to send docmnents you have prepared on 
your Macintosh. (Of course, it also makes it nearly impossible to send 
documents you haven't prepared on your Macintosh.) In this section, 
you'll find some tips for using your fax modem. 

Send Faxes at Night 

Telephone rates are cheapest at night. This is a fact of life. If you need 
to send a fax to someone outside your local calling area, try to send it 
after 11:00 P.M. Of course, you ' II have to leave your computer and fax 
modem o n to do this, but there's a trick for having it shut down auto
matically, too. 

0 Set up the fax( es) to be sent at night. 

0 At the end of the day, choose Shut Down from the Finder's 
Special menu. Depending on your fax modem and software, 
you may get a message like the one in Figure 5.5 giving you 
the opportu nity to instruct your Macintosh to shut down after 
the fax( es) have been sent. 

8 Click Shut Down When Finished. Your Macintosh will 
attempt to send the fax( es) and shut down afterwards. 
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There ar e 1 i tems in y our faH queue. 
If you Shut Down now, these items w ill be sent 
when you res tart the computer. Do you w ant 
TelePort to Shut Down after the 1 items haue been 
sent? 

Shu t Down Now ( Shut Down When Finished J 

Figure 5.5 Your software may offer to shut down your 
Macintosh a fter sending faxes at night. 

Use Small Cover Sheets-Or None at All 
Fancy cover sheets arc very popular with people who wa nt to p rove th at 

t hey're imaginative individuals. I f your faxes can speak for themselves, 

usc the smallest fax cover sheet you can- or no ne at all. Why? Because 

eve ry inch of fax you send takes t ime to send and uses paper on the 

recipient's fax machine . VVhy waste time and paper? 

Choose Your Fax Modem Driver with a Keystroke 
Some fax modem software-li ke t he soft\vare that comes with Glo bal 

Village Communicati o ns' Teleport tax modems-include hot keys to 

choose th e fax modem d river. C heck the documentation that cam e with 

your fax modem soft\vare to see if it a lso uses this feature. If not, use a 

program like CE Software's Q;ticKe)'S o r Now Soft\vare's Now Menus to 

assig n a keystroke to switc h to the fax modem driver. T his saves time 

over using th e C h ooser. 

Set Up a Fax Schedule for Incoming Faxes 
If your fax modem is your o nly fax machine and it docs not have a decti

cated pho ne line, be sure to tell t he people who send you faxes that they 
e ither have to call you before sending a fax or fax during a certain time 

each day. Fo r example, if you work a standard 9 to 5 day (lucky you ), 

you mi g ht want to leave your Macintosh o n overnig ht and accept faxes 

fro m 5:00 P. M. to 9 :00 A.lvl. T his way you won' t answer the phone and 

get a fax tone screaming in your ear. 
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Use a Fax Modem and OCR to Retype Text 

You've got a copy of your company's annual report. You want to in
clude the text and financial reports in another document. Do you start 
retyping? If you've got a fax modem and OCR software, the answer is no! 

0 If necessary, photocopy the original document so that it's on 
flat paper. (You can't squeeze a booklet into a fax machine 
feeder, can you?) 

0 Fax the pages of the document from a standard fax machine to 
yow· fax modem. It's vital that you feed the pages in as straight 
as possible! In addition, if the sending fa.x machine has a "fine" 
or "best" setting, make sure that it's selected. 

0 Open the iJ1coming fa.x document on your Macintosh and put 
the OCR software to work translating the graphic text to edit
able text. 

This isn't a foolproof method of converting printed documents to 
editable text, but it is effective. You'll have to proofread the results care
fully-a spelling checker in yom word processing software can help 
identify spelling mistakes that occur when the OCR software makes an 
error. If you only have a page or two of text to convert, do yomself a favor 
and just type it in. You might spend more time messing around with the 
OCR software than you would take to just type it in the first place. 

Use a Scanner 
If your fax modem is your only fax machine, you might find it tough to 
fax documents that you haven't created on yollr Macintosh. This is pos
sibly the biggest drawback to fax modems. If you have a scanner, how
ever, you can use it to scan documents into your Macintosh. Once on 
disk, you can then fax the document anywhere you like. 

Cross-Platform Communications Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
You've got a Macintosh at work. John, who works down the hall, has 
an IBM running Windows. And your home computer is an old Apple 
Ilgs. How can you get files you create at home onto John's computer? 
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This section will tell you how by providing a few tricks to transfer files 
from one computer platform to another. 

Use a Modem to Exchange Files 

One of the best things about telecommunications is that modems and 
phone lines don't care what kind of computers are connected to them. 
This makes it possible fo r a Macintosh to dial into a non-Macintosh 
computer and exchange files with it. 

0 Connect both computers to modems and phone lines and turn 
them on. 

0 On one computer, start the telecommunications software and 
instruct it to answer the phone. 

0 On the other computer, start the telecommunicatio ns sofnvare 
and instruct it to dial the other computer. The two computers 
should connect. 

Macintosh users are spoiled: We can name our files with up to 
31 characters. Folks in the DOS world are limited to eight char
acters followed by a period (or "dot") and a three-character 

"extension." The extension can sometimes be very important for DOS 
users. Since their files don't have type and creator codes bui lt into 
them like Macintosh files do, some of their software products rely on 
the extension to tell them what kind of file a file is. 

When naming files that will ultimately be read on IBM-compatible 
computers, stick to DOS filename conventions. Otherwise filenames 
may be truncated and extensions may be missing. Here are a few DOS 
filename rules: 

• A filename may be from one to eight characters long, optionally 
followed by a period and then a one to three character extension. 

• Filenames may not contain spaces or symbol/punctuation charac
ters other than these: ! @ # $ % & ( ) - _ { } · 

• The following extensions should not be used for plain document 
files: COM, EXE, BAS, SYS, and BAT. 
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8 Instruct one computer to send the file you need on the o ther 

computer. 

8 Instru ct the other computer to receive the fil e being sent . (I f 

you' re using ZModem, you might not even need to do t his 
step; the software may sense the file coming and accept it auto

mati cally.) 

G Repeat steps 4 and 5 for each fi le you need to t ransfer. 

0 When you are finished, usc the appropriate commands to dis

connect (or hang up) on each computer. 

Use a Null Modem Cable to Exchange Files 
A null modem cable is a serial cable you can use to connect the serial 

po rts of two computers. T he ca ble needs to have the correct pin con

fi guration on bo th ends so you can plug it into two different systems. 
Once connected, usc telecommunication soft'Nare on both compu ters 

to send and receive f1 1es. I t works much like sending files via modem, 
but t here isn' t any modem. 

Read and Write to DOS Disks 
If you've got a Macintosh with a SuperDrive (basically any Macintosh 

made afte r March, 1989), you can read and write to DOS-compatible 

disks. Apple even provides the software to do this: Apple File Exchange. 

0 Launch Apple File Exchange. Its main window, illustrated in 

Fig lll'e 5.6, appears. T he contents of your hard disk are d is

played in the directory window on the left. 

0 Insert a DOS-formatted disk. Your Macintosh reads the disk 
and displays its contents in the directo ry window on the right. 
This is also illustrated in Figure 5.5 . As you can see, DOS sub
directories appear as folders. 

0 T he Mac to M S-DOS and MS-DOS to Mac menus let you 
choose from among the translators that you have in the Apple 

File Exchange fo lder. T hese translators sometimes come with 
software applications, but since many applications have transla
tors buil t in, Apple Fi le Exchange tran slators are getting 

tougher and tougher to fi nd. For plai n text fil es or fil es that 
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-- Apple File EHchange 

I= Hard Disk ! I (g} UNTITLED_MS I 
D Applications ~ D CENCON.WKI Q 
D Desk top Folder [ lr<tn~l fl ~~~ 

J D CENREPT.WK I ~ 
D Documents D CHGTEMPL.WKI I 

D System Folder [ lh~lllf) I JI~ J D CNSCON.WKI 
,;I D Telecommunications D CNSREPT.WKI 

D Temporary I terns D DlliCON.WKI iii 
D Trosh D FINISHED !:I 
D Utilities 0 MAKEREPT.FMT 

0 
D MRKEREPT.WK I 

JQJ D METCON.WKI .(). 

= Hard Disk (g} UNTITLED_MS 

6396K bytes a11ailable 784K bytes a11alloble 

( 0Jt<HI )I ( Drille l [ 0()£>1\ ]![ Drllle l 
[New FolderJ J [ 

! 
l'je< t l [New Folder) I [ Eject l 

Figure 5.6 Apple File Exchange's main window 

have identical formats on either platform (like many Microsoft 
products), special translators aren't necessary at all; you can use 
the Default Translation. 

8 To copy a file from your Macintosh to the DOS disk, use the 
left side directory window to find the file. Click on it once to 
select it. To select multiple files, hold down the Command key 
while clicking on each one. Then click the Translate button. 

0 To copy a file from the DOS disk to your Macintosh, use the 
right side directory window to find the file. Click on it once to 
select it. To select multiple files, hold down the Command key 
while clicking on each once. Then click the Translate button. 

0 You can use the Eject button to eject the DOS disk and insert 
another if you need to . You can also use the New Folder but
ton to create a new folder on either the Macintosh disk or the 
DOS disk. On the DOS disk, this will become a subdirectory. 

0 When you are fu1ished , click Quit. If a DOS disk is still in the 
disk drive, it is ejected. 
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Format DOS Disks 
You can also format disks in a DOS-readable format using Apple File 

Exchange. This makes it possible for you to create disks for other com

puter systems. 

0 Launch Apple File exchange. 

0 Insert an unformatted fl oppy d isk. A dialog box like the one in 

Figure 5.7 appears. 

0 Use t he radio button to choose the appropriate capacity for the 
disk. Options in the scrolling list of formats turn black or gray 

depending on what you se lect. Click the one for MS-DOS 

when it is black to select it. 

8 Click Initialize. Your Macintosh begins the initialization proc

ess. When it is finished , the new blank disk appears in the right 

side directory window of Apple File Exchange . 

Decompress DOS-Compressed Files 
Like Macintosh files, DOS files can be compressed. The trouble is, com

pression schemes popular on DOS-based systems-like ZIP and ARC

aren't the same as ones on Macintosh systems. And since your 

Macintosh can't run an IBM-based program without a little help (like 
emulation software or hardware), you might one day find yourself with 

a file you can't read. 

Fortunately, Macintosh shareware programmers have come up with 
Macintosh-compatible software products that can decompress these 

bJ Rpple File EHchange cannot 
read thi s disk. Do you wish to 
initialize it? 

0 4DOK Mlll:ln1u~h 

O DDDK 1.::0~'1:::11 I 

@72DK ProOOS 

( lnitiallzP~ ~ Eject 

Figure 5.7 Initializing a disk with 
Apple File Exchange 

LO 

lo 
~ 
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Apple File Exchange, PC Exchange, MacLink 
Plus, AccessPC, and DOS Mounter 

Apple File Exchange is 
the software Apple pro
vides for free to ex

change files between Macintosh computers and MS-DOS or ProDOS 
(Apple//) disks. It has few bells and whistles and isn't very glamorous, 
but it has two big things going for it: It works and it's free. 

If you regularly exchange files between your Macintosh and IBM
compatible computers, you may want to look into a few products that 
let you insert, read, write to, and format DOS disks without launching 
any special applications. Some examples are Apple Computer's PC 
Exchange, DataViz Inc.'s MacLink Plus, Insignia Solutions' AccessPC, 
and Dayna Communications, Inc.'s DOS Mounter. These programs use 
control panels to be able to read and translate DOS disk files on the 
fly. You might find this a lot quicker and easier than reaching for Apple 
File Exchange. 

files. Zipl t by Tommy Brown is one. Not only does it let you decom
press fil es compressed with the ZIP compression scheme, but it lets you 
create ZIP-compressed files as well. You can find this program and oth
ers like it on online services and BBSes. 

Networking Tricks 

In this section, you' ll find a few tricks to make networking Macintoshes 
a bit easier. 

Use an Alias to Mount a Network Volume 

For a quick and easy way to mo unt a network volume, make an alias of 
that volume and store it on your Desktop or under your Apple menu. 
Then, when you open the alias, it automatically mounts the volume. Of 
course, ifthere's password protection on th e volume, you'll still have to 
enter the appropriate user name and pass·word before you can use it. 
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Use an Alias to Open a Folder on a Network Volume 

Taking the previous trick a step further, if you need to open a specific 

folder buried inside a network volume, you can create an alias for that 
fo lder. When you open d1e alias, it not only mounts the volume, but it 

opens the folder. Remember, you may still have to type in your user 
name and password if the volume is password protected. 

Use File Sharing to Network 

System 7 File Sharing is possibly the simplest and least expensive form 

of nenvorking available. Whi le it isn't necessarily fast, it may be enough 

to meet the networking needs of many small businesses. Here are a few 

tips for File Sharing networks: 

+ To force a registered user to log on as a Guest, open the Users 
& Groups control panel, double-click the user's account icon to 

open it, and turn off the check box for Allow user to connect. 

T his makes it possible to restrict access temporaril y without delet

ing the user's account. 

+ To prevent nonregistered users from connecting, open the Users 

& Groups control panel, double-click d1e Guest account icon to 

open it, and turn off the check box for Allow guests to connect. 

+ To di sconnect a user who is currently sharing a file, open d1e 
File Sharing Monitor control panel , click on d1e name of the 

user you want to disconnect, and click Disconnect. Keep in 

mind d1at th is won' t stop the user from reconnecting . To pre

vent the user from connecting again, you must change his privi
leges in the Users & Groups control panel. 

+ To automatically mount shared folders or volumes at startup , 
turn o n the check box beside the item name in the C hooser dia

log box that displays items you can connect to. I f you do not 

have t he Save My Name and Password option selected, you' ll 
have to provide a password when connecting . 
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Apple's Apple Talk Remote Access (ARA) is a pro
gram you can use to create a mini-network be-
tween one Macintosh and another. When your 

Macintosh dials into another via ARA, a modem, and a phone line, the 
icon for the remote Macintosh's hard disk appears on your Desktop. 
You can open it and work on any file. 

For best results, ARA requires that both computers have modems 
with speeds of at least 9600 baud. System 7, File Sharing, and ARA 
must be installed on both machines. And, of course, the remote Macin
tosh's modem must be set to answer the phone. 

ARA is intended for PowerBook users who need to access their 
desktop Macintosh while t raveling. Even if you don't have a Power
Book, you can probably come up with a few ideas for using ARA to 

·II connect Macintoshes and exchange files. 
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RAM Tricks 

Hardware Tricks 

Chapter 4 began by saying that a computer is completely useless 
without software. Well, the opposite is also true: Software is com

pletely useless without computer hardware. In this chapter, you'll find 
some tips and tricks for keeping your hardware in good working order. 
You'll also fmd tricks fo r upgrading your system. 

Chapter 3 offered some RAM-related software tricks. In this section, 
you ' 11 fi nd some hardware tricks for installing RAM and disposing of o ld 
chips. 

Buy the Right SIMMs 
Macintosh RAM comes on special chips called SIMMs: Single Inline 
Memory Modules. SIMMs have various capacities ranging from 256 K 
to 16MB. Nowadays, l MB, 2MB, and 4MB SIMMs are most com
monly used. SIMMs also have various speeds, measured in nanoseconds 

139 
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(NS), the lowest being the fastest. The higher the capacity and the faster 

the speed, the more expensive the SIMM. 
Common sense may tell you to buy the slowest, lowest capacity 

SIMMs you need to upgrade your !vlacintosh. While this can save you 
money now, it might cost you money in the future if you decide to sell 
your current machine and buy a new (or pre-owned) one. For example, 
say you have a Macintosh Ilcx with 4 MB of RA!\11 and you want to 
upgrade to 8MB. A Ilcx can use 100 NS SIMMs, but not many newer 
models can. That means you won't be able to take the 100 NS SIMMs 
out of your Ilcx and install them in a newer machine. You' ll have to buy 
new SIMMs again. You might avoid this problem by buying the fastest 
SIMMs you can afford . In many cases, there isn' t even much of a price 
diffe rence. 

Install it Yourself 
RAM isn't difficult to install , especiaJly in the newer, modular Macin
tosh models. Some organizations that sell SIMMs provide free illus

trated guides, videos, or tools to make it even easier for beginners. By 
installing SIMMs yourself, you can save $50 or more-the cost of hav
ing an authorized Apple dealer or a private consultant do it for you. 

If you do decide to install your own SIMMs, keep these important 
points in mind: 

+ Turn offyour Macintosh and djsconnect the power before open
ing your computer. 

• Do not use magnetized tools to work on your Macintosh. 

+ Discharge static electricity and ground yourself before opening 
your Macintosh or touching any chips or internal parts. 

+ In early Macintosh II, Ilx, Ilcx, Ilci , and Ilfx models, Apple 
used plastic tabs on the SIMM slots. If your Macintosh has these 
tabs, be careful when removing or inserting SIMMs. The plastic 
tabs are very easy to break and can be costly to replace. 

Add RAM Slots 
If your Macintosh has eight SIMM slots (two banks of four ), and you 
want more tl1an 8MB of RAM, you'd normally need to buy four 2MB 
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or larger SIMMs and use them to replace four l MB SIMMs already in 
your Macintosh. The SIMMs you'd remove would be useless. 

MicroMac Technologies makes SIMMdoubler II, a device that en
ables you to put two SIMMs in the same slot. With it-or a similar 
product-you can increase the amount of RAM in your Macintosh with 
less expensive SIMMs (1 MB SIMMs are considerably cheaper than 2 
MB or 4MB SIMMs) and without discarding any SIMMs. 

Give Your Old SIMMs a New Home 
·what do you do with old 256 K and 512 K SIMMs that are just about 
useless these days? Here are two suggestions: 

+ Donate them to a school or other nonprofit organization. Not 
only will you be extending the life of these chips, but you might 
even be able to deduct a portion of their value on your income 
tax return. (Ask your accountant.) 

+ Make jewelry out of them. Imagine how different a pair of 
SIMM earrings or a SIMM tie clasp would look at the next party 
you attend! 

Hard Disk Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Chapter 2 offered some software-related tips for dealing with disks. 
Here are some hardware tips and tricks you can use to get more out of 
your hard disk-or to add additional ones. 

Partition Large Hard Disks 
Because minimum file size depends o n the size of a disk's partitions, 
partition hard disks that will be used to store small files. For example, 
say you have a 600 MB hard disk that will be used as a file server for 
your company's electronic mail system. Electronic mail messages are 
normally small files, 2 or 3 K in size. Yet if you do not partition the 
hard disk, each file will occupy a minimum of 9.5 K of hard disk 
space. The difference betvveen the actual file size and the amount of 
space it takes up because of allocation block size is wasted. With 
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What 's All This About Partitions and Allocation 8/oc/cs? Partition
ing is part 
of the hard 

disk initialization or logical formatting process. A partition is a usable 
area of disk with its own directory entries. A hard disk can have one 
or more partitions. A hard disk with multiple partitions will appear as 
multiple icons on your desktop even though they share one SCSI ID. 

The size of a hard disk partition determines the size of its alloca
tion blocks. An allocation block is the smallest amount of disk stor
age space your Macintosh can recognize. It's based on sectors, 
which are equal to 512 bytes. An allocation block can be one, two, or 
more sectors in size. An allocation block is also the smallest amount 
of disk storage space a file can occupy-a file can never be smaller 
than the size of the allocation blocks of the disk it's stored on. There
fore, if an allocation block is two sectors, the minimum file size is 
1024 bytes or 1 K, even if the file is a simple text file with only one 
character in it. 

The larger the hard disk partition, the larger the allocation block 
size. The following table provides some standard disk sizes and the 
.size of allocation blocks in each. To calculate the allocation block 
size in ki lobytes for a hard disk not included in this table, take the 
total disk capacity in kilobytes, divide it by 32,767, round the result up 
to the nearest whole number, and then multiply it by .5.1Never said it 
would be easy.) 

Hard Disk Size Allocation Block Size 

20MB .5 K 

40MB 1 K 

80MB 1.5 K 

100MB 2K 

120MB 2K 

170MB 3K 

230MB 3.9K 
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Hard Disk Size 

340MB 

600MB 

Allocation Block Size 

5.5 K 

9.5 K 

1GB 16 K 

This also explains why a tiny file on a 600 MB hard disk can occupy 
9.5 K of disk space on that disk and only 1 K of disk space when cop
ied onto a f loppy disk. 

You can partition a hard disk with the formatting software that 
came with the disk. Apple HD SC Setup, which is part of the System 
Software, can format and partition disks that come with Apple comput
ers. For non-Apple disks, try FWB Incorporated's Hard Disk Toolkit or 
LaCie Inc.'s Silverlining. 

5,000 messages, that can easily add up to 30 or 40 MB of unusable 
space. If you partition the hard disk into two or three separate volumes, 
however, you reduce the minimum file size . This is a much more effec
tive usc of hard disk space. 

Find and Use Hidden Hard Disk Space 
If your hard disk was formatted with Apple HD SC Setup, there's a 
chance that you' re missing out on some of the disk's storage capacity. 
This is because of the way Apple HD SC Setup initializes a disk. You can 
look for this hidden space by fo llowing these steps: 

0 Start your Macintosh with the Disk Tools disk that came with 
your System software. 

G Launch Apple HD SC Setup. 

0 Click the Partition button. 

8 Click the Custom button. A map of the disk's partitions, like 
the one in Figure 6.1, appears. It shows the Mac Driver and 
hard disk partitions created by Apple HD SC Setup. It may 
also show a gray area at the bottom of the map. This gray area 
is unused space. On the 40 MB Connor drive that came with a 
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ApproH. Partitions 
16 K Moe Dr uer --w•-•MowowoRowow-•---·-·--·-·•-••- ·----·-·--• 

Click on o partit ion t o 
select it. Cl ick & drog 
in groy oreo to creote o 
new portltion. 

( lh~lllOIJl' ) 
40DOO K If Hord Disk 40 ( lor:l: ) 

[ GrmlJl ) 

[ De toils ) 

~ J Done 
992 K 

Figure 6.1 Finding hidden hard disk space with Apple HD 
SC Setup 

Macintosh LC, thjs space amounted to a whopping 992 K
almost a full megabyte! 

0 Click OK to close the partition map window. 

8 Click Done. 

0 Click Quit. 

To use this space, you'll have to repartition the hard disk. Back up the 
enti1·e ha1·d disk first. Then follow these steps: 

0 Start your Macintosh with the Disk Tools rusk that came with 
your System software. 

0 Launch Apple HD SC Setup. 

8 Click the Partition button. 

8 Click the Custom button. 

0 Click on the name of the hard disk in the hard rusk partition 
area to select it. 

8 Click Remove to remove the partition. You'll see a warning 
message telling you that the data in the partition will be de
stroyed. Click OK only if you have backed up the rusk as in
structed above! 
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0 With your mouse, drag in the gray area from a position just be
low the Mac Driver partition on the map down to the bottom 
of the map. You' ll see the size of the new partition indicated 

on the left side of the map window. 

0 When you let go of t he mouse button, a new window appears 

so you can select the type of partition. Select Macintosh Vol
wne. 

8 Make sure the value in the size edit box is equal to all available 
disk space. If it isn't, you can type in a new value. 

8 Click OK. 

fD When the message "Partitioning was Successful" appears, click 
Done. 

fD Click Quit. 

If you use formatting software like those products mentioned earlier 
in this chapter, you won 't have to go through all this trouble. It's on ly 

Apple HD SC Setup that sometimes hides disk space. 

Use Compression Software to Increase Disk Space 

T he best way to increase available disk space in a hard disk is to delete 

the files you don 't need. But what if that isn't enough? T hat's when you 
might want to look into compression sofu:vare. 

T here are two kinds of compression software that can he lp you get 

more data on a hard disk: 

+ Fi le compression software can compress files in the background 

while your Macintosh is id le, then decompress them automat

ically when you need them. Examples of some popular packages 
include Aladd in Systems' Stufflt SpaceSm,er, Now Software Inc.'s 
Now Co-mpress, and Fifth Generation Systems' AtttoDoubler. 

+ Disk compression sofhva rc changes t he hard disk drivers to fool 

them into thinking that the hard disk is larger than it really is. 
T he result: T he available hard disk space increases. Examples of 

some popular packages include Golden T riangle's TimesTmo and 
AJysis Software Corp.'s eDisll. 
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:::~ - Upgrade Your Hard Disk 
When all else fails and you need more disk space than you can squeeze 

out of your hard disk, it's time to upgrade. You have two main options 

when you buy a new hard disk: internal or external. Here are the pros 

and cons of each if you have to decide: 

+ Internal hard disks are generally $50 to $150 cheaper than exter

nal hard disks. Why? Because there 's no need to provide you 

with a case, power supply, and internal cables. The drawback to 

buying an internal hard disk is t hat you must use it inside your 

Macintosh (or inside an external hard disk case you already 

have). This means that whatever hard disk is inside your Macin
tosh has to come out. If there's no case to put it in , it can ' t be 
used. 

+ External hard disks may cost more money, bu t they make it possi

ble to have and use multiple hard disks. Simply use a SCSI cable 
to plug the new external hard disk into yom Macintosh. If prop

erly formatted and turned on before startup, it appears as a new 

volume on your Desktop. If you want to get ta ncy, swap disks. 
For example, if you have an internal 40 MB hard disk and just 
purchased an external 170 MB hard di sk, there's nothing to stop 

you from putting th e 170 inside your Macintosh and the 40 in

side the case the 170 came in . The result of this juggling: You 

have the larger disk inside your Macintosh and can keep the 

external around as a "spare. " 

Give Your Old Hard Disk a New Life 
Want to know what to do with a hard disk you pull out of your Macin
tosh? Here are two suggestions: 

+ Buy an external hard disk case. Prices range from $75 to $150. 

Install the old internal hard disk into t he case and use it as an ex
ternal hard disk. It's great for backing up documents! 

+ Donate it to a school o r o ther nonprofit organi zation. T hey'll be 
grateful fo r your generosity and you might be able to write off 
the contribution on your tax return. (Ask your accountant.) 
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SCSI Rules and Regulations SCSI or Small Computer Systems Interface is the 
standard connection for external hard disks; CD-
ROM, SyQuest, and Bernoulli drives; and some 

printers and scanners. It's a great system on the Macintosh because 
you can "daisy-chain" up to six of these devices on your Macintosh's 
one SCSI port. 

SCSI does have some rules, however. Here they are: 

• Each device on the SCSI chain must have a different SCSIID num
ber. Your Macintosh CPU is always number 7. Your internal hard 
disk is normally number 0. That leaves numbers 1 through 6 for ex
ternal SCSI devices. You can usually set the SCSIID on an external 
device with a setting switch. If a switch isn't provided or not con
nected properly, you can set the SCSI I 0 with jumpers on the de
vice itself. 

• A SCSI chain must be terminated at both ends. Your computer has 
internal termination at one end and, if you don't have any devices 
connected to its SCSI port, it's internally terminated after the inter
nal hard disk. Otherwise, the last device in the chain must have an 
internal or external terminator. 

• The total length of cable on a SCSI chain should not exceed 18 feet. 
This is what Apple recommends, but, in reality, you might find the 
length a lot shorter. As a result, you shou ld always use the shortest 
SCSI cable you can to connect devices. 

• Interference from fluorescent lighting can cause SCSI problems 
(as well as problems with networking cables and the like), espe
cially if low-quality cables are used. Try to use double-shielded ca
bles whenever possible. They cost more, but they can save a lot of 
headaches. 

Floppy Disk Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Chapter 2 also offered some software-related fl oppy disk tips and tricks. 

Here are some for floppy disk hardware. 
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Lock Disks 
Although locking disks was mentioned in Chapter 2, it' s worthwhile 
mentioning it here again. When you lock a floppy disk, you use hard
ware to prevent the disk from being written to by the computer. It is 
impossible for a fully functioning floppy disk drive to write to a locked 
floppy. That's one surefire way to protect floppies against computer 
viruses. 

Use High-Density Disks in Low-Density Drives 
Ever find yourself in a situation where you've got an old Macintosh with 
a low-density disk drive (like a Plus or SE) but the only disk you've got 
handy is a high-density disk? Here are some tips for dealing with this 
situation. 

+ If the disk is blank, you can format it in the low-density drive as 
a single-sided or double-sided disk. You can then copy files to it 
just as if it were a low-density disk. 

+ Once you've formatted a high-density disk as a low-density disk, 
you must "fool" a Macintosh SuperDrive into recognizing the 
disk as a low-density disk before it can read it. Otherwise, you'll 
get a message like the one in Figure 6.2. To fool it, put some 
adhesive tape over the hole opposite the disk lock tab on the 
disk. Then, when you stick the disk into the SuperDrive, your 
Macintosh will think it's a low-density disk. 

+ If the disk was already formatted as a high-density disk and has 
information on it that you need in the older Macintosh, you 
might be sunk. Find a Macintosh with a SuperDrive, copy the 

This disk is improperly formatted 
for use In this driue. Do you wont 
to initialize It? 

(( Eject JJ ( I nltiolize] 

Figure 6.2 The message displayed when 
you insert a high-density disk 
formatted as a low-density disk in a 
SuperDrive 
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Why Adhesive Tape Can Fool Your Macintosh In case you're wonder
ing why the above 
adhesive tape trick 

works, here's the exp lanation. SuperDrives use a sensor to determine 
whether a disk is a high-density or low-density disk. The sensor is a 
mechanical pin that pokes up-you guessed it-through the hole op
posite the disk lock tab. If the hole is covered, the disk "feels" the 
same as a low-density disk as far as your Macintosh is concerned. 
That's how it's fooled. 

information onto its hard disk. Then put some adhesive tape 

over the ho le opposite the disk lock tab on the disk, insert the 

disk, and initialize it as a single- or double-sided disk. You can 

then copy the files back to the disk and use them in the old 

Macintosh. 

Some folks say this isn 't foolproof or reliable, so don't make a habit 

of doing it. In a pinch, it certainly can be helpful. 

Monitor Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . 
Your Macintosh " talks" to you through its monitor by displaying what 

it's doing in windows and asking questions in dialog boxes (why do you 

think they call them that, anyway?) . Keeping your monitor in good 

shape is important if you want to keep communicating with your 
Macintosh. Here arc a few tips and tricks for doing just that. 

Use a Practical Screen Saver 
Scn:en savers can be very entertaining these days, offering popular car

toon characters, voyages to the final frontier, flying appliances, and bub
bling aquariu ms. But do you really need all t his? 

While fancy screen savers do protect your screen from burn in, they 
also tend to consume large quantiti es of RAM and processor resources. 

This reduces the RA1\II. avaj lable fo r your applications and slows down 



150 Maciutosh Slick ·n·icks 

your Macintosh. If you want to get more out of your Macintosh, stick 
to the basic screen savers or screen saver modules . You 'II save money, 
too. 

(By the way, the same goes for many of those fancy Desktop pattern 
and icon utilities. They eat up RA.l\1 and slow things down. Ifyou want 
your Macintosh to give you all it can, don't fatten it up with window 
dressing.) 

Use Your Monitor's "Built-in" Screen Saver 
Every monitor comes with a built-in screen saver. Did you know that? 
On compact Macintoshes, it's the brightness knob. On freestancling 
monitors, it's either a brightness knob or a power switch. 
~Then you leave your Macintosh unattended for long periods of time, 

turn the monitor off or turn the brightness down. This is not only a free 
way to protect your monitor, but it works extremely well and can save 
electricity to boot. 

Avoid Static Cling 
Ever notice how dust seems to cling to the front ofyour monitor? You 
could wipe it every day and still come up with a dirty tissue or cloth. 

Try wiping it with a used fabric softener cloth like Bounce or Cling 
Free. This will clear dust off the screen and should prevent dust from 
settling there as quickly. For a few minutes, it will make your desk area 
smell nice, too. 

Keyboard and Mouse Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
If your Macintosh talks to you through your monitor, your keyboard 
and mouse provide the ways for you to talk back. Here are a few tips for 
these primary input devices. 

Add Extended Keyboard Keys 
You've got a standard keyboard or a Power Book and you want (or 
need) to be able to use the keys on an extended keyboard. What can you 
do? You've got two main options: 
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Despite what you might read elsewhere, a 
screen saver can be an vital piece of soft-
ware for the health of your monitor. Screen 

savers usually "blank" out the screen by displaying moving graphic 
images. This prevents regular screen images- like the menu bar
from "burning in" to the phosphor coating the inside of a screen. If 
you leave your Macintosh on for more than a few hours a day every 
day, you should use some sort of screen saver. 

+ Track down a shareware program called K eyboa1·d Plus by Berrie 
Kremers. T hi s program was designed specifically for ISO key
board and PowerBook users. It installs emulators that give you 
access to extended keyboard keys, including the numeric keypad . 

+ Use CE Software's QuicKeys to add the keys you need. The Alias 
Keystrokes feature lets you do this. T he trick here is to have an 
extended keyboard attached when adding the keystrokes since 
this feature of QuicKeys requires that yo u be able to type in both 
keys-the desired key and the alias-when assigning the alias. 

Use a Mouse Pad 
Although a mo usepad is not requ ired when using a mouse, it does have 

two advantages: 

+ A mouse pad usually provides good traction fo r the mouse. 

+ A mouse pad helps assure that there's suffi cient space on your 
desk surface set aside for using a mouse. 

Use a Trackball 
If yo ur desk is often so cluttered you can' t find room to roll your mouse 
around (even with a mouse pad claiming territory) , it's time to look into 
a trackball. While a trackball has the same basic parts as a mouse- a 
rolling ball and a butto n- it puts the ball on top where you can roll it 
with your fingers without having to move the \vhole unit. It may take 
some getting used to, but it works just as well as a standard mouse. 
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Miscellaneous Hardware Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Here are a few additional hardware tricks you might find useful. 

Power Down Before Plugging In 
Always shut off your Macintosh before connecting or disconnecting 
peripherals. Failing to do so may cause temporary ur c.:ven permanent 

damage to your equipment. 
At this po int you may be shaking your head , thinking about all the 

times you've plugged in your mouse, keyboard, modem, or printer with 

your Macintosh turned on. By doing this, you arc courting disaster. 

How long does it take to turn off you r computer, plug something in, 
and turn it back on? Less time that it would take for your Apple dealer 

to rep lace a damaged motherboard, SCSI port, or fuse? Why take 

chances? 

Use an AlB Switch 
You've got two serial ports on your Macintosh, but three serial devices: 

a modem, a printer, and a MIDI setup. You're going nuts because every 

t ime you need to use the device that isn' t plugged in , you need to reach 
behind your Macintosh and fidd le around with the plugs. Is there a so

lution? Of course. Get a serial A/B switch. 

An A/B switch is a hardware device you can usc to manually switch 

active devices. Plug the A/ B switch into one of your serial ports, then 

plug two devices in to the A/B switch. When you want to usc one de

vice, turn the knob on the front of the A/B switch box to the approp ri 
ate letter (A o r B). When you want to use the other, switc h to the oth er 
letter. Simple, no? 

Here arc a few things to consider: 

+ An A/ B switch docs not add serial ports. It only adds the con

venience of switching among devices. You can still only use two 
serial devices at a time. 

+ A/ B switches let you plug in two devices. You can also get 
A/ B/C/D switches to plug in four devices. Other configura
tions are avai lable . 
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• Automatic A/B switches are also available. Most of these use soft
ware to set the switch. 

• If you really need more serial ports (because you need to use 
more than two serial devices at a time), check into serial port 
cards manufactured by Creative Solutions, Applied Engineering, 
and Digiboard. 

Install and Use the Programmer's Switch 

"The programmer's switch is for people who want to write application 
programs on the Macintosh Ilcx. If you aren't an applications devel
oper, do not install the switch . Installing it and using it incorrectly can 
result in loss of data." 

That's what Apple says about the programmer's switch in the Macin
tosh IIcx Owner)s Guide. It makes similar frightening comments in other 
owner's gu ides. Don't let Apple scare you. T his switch isn't going to 
cause your computer to self-destruct. What it can do is give you a way 
to restart the computer without powering it down. 

The programmer's switch normally appears as a pair of plastic buttons 
or tabs on the front or side of your Macintosh CPU. One button, which 
has a tiny triangle on it, lets you restart your Macintosh. The other 
button is the programmer's interrupt button, which is commonly used 
by programmers (like Apple says) for debugging software. Not all 
Macintosh models have externally accessible programmer's switches. If 
yours does, it may or may not have been installed by your Apple dealer. 

Use the restart button only when your Macintosh is completely fro
zen and you'd have to power down anyway. Don't press the button 
unless you really want to restart- your Macintosh won't ask any ques
tions and it won' t save any documents first . It' ll just restart. 

In case you're wonderi ng, the programmer's interrupt button puts a 
very un-Macintoshlike window on the screen with a greater than symbol 
in it. A programmer knows what to do witl1 this. If you ever press this 
button by mistake and find this window staring you in the face, press G 
and then Rettun to go back to whatever document was active. You 
might consider restarting your Macintosh with the Restart command 
under the Special menu afterward just to clear out RAM. 
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Printing Tricks 

Printing enables you to share the results of your computing efforts 
with others. Write a letter, a report, or a shopping list, and print it 

to take it with you. Draw a pictu re, lay out a newsletter, or create a fi
nancial worksheet, and print it to show it to others. Most of what you 
do on your computer will end up, sooner or later, on paper. This chap
ter provides some tips and tricks for helping you get it there. 

Output Tricks 

What are you going to print? How are you going to print it? Th.is sec
tion provides some tips. 

Choose a Printer with the Chooser 
If your Macintosh is connected to more than one printer, you can use 
the C hooser to pick the one you want to print to. 

155 
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0 Choose Chooser from the Apple menu. 

0 On the left side of the Chooser window, click on the icon for 
the type of printer you want to print to. 

0 On the right side of the Chooser window, click on the name 
of the printer you want to print to. 

G Close the Chooser. 

0 A dialog box may appear, warning you that you have made 
changes and should check the Page Setup dialog box in open 
applications. Click OK 

The next time you use the Print command, options for the printer 
you selected appear and the document is printed to that printer. 

Choose a Printer with a Keystroke 
If you have CE Software's Q;·ticlCeys, you can use the Choosy extension 
to choose a printer with a single keystroke, bypassing the Chooser com
pletely. Now Software's NowMemts also lets you do this by assigning 
keystrokes to Chooser options on the hierarchical Apple menu that 
NowMenus creates. 

Print a List of a Folder's Contents 
You can print a list of the contents of a folder by choosing Print Win
dow from the Finder's File menu when that folder's window is active. 
A standard Print dialog box appears; just cJjck Print to send the infor
mation to your printer. Here are some important points to remember 
when doing this: 

+ If you are viewing the window in a List view, the printout will in 
clude all items in the window, .including ones that don' t fit in the 
window on screen. The printout will go to multiple pages if nec
essary. The item list will be in the same order as the window 
view and will include all the information shown in the window: 
kind , size, label, date, etc. In addition, if you're using System 7's 
outline feature to show multiple folders and tl1eir contents in the 
same window, the outline will also print. This is a great way to 
show tl1e contents of more than one folder witl1out printing 
more than one list. 



Chapter 7: Printing T~·icks 157 

• If you are viewing the window in an Icon view, only those icons 
that appear within the window will print. 

Print a Picture of the Screen 

Ever need to get a snapshot of your Macintosh screen on paper? In the 
old days of System 6 and ImageWriter printers, pressing Command
Shift-4 sent a screen image to the ImageWriter for printing. With Sys
tem 7 and a laser printer, it takes a bit more work. 

0 Press Command-Shift-3 to activate the built-in FKEY to take 
a snapshot of your Macintosh screen. You 'II hear a camera click
ing sound and your mo use will freeze for a moment while the 
snapshot is being processed. 

0 Open your hard disk icon. There should be a TeachText PICT 
document file there called Picture 1. 

8 Double-click this file to open it. Ifyou have TeachText 7.0 or 
later or SimpleText instilled on your Macintosh, it will lau nch 
and open the fil e. (If you do not have a current version of 
Teach Text or Simple Text, you ' II have to open the file with a 
graphics application like Claris's MacDm1v Pro or Deneba's 
Canvas.) 

8 Choose Print (Command-P) from the File menu. 

0 In the Standard Print dialog box that appears, click Print. 

If you have a large monitor, the image may print on more than one 
page. To get it all on one page, usc the Page Setup command under the 
File menu to specify a percentage to reduce the image before printing it. 

Print Closer to the Edge of the Paper 

Laser printers normally require roughly 1/2-inch margins all around the 
edge of a page. Why? So that toner doesn 't spill inside the printer. This 
sets a minimum margin size for your documents, one you might want 
to override. 

You can print closer to the edge of the paper by turning on the 
Larger Print Area check box in the Print Options dialog box, as 
shown in Figure 7.1. Get to the Print Options dialog box by clicking 
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LaserWriter B.O Op tions 8.0 t OK l) 
Ulsual Effects: Papor stzo tn tnchos 

( c ancel ) Width : 8 .5 D Flip Horizontal 
Ht i9ht : 11 D Flip Uertical 

--OM ____ 

Margins in inches D lnuert lmoge ( Help l 
Top : 0 .111 
Loft : 0 .25 Printer Options: 

Bottom : 0 .111 181 Substitut e Fonts Ri9ht : 0 .25 
1/ 181 Smooth TeHt 

181 Smooth Graphics 
D Precision Bi tmap Al ignment (4% reduction) 
~Large r Print Area (Few er Downloadable Fonts) 

Unlimited Downloadable Font s in a Document 

Figure 7.1 Print Options lets you ch an ge a number of pr inting 
optio ns o n laser printers. 

Options in either the P age Setup or Print dialog box. I f you click on 
the dog/ cow sample illustration, you can display the actual margins 
which will be used by the prin ter. This is also shown in Figu re 7.1. 

Disable Font Substitution 
System 7 comes with TrueType versions of the standard Macintosh 
fo nts: Geneva, New York, and Monaco. If you want to print these fonts 
on a PostScript prin ter, be sure to turn Font Substitution off in the 
Print or Print Options dialog box (see Figure 7.1 ). T his option is 
turned on automatically. If you leave Font Substitution on, your Macin
tosh wi ll substitute H elvetica, T imes, and Courier fonts, respectively. 

Automation Tricks 

If you'd like to sec your documents priJlted automatically, don't skip 
over this section. In it, you' ll fi nd some tips for unattended printing. 

Print Batches of Files 
You 'vc got a folder fu ll o f fi les created with different applications. Yo u 
need to print them all. Do you start opening them, one by one, and usc 
the Print command for each? There's a better way. 
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With bitmapped, True Type, and PostScript fonts 
installed in your Macintosh, you may wonder 
which font is actually used to print on a Post

Script printer. If a required font is not included in the printer's ROM, 
your Macintosh looks for fonts to send to it in the following order: 

• PostScript 

• TrueType 

• Bitmapped (scaled) 

If you've got a QuickDraw printer like an lmageWriter, a Style
Writer, or a LaserWriter lise, PostScript fonts aren't understood by the 
printer at all. In that case, your Macintosh looks for fonts to send to 
the printer in this order: 

• TrueType 

• PostScript (processed with ATM- if ATM is installed) 

• Bitmapped (scaled) 

0 Select the icons for the files you want printed. If the files are in 

multiple folders, use the List view outline feature of System 7 

to see the contents of all the fo lders. Remember to hold down 

the Shift key while clicking each icon to select them all. 

0 C hoose Print (Conunand-P ) from the Finder's File menu. 

0 Your Macintosh begins launching applications and displaying 
Print dialog boxes for each one. Click Print in each dialog 
box that appears. Each application will display only one Print 
dialog box no matter how man y of its documents were in

cluded in the selection. After an application sends information 

to the printer, it automatically quits. 

Ifyour Macintosh attempts to open more applications than available 
RAM allows, it might display an error message. It may also display an 
error message if there isn't enough RAM available to launch PrintMoni
tor and print. For this reason, it's a good idea to limit tl1e number of 
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different kinds of documents you print in a batch. You should have no 
problems if you choose several documents in only one or two applica
tions. 

Delay Printing 
You can usc Print:Monitor (or another print spooler application) to de
lay printing. For this to work, Background Printing must be turned on 
in the Chooser to r the printer you plan to print to. 

0 Open the document that you want to print later. 

0 C hoose Print (Command-P) fi·om the File menu. 

0 Make any necessary changes to the default settings in d1c stand
ard Print dialog box and click the Print button. 

0 The application displays a " Printing" message and sends the 
document to PrintMonitor. Wait until the " Printing" message 
disappears and then choose PrintMonitor from the System 7 
Application menu. It may take a little while for Print:Monitor 
to appear on d1e menu, so if you pull down the Application 
menu immediately and don't see it, release the menu, wait a 
moment, and try again . 

8 The Print:Monitor window appears. It lists all the documents 
currently waiting to be printed. Make sure the name of the 
document you want to print later is selected in the Print:Moni
tor window and click Set Print Time. 

0 A dialog box like the one in Figure 7.2 appears. Usc it to set 
d1e time (and, if desired, the date) that you want d1e selected 
document to print. Then click OK. 

Set Print Time: 

® [ Concel I 

0 Postpone Indefinitely 
([ OK I] 

Figure 7.2 Set the printing time and 
date with PrintMonitor. 
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0 Back in the PrintMonitor window, a suitcase icon appears be
fore the document name. The print time and date also appears. 
This is illustrated in Figure 7.3. 

0 To go back to work, choose another application from the Appli
cation menu. PrintMonitor should close automatically. 

Repeat these steps for as many documents as you like. The docu
ments you set to print later will automatically print at the specified time 
as long as the printer is properly connected and ready. Use this to print 
documents you don't need right away, leaving your printer free to print 
documents you need now. 

Canceling a Print Job 
Once you've sent something to PrintMonitor for printing, you can can
cel it at any time. 

0 Choose PrintMonitor from the System 7 Application menu. 

0 In the list of documents to be printed, click the name of the 
document you want to cancel. 

8 If the document is in the Printing edit box, click Cancel 
Printing. If the document is in the Waiting list, click Remove 
from List. After a moment, the item disappears. 

~ .... - i PrintMonitor i 

Printing 

W111ting 

0 fJID Chllpter 07 ~ 5:00 PM 10/27/ 94 

C11nre l Printing Se t Print Tim e •.. 

Figure 7.3 PrintMonitor's window displays 
the scheduled printing time and date for 
documents to be printed later. 
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PrintMonitor PrintMonitor is the print spooling application that's part of the Sys
tem software. It makes it possible to have your System 7 or Sys
tem 6 MultiFinder Macintosh print in the background, freeing up 

your Macintosh to do other things. 
While perfectionists might argue that PrintMonitor has many flaws, 

it's got two main things going for it: It works and it's free. If you find 
that PrintMonitor doesn't offer all the features you need in a print 
spooler, check out Fifth Generation Systems' SuperLaserSpoolwhich 
offers all the features of PrintMonitor and then some. 

0 Repeat tor as man y documents as you need to . 

8 To go back to work, choose another application from the 

Application menu. PrintM.onitor should close au tomatically. 

I f a document is already being printed when you cancel it, several 

pages may print befo re it is finally removed from the PrintMoni tor 
window. 

Launch PrintMonitor Manually 
Prinu\1onitor only appears on the Application menu if there are docu

ments currently being printed. If you have scheduled all documents to 

pri nt later and decide to cancel one, you may find that you can' t access 

PrintMonitor from the Application menu because it isn't active. Don't 

worry-you can still launch it manually. 
PrintMoni tor is an application that you can fi nd inside the Extensions 

folder inside you r System Folder. Launch it by double-clicking its icon. 
If you find that you do this often, make an alias of the PrintMonitor 
application and place it in your Apple Menu Items folder. That'll make 

it quick and easy to lau nch any time. 

Automatically Shut Down After Printing 
If a long document is printing and you don't want to wait around for it 
to finis h, you can make you r Macintosh shut down automatically when 

it's done. Sim ply select Shut Down from the Finder's Special menu. A 
dialog box like t he one in Figure 7.4 appears, warning you that a 
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" Figure 7.1 " from " TeachTeHt" is being 
printed on printer "Personal LoserWriter 
SC". I f you quit PrintMonitor now, the 
document will f inish printing when you 
restart the computer. Do you wont to 
finish printing now? 

[ Print Later ) ([ Finish Printing ll 

Figure 7.4 PrintMonitor displays this dialog 
box if you Shut Down while a document is 
being printed. 

docwnent is being printed. Click Finish Printing. Your Macintosh 
prints the entire document and th.en shuts down. 

Resource Saving Tricks 

Printing is probably one of the most wasteful aspects of computing . Af
ter all, it takes time, toner or ink, and paper. In this section, you' ll find 
some tips for saving these resources when you print. 

Save Time 
While it's true that you don't have to " baby-sit" a printer while it prints, 
you have to admit that printing can be, at times, painfully slow. Here 
are a few tips for speeding things up. 

+ When printing on a laser printer, choose Black & VVlute in the 
Print dialog box whenever possible. T his will force any colors 
in the document to change to either black or white- not much 
of a problem if you r document is already in black and white. 
C hoosing G rayscale/Color can slow down the printing process 
unnecessarily. 

+ Some print dialog boxes (like QuarkXPress's, which is shown in 
Figure 7.5) offer different quali ty outputs. Choosing something 
less than best quality wiU speed the printout considerably. T he 
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Figure 7.5 QuarkXPress offers different output options, some 
faster than others. 

document that emerges fi·om your printer will not be camera
ready, but it should be fine as a first draft. 

+ When printing on an Image~'riter, choose Draft or Faster in the 
Print dialog box whenever possible. Draft doesn't use the fonts 
you specified, but gets all the text on paper for proofreading and 
the like. Faster uses the correct fonts but doesn't print as dark or 
as clearly as Best. 

Save Ink and Toner 

T he tips for faster printing above can also save ink or toner. Here are a 
few more tips for saving the black stuff: 

+ When printing draft documents, remove any heavy black graph
ics (or set them so that they don't print) before choosing the 
Print (Command-P) command. 

+ When your laser printer displays the low toner indicator, shut off 
the prin ter, remove the toner cartridge, and gently rock it back 
and forth. Replace the cartridge and turn the printer back on. 
The rocking motion may be enough to settle the toner evenly in 
t11e cartridge, letting you print up to a few hundred more pages 
of text. 
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Recycling is great. It helps us 
reuse valuable resources and 
minimize landfills. This is espe

cially important for waste products that are not biodegradable, like 
toner cartridges. 

Many office supply stores sell recycled toner cartridges. These are 
used cartridges that have been refilled with toner. They're generally 
$10 to $30 cheaper than brand new toner cartridges, making them 
seem like a real money-saver. 

Unfortunately, as toner cartridges are used, they can become dam
aged. Print quality can be affected, depending on the damage. A 
scratch on a roller, for example, can leave a line on every single sheet 
of paper you print. Since the damage is in the cartridge itself, there's 
usually nothing you can do about it. 

If you do use recycled toner cartridges, keep an eye out for stray 
marks on your documents. If you find that the quality of the printouts 
isn't up to par for fina l documents, remove it. Don't throw it out, 
though. In a work environment with many laser printers, you might be 
able to use a damaged cartridge on a printer normally used for draft 
or internally circulated documents. Otherwise, it might make a good 
spare for emergencies. 

+ Check ou t a program called Toner Tuner by ·working Software, 

Inc. T his program works with your printer driver to reduce the 

amount of toner or ink your printer uses by letting you control 

the darkness of the print. I t works with most PostScript and 
non- PostScript printers, including laser, dot matrix, and inkjet 
printers. 

Save Trees 

With hund reds or thousands of acres of forest being cut down every day 
to meet the paper demands of today's businesses, you should try to do 
your part to minimize paper \vaste. Here are some tips: 
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8.0 

US Letter•l 

(( OK )J 

( Conce l J 

( Op t ions J 

( Help 

D Froctionol Widths D Print PostScript Ouer TeHt 

0 Use As Oefoult 

Figure 7.6 The LaserWriter 8.0 print driver offers multiple 
page printing on one page. 

• Save unneeded documents that are printed on only one side. Use 
the unprinted side for printing other draft documents or cut the 
sheets in half or quarters and use them for scrap note paper. 

t If your application or Page Setup dialog box offers it, prin t mul
tiple pages of a draft document on one page. The LaserWriter 
8.0 printer driver offers l Up, 2 Up, or 4 Up printing, as shown 
in Figu re 7.6. 

t Recycle used paper. Even if this is not mandatory in your area 
of the counu-y, imagine how much less waste there would be if 
everyone recycled! 
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Mobile Slick Tricks 

l X Jith the release of the original Macintosh Portable, Macintosh 

V V computing "went mobile." Years later, the PowerBooks and 

PowerBook Duos gave Apple a su·ong presence in the notebook com
puter market. Today, PowerBooks remain among the top-selling note 
book computers in the world. It doesn't seem possible to take a plane 

anywhere t hese days without seeing one on someone's u·ay table dming 

the flight. 

The Newton, which debuted at MacWorld Boston 1993, made Apple 

computing even easier to take along. While it is not a Macintosh, with 

the help of the Newton Connection Kit, a Newton has no trouble com
municating with one-or with an IBM-compatible machine running 
Microsoft Windows, if it has to. Before long, you'll be seeing Newtons 

in your doctor's office, at business meetings, and on golf courses-if 

you golf, of course. 
This chapter offers some tips and tricks for the desktop Macintosh's 

slimmer and u·immer sibling, as well as its pocket-sized cousin. If you're 

fortunate enough to have one of these computing devices, this chapter 
is for you. 

167 
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PowerBook Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Power Book users have all the power of a desktop Macintosh in a port
able package. But with that package comes new concerns: battery con
servation, connectivity, and file synclu·onization. This section provides a 
few tricks for dealing with them. 

Monitor Battery Power 
The Battery desk accessory, which is part of the System software for 
PowerBooks, enables you to check battery power and put your Power
Book to sleep (more on sleep in a moment). 

0 Choose Battery from the Apple menu. 

0 The Battery DA appears. It can be either expanded (as shown 
in Figure 8.1) or collapsed. Use the tiny "handle" at the far 
right side of the desk accessory to expand or collapse it. 

8 Solid black boxes indi.cate the battery level. A System Sleep 
button lets you put the PowerBook to sleep. 

G Click the close box to close the Battery DA. 

Put Your PowerBook to Sleep 
When you put your PowerBook to sleep, you're saving almost as much 
power as you do when you shut it down . In the so-called "sleep state," 
your PowerBook uses very Little power. In fact, it can remain sleeping 
on battery power for days. The benefit of putting your Power Book to 
sleep rather tl1an shutting it down is that the contents of RAM are not 
lost. Your Macintosh can wake quickly, too-much more quickly than it 
starts. 

Under System 7 .O.x, there are t\'IO separate kinds of sleep tl1at you 
can control separately: System sleep and internal drive sleep. Under 

0 L'tJ E 11111111 F t 
Sleep 

S.,sttm 
Sloop 

Figure 8.1 The Battery 
desk accessory 
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System 7. l.x, there is o nly one kind of sleep which covers both the 
system and the internal drive. Put your PowerBook to sleep with the 
Sleep command under the Special menu or the Battery desk accessory. 
Set sleep options with the PowerBook control panel. 

Putting Your Internal Drive to Sleep 
.... '. 

If you're using System 7.0.x and have the abi lity to set the internal 
drive sleep period, don' t set it for too short a period. Waki ng a hard 
disk consumes a lot of power. If you're using an application that fre
quently consults or saves to tl1e internal hard disk you could burn up 
a significant amount of battery power each time the hard disk wakes. 

Use the PowerBook Control Panel 
The PowerBook control pan el, which is illustrated in Figure 8 .2, lets 
you configure how your PowerBook tries to conserve power as it runs. 

0 Launch the PowerBook control panel. 

0 Use the sliding bar to set how your PowerBook runs. Maxi
mmn Performance increases PowerBook reaction time and 
speed while reducing battery conservation. Maximum Conser
vation saves power but decreases performance. 

0 If desired, click the Options button. The Battery Conserva
tion Options dialog box, which is illustrated in Figure 8.3, 
appears. Use the check box and radio bu ttons to specify exactly 
how you want your PowerBook to conserve battery power. 
When you' re finished, click OK to accept your settings . 

8 C lick the close box to close tl1e PowerBook control panel. 

Pow e rBoolc 

Ba ttery Conserva tion 
Mo1x fmum ~ 
Performance ~ 

I Options... J 

Max imum 
Conservation 

7 .1.2 

Figure 8.2 The P ower Book control panel 
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( Use Defoults ) n Concel D ( OK 

Figure 8.3 Battery conservation options offered 
by the PowerBook control panel 

Use a RAM Disk 
As with any computer, motorized parts consume a lot of power. Pow
erBooks have two such parts: the hard di sk and the floppy disk. While 
you may not notice how often the hard disk in a desktop Macintosh 
spins as you work, it's quite noticeable in a PowerBook. Each spin con
sumes power. If the Power Book is running on battery power, each spin 
means less running time. 

A RAM disk is the best solution for this problem. A RAM clisk, which 
was discussed in Chapter 3, enables you to use RAM as clisk space. Be
cause RAM doesn't need a motor to work, it uses much less power than 
a hard or floppy disk drive. It also has the added benefit of being faster 

than a hard disk. 
PowerBooks come with a RAM disk utility built into the Memory 

control panel, which was also discussed in Chapter 3. Figure 8 .4 shows 
what it looks like. H ere's how to use it to create a RAM disk. 

0 Open the Memory conu·ol panel. 

8 Click the On radio button in the RAM Disk section of the dia
log box. 

8 Drag the sliding bar to set the size of the RAM clisk. Fifty per
cent of available RAM is usually enough on a Power Book with 
8 MB or more of RAM installed . 
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Figure 8.4 The Memory control panel on a 
Power Book 

G Click the close box to close the Memory control panel and 
choose Restart from the Special menu. 

The RAM disk appears as an icon on your desktop when you restart. 
You can copy any fi les you like to the RAM disk, including large appli
cations and files that don't completely load when launched. This can 
greatly reduce hard disk access while working witl1 tl1ese files. 

RAM Disk Contents Can Be Lost! '· '· 

A RAM disk is not the same a regular disk. When you shut down your 
Macintosh or it bombs, causing you to restart, the contents of a 
RAM disk are lost! This applies to all Macintosh models except the 
PowerBook 100, which uses battery power to retain RAM disk con
tents even when the computer is turned off. For more information 
about RAM disk danger and how you can avoid it, be sure to consult 
Chapter 3. 
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Start Your Macintosh from a RAM Disk 
Since your Macintosh accesses System files periodically while you work, 
it's a good idea to use a RAM disk as your Startup disk. Here's how. 

0 Trim down your System folder so it contains only the files you 
absolutely need for your work. To do this, remove any un
needed fonts, desk accessories, control panels, and extensions. 

0 Create a large RAM disk. It must be at least large enough to 
hold the System folder. 

0 Drag your System folder icon to the RAM disk icon to copy it. 

0 Open the Startup Disk control panel. Choose the RAM disk 
as your startup disk. Close the Startup Disk control panel. 

0 Choose Restart fi·om the Special menu. When your Power
Book restarts, it'll start from d1e RAM disk. 

If you have a large enough RAM disk, you can copy applications and 
documents to the RAM disk as well. This will furd1er reduce disk access. 
If you put your Power Book to sleep rad1er d1an shut it dovm, you can 
retain the contents of the RAM disk. Od1erwise, each time you shut 
down your PowerBook, you' ll have to repeat Steps 3 through 5 to run 
from the RAM disk again. 

One important thing to remember when doing this: Since the con
tents of your System folder can change while you work, be sure to copy 
changed files from your System folder back to your hard disk before 
shutting down. This way the most recent versions of preferences and 
settings files are stored on your hard disk where they're not easily lost. 

Turn Down Brightness 
Backlit PowerBook screens are also big consumers of power. You can 
decrease the amount of power your PowerBook's screen uses by using 
the PowerBook Display control panel to dim the screen when the Power
Book is idle. This is like a built-in screen saver for the PowerBook. As 
soon as you begin using your PowerBook again, d1e screen image 
comes back. 
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Be Sure to Set Screen Dimming 

Even if your Power Book is connected to an external power source, 
it's a good idea to use the PowerBook Display control panel to dim 
the screen. If the screen is left on for an extended period of time, it 
can become temporarily damaged by the image left there. 

Run Down the Battery 
PowerBook batteries, like many other rechargeable batteries, have a 
memory. If the battery isn't completely drained before it is recharged, 
after a while it " thinks, it doesn't need to be completely drained before 
it is recharged. The result: reduced battery life. 

It's a good idea to completely run down your PowerBook's battery 
prior to recharging it as often as possible. You can purchase a discharging 
device to help you do this if you don't want to leave your Power Book 
on-check your computer rescller for options. (By the way, this principle 
applies to the batteries on cellu.lar phones and video cameras, as well.) 

Note: This does not apply to the Powerbook 500 series computers' 
"Intelligent Battery., 

Connect to a Desktop Macintosh with File Sharing 
System 7 file sharing offers an easy way to connect your PowerBook to 
a desktop Macintosh. Use AppleTalk connectors to physically connect 
the t\¥0 machines, then use fi le sharing to set up the network and access 
one computer's disks from the other's. 

0 Use the Sharing Setup conu·ol panel to identify each Macin
tosh's Owner, Password, and Name. 

f) Use the User & Groups control panel to create user accounts 
and set privileges . 

0 Select the disks or folders you want to share and use the File 
menu's Sharing command to make it accessible over the net
work. 

0 Use the Sharing Setup control panel to turn file shari ng on 
or off. 
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File Synchronization Software With the widespread use of PowerBooks, 
software developers have been quick to 
meet file synchronization needs. PowerMerge 

by Leader Technologies and lnline Sync by In line Design/Microseeds 
Publishing are just two of the products that perform this function. 
Other PowerBook utility packages may include their own synchroniza
tion software. This software can save a lot of time and effort by mak
ing it easy to find and update both your computers with the latest 
version of any changed file. 

0 Use the Chooser to mount a shared volume over the nel:\;vork. 

Once you mount your PowerBook's hard di sk on your desktop 
Macintosh, you can access any of the fil es on it as defined by the privi
Leges you set. If you prefer, you can mount your desktop Macintosh's 
hard disk on your PowerBook. In fact, you can do both at the same time 
if yo u like. 

Use Apple Talk Remote Access 

AppleTalk Remote Access, or ARA, was discussed in Chapter 6 . You can 
use this program, which comes with PowerBooks, to use file sharing 
over a modem connection. This makes it possible to access your desktop 
Macintosh from your PowerBook from anywhere in the world. 

Synchronize Files 

You've got a desktop Macintosh and a PowerBook. You keep certain 
files on both machines. How do you make sure the most up-to-date file 
is on both of them? The answer: Synchronize. Here are a few tricks for 
making file synchronization easier. 

+ Copy files from your desktop Macintosh to your PowerBook 
before taking your PowerBook on the road. Copy files from your 
PowerBook to your desktop Macintosh when you return. This 
will be effective only if you do it consistently and only use one 
compu ter at a time. 
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Quick Quiz: Macintosh on Television Name a current and wildly popular 
network sitcom where you can see a 

Newton Tricks 

Macintosh computer on the main 
character's desk. Know the answer? Know what kind of Macintosh it 
is? How about the Macintosh that occupied the same spot in the 
1992/1993 season? 

The answer is NBC's Seinfeld. Jerry has a Macintosh Duo with Duo
Dock and color monitor on his desk. In the first few seasons of Sein
feld, Jerry had a compact Macintosh. 

What other popular network sitcom, which is now in syndication, 
featured a Macintosh computer on one of its character's desks? What 
model was that? 

It's another NBC show: Night Court Judge Harry Stone also had a 
compact Macintosh on his desk. 

+ Store all files that are kept on both computers in a separate 
folder on each machine. This makes it easy to simply open the 
folders and compare dates. 

+ Use the Finder's Find (Command-F) command to find files 
modified since the last time you synchronized. T hen compare 
the dates and copy the files as necessary to update each machine. 

+ Use ftle synchronization software to simplify or automate the syn
chronization task. 

You saw it and you had to have it: a Newton. If you' re like other New
ton owners, your opinion of Newton probably falls between these two 
extremes: 1) T he Newton is one of the most useful computing tools 
you've ever used and you wonder how you lived without it, or 2) the 
Newton is a cute toy but you can't figure out what to do with it. T he 
handful of tips and tricks in this section should help point you in the 
right direction if you're lost in Newtonland. 
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Improve Handwriting Recognition 
One of the biggest complaints new Newton users have is Newton's less 
than perfect handwriting recognition. Here are a few tips for helping 
Newton to read your handwriting. 

+ Write with large, clear, well-formed letters. Large characters are 
easiest for Newton to understand . 

+ Show your Newton the correct word when it doesn't choose the 
right one. To do this, double-tap the word your Newton came 
up with to display a List of words it considered. If the correct 
word is on the List, tap it to replace the incorrect word. This not 
only corrects the entry, but it helps the Newton to learn how 
you write that particular word. 

+ Change the Handwriting Style so that it transforms handwriting 
less quickly. To do this, tap Extras, tap Prefs, and then tap 
Handwriting Style. Slide the indicator a bit to the right. 

+ When writing, don't rest your hand or tlngers on the screen. 
T his may confuse your Newton, which doesn't know whether it 
should interpret the pressure as part of the information you are 
entering. 

+ Be sure to put your Newton in Guest mode when letting some
one else give it a try. To do this, tap Extras, tap Prefs, and then 
tap Handwriting Style. Turn on the box for Configure for 
Guest User . When the "guest" has fini shed, be sure to turn 
Guest mode off so your Newton can continue to learn from you. 

Have Patience 
Don't get frustrated when your Newton can' t seem to learn how to 
read your handwriting. It takes time, effort , and patience. If you follow 
the instructions that came with your Newton and write as clearly as pos
sible, you should see positive reSlllts within a reasonable time. 

Read Your Own Handwriting 
If you don't have the time or patience to teach your Newton how to 
read your handwriting, turn character recognition off and just write. 
After all , you can read your handwriting, can' t you? This is most useful 
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for jotting down little reminders and notes that don' t need to be stored 
as regular computer data. 

Synchronize 

T he Newton Connection Kit (version 2.0) lets you back up your New
ton to a desktop Macintosh witl1 its synchronize function. This function 
is good for a few tricks: 

+ Use Synchronize to back up the contents of your Newton to a 
desktop Macintosh. After the first synchronization, three fi les are 
maintained: Newton, Backup File, and Archive file. Newton con
tains the contents of your Newton. Backup File contains the con
tents of your Newton the last time you synchronized. Archive 
Fi le contains the items removed from your Newton each time 
you synchronize. 

+ Use Synchronize to restore the Newton fi le to your Newton in 
the event of a Newton data loss. 

+ Use Copy and Paste on your Macintosh to copy items from the 
Archive fil e to the Newton file. Then use Synchronize to get the 
old information back onto your Newton. 

+ Since tl1e Newton Connection Kit " recreates" Newton 's resident 
applications on your Macintosh, you can enter data on your 
Macintosh and use Synchronize to get it into your Newton. 

Try Shareware 
Shareware, or " try-before-you-buy" soft\vare, has been available for 
desktop computers for years. You may not realize it, but there is New
ton shareware around as well. You can find it on many online services 
and BBSes. With shareware prices ranging from free or a simple post
card up to about $20, shareware can be an excellent value. One thing 
to keep in mind , however: To install Newton shareware that you obtain 
on a Macintosh disk, you' ll need d1e Newton Connection Kit. 

Connect with NewtonMail 
NewtonMail is a service of Apple Computer, Inc. To use it, you need a 
NewtonMail account, a Newton, and a Newton fax modem . Once set 
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Duiclc Quiz: Newton in the Funny Papers Name a popular comic 
strip that featured the 
Newton not long after it 

was first released. Which character had one? 
The answer is Gary Trudeau's Michael Doonesbury in the comic 

strip Doonesbury. 

up, you can use Newton mail to exchange NewtonMail messages with 
other Newton users, and any electronic mail system that can be accessed 
t lu·ough the Internet. (For more information about connecting 
through the I nternet, be sure to check out Chapter 5.) 

Display Newton Easter Eggs 

An Easter Egg is a hidden message or graphic placed inside a com
puter's software or ROMs by a programmer. There are hundreds of 
Macintosh Easter Eggs-you can fi nd them sprinkled throughout this 
book. Here are a few just for Newton. 

+ To find out where Elvis was last sighted, tap Find, wri te Elvis, 
and tap the Close button on the keyboard. Before the keyboard 
disappears, it asks, "Add Elvis to word list?" Answer Yes or N o. 
Then tap All. 

+ To see a list of the Apple developers who created Newton, tap 
Assist, write About Newton in the Please fie ld, and tap Do. 

+ To see a special graphic when you turn on your Newton, tap 
Extras, tap Prefs, and tap Personal . Double-tap the Country 
field . When the keyboard appears, type Graceland. Tap the 
Close button on the keyboard. Before it disappears, it asks, 
"Add Graceland to word list?" Answer Yes or No. Close Prefer
ences, close Extras, and turn your Newton off. When you turn 
your Newton back on, you' ll get a new greeting. 
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Maintenance and 
Troubleshooting Tricks 

A n ounce of prevention is worth a pound of cure. Whoever first 
made that statement may have owned a computer because it cer

tainly can be applied to computer equipment. It's amazing how a few 
simple maintenance tasks and protective measures can help keep your 
Macintosh running smoothly for years. 

In this chapter, you'lllearn some tips for taking care ofyour hardware 
investment. Because good maintenance isn't always enough, however, 
this chapter will also provide a bunch of tips and tricks for figuring out 
what's wrong-and fixing the problem-when your Macintosh is feel
ing under the weather. 

Power Protection Tricks 

Power level fluctuations, which are called spikes, surges, and brownouts, 
can do serious damage to computer components. Here are some ways 
you can protect against these power problems. 

179 
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Use a Surge Suppresser 
A surge suppresser is a device that plugs into the wall socket and usually 

offers two to eight plugs to provide power to multiple computer or 

electronics devices. Surge suppressers have fuses and often have their 

own separate power switches that add even more protection. No com

puter sho uld be plugged directly into a wall socket! 

Use a UPS 

An uninterrupted power supply (UPS) is most commonly used to pre

vent systems fi·om shutting down in tl1e event of a power outage. Many 

UPS units, however, also fi lter incoming power to provide smooth 

power levels for devices plugged into them. While more expensive than 

a standard surge suppresser, you've got tl1e added benefit of being able 

to continue working even in the event of short-term power failures. 

Use a Telephone Surge Suppresser 
Your local power company and its electrical lines aren't the only source 

of power hazards. Ifyou use a modem or fax modem, it can be damaged 

by phone line power problems. Telephone line surge supprcssers, which 

arc often included on regular surge suppressers, help protect against 

phone line power fluctuations. Use a standard phone cable to connect 
the suppresser to the wall jack. Then use another standard cable to con

nect the suppresser to tl1e modem or fax modem. (By the way, this can 

help protect regular fax machines, too. ) 

Power Down During Thunderstorms 
If you live in an area prone to thunderstorms, consider shutting down 
your computer equipment during storms, especially violent ones. Light
ning strikes on or near power or phone lines can cause the kinds of 

spikes and surges that you buy surge suppressers to protect against. If 

the strike is close enough, however, no surge suppresser is going to stop 
its power. 
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Virus Protection Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Computer viruses are possibly one of the most frightening hazards for 
computer users. If you follow a few simple precautions, however, you 
can keep your computer free of viruses and the damage they cause. 

Use Anti-Viral Software 

Anti-viral software is your first defense against computer viruses. These 
software products can perform any or all of the following functions: 

+ Protect against virus infections. Many anti-viral software prod
ucts work constantly to check your system for indications of virus 
activity. Ifyou insert an infected floppy disk, for example, this 
software will spot the virus and alert you before the virus has a 
chance to infect your system. These anti-viral products usually 
contain a System extension or control panel or both so that they 
load as soon as you start your Macintosh. 

+ Detect virus infections. Many anti-viral software products include 
a scan function you can use to search disks for infected files. If 
the software finds an infected file, it alerts you immediately so 
you can act to remove it. Virus detection scanners usually work 
as applications that you launch manually and put to work. 

+ Remove infections or infected files. Once a virus is detected, 
many anti-viral software products have tl1e ability to remove in
fected files . Not all viruses can be removed by anti-viral software, 
however. Most anti-viral software provides instructions on how 
you can remove a virus if it can't. Sometimes the solution is as 
easy as rebujlding your Desktop file. 

Update Anti-Viral Software Regularly 

Each time a new virus comes to light, chances are your existing anti-viral 
software won't be able to detect it. That means that it's vital that you 
keep your anti-viral software up to date. If possible, watch for news of 
new viruses in Macintosh magazines like MacWEEK, MacUser, and 
MacWodd. vVhen you read about one, get the update to your anti-viral 
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Disinfectant Not everyone has a lot of money to spend on anti-viral software, 
updates, and update services. If you're on a tight budget, check 
out Disinfectant by John Norstad. It is updated each time a new 

virus is discovered- updates are always available within days of the 
discovery. Disinfectant includes an extension that can identify in
fected floppy disks as they are inserted. Its application can scan or 
disinfect disks, folders, or specific files. 

It's online help feature includes an extensive virus reference mate
rial that'll teach you everything you need to know about Macintosh 
viruses. Disinfectant is widely ava ilable on online services and BBSes. 
Perhaps best of all, this little gem is free. 

software- it's no rmally available within days of the discovery of a new 

virus. If the maker of the anti-viral sofu:vare you use offers an update 
service, sign up fo r it . T here might be a fee involved, but paying that 

small fee might save your files one day. 

Lock Floppy Disks 

As mentioned in Chapter 6, one surefire way to protect floppy disks 

from infection is to lock them. When a disk is locked, nothing can be 

wri tten to it. That means nothing can be changed-which means a virus 

canno t infect the disk. It's as simple as that. 
Be sure to lock all original program disks and other disks containing 

information you don't need to change. This will pro tect the d isk fro m 

viTuses better than any other method. 

Spread the Word-Not the Virus 
If you find a virus on your system, don't keep it a secret. There's a 
chance that any disk inserted in to your computer since the last time you 

checked for viruses may also be infected. Tell anyone who may have a 
disk that has been in yoLtr system. This will help prevent the further 
spread o f the virus. 
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Cleanup Tricks 

A di1·ty Macintosh isn't only unattractive; it might have trouble operat
ing. Here are some tips for keeping your Macintosh clean. 

Don't Smoke 
Secondary smoke can be harmful to your computer's health, too. If 
you're a smoker, do your Macintosh a favor and don't smoke near it. 
Smoke particles find their way inside components and cling to surfaces. 
Smoke on the magnetic surface of a floppy disk can cause data access 
errors. 

Blow the Oust Out of Your CPU 

Periodically open your CPU and blow out the dust that might have ac
cumulated. Dust buildup leads to heat buildup which can permanently 
damage computer components. When blowing out dust, it's best to use 
compressed air that comes in a can. You can find it in most office or 
computer supply stores. 

Use a Oust Cover 
Ifyou work in a dusty environment, invest in computer covers to keep 
the dust out of your equipment when you're not using it. 

Clean Floppy Drives 

Clean your floppy disk drive( s) regularly-at least a few times a year. 
This keeps the heads free of dirt and dust that can corrupt data on 
floppy disks. 

A number of companies make floppy disk drive cleaners. These nor
mally consist of a special floppy disk with a hard doth insert instead of 
magnetic media and some kind of cleaning fluid. 3M makes drive clean
ers with treated inserts. Other companies, like Allsop, make reusable 
inserts and provide a plastic bottle of fluid you can drop onto the insert 
before using it. Either way, when you insert the special disk into your 
drive, your Macintosh tries to read it. As it tries, its heads get cleaned. 
When it reports that the disk cannot be read and it offers to initialize it, 
click Eject to remove tl1e disk. 
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Use a Keyboard "Skin" 
Dust and humidity are two environmental hazards that can prevent a 

keyboard from working properly. A thin plastic covering designed spe

cifically to mold to the keys on your keyboard can protect it from both 

of these elements. You'll hate it tight after you install it, but after about 
a week or so, you won't even notice it. If you've ever taken apart an 

extended keyboard and cleaned every single key by hand, you'll realize 

the value of this simple protective device. 

Keep Your Mouse Territory Clean 
As your mouse rolls around your desk surface or mouse pad, it picks up 
whatever dust, crumbs, other debris might be in its path. These particles 
accumulate inside the mouse and can cause it to malfunction. Keep your 

desk clean to avoid mouse problems. If problems do occur, simply re

move the ball in the belly of the mouse, blow out the debris, and replace 

the ball. 

Clean the Plastic Parts 
To clean the outer plastic parts of your Macintosh, use a soft cloth and 
a nonabrasive cleaner. Fantastik is very effective. Don ' t spray the cleaner 

directly onto your Macintosh. Instead, spray it on t11e cloth. You may 
want to rinse t11e cleaned components with clear water on a fresh cloth 

to finish the job. 

Desktop File Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Rebuilding the Desktop is a simple software maintenance technique 

t11at can prevent missing or incorrect icons and some disk-related errors. 
Do it once every few months. In t11is section, you' ll learn how. 

Rebuild a Floppy Disk's Desktop 
To rebuild the Desktop on a floppy disk, follow these steps: 

0 Hold down Command-Option while inserting the disk. 

0 A dialog box like t11e one in Figure 9.1 appears. Click OK. 
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Are you sure you want to rebuild the 
desktop file on the disk " Sneaker Net"? 
Comments in info windows will be lost. 

( Cancel J n OK JJ 

Figure 9.1 Rebuild the Desktop? 

0 A progress box appears like the one in Figure 9.2 appears. It 
shouldn't take more than a few seconds to rebuild the Desktop 
on a floppy since it usually contains few files. When the pro
gress box disappears, you can continue working. 

Rebuilding the Desktop Erases Get Info Comments 

When you rebuild the Desktop, any comments you may have entered 
into the Get Info window for a ftle will be lost. If you want to enter 
permanent comments in the Get Info window, include them in a file's 
vers resource-you can fmd instructions for this in Chapter 10. 

About the Desktop As your work with your Macintosh, it build~ and maintains 
a·n invisible file (or pair of files) called the 10esktop file 
which it uses to store references to icons and file path infor

mation. Your Macintosh uses this information to display icons in the 
Finder. Qn a System 7 Macintosh's hard disk, the Desktop file really 
consists of two invisible files: Desktop 1DB and Qesl<top DF. On a·Sys
tem 6 Macintosh's hard disk or on any floppy disk, no matter what ver
sion of the System software is running, there's just.one invisible file: 
Desktop. 

When, your Macintos~ experiences system borilbs1 !POWer outages, 
and other: disruptive events, the Desktop file can oecome corrupted. 
Rebuilding the Desktop creates a brand new Desktop file from 
scratch, eliminating any problems that might otherwise occur. 
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Rebuilding the desk top file ... 

Stop 

Figure 9.2 A progress box shows 
reconstruction in progress. 

Rebuild Your Hard Disk's Desktop 
To rebuild the Desktop on a hard disk, follow these steps. 

0 Hold down Command-Option while restarting (or starting) 
your Macintosh. Keep the keys held down throughout the en
tire startup process. You may notice that some extensions and 
control panels that normally appear across the bottom of your 
startup screen display with X's over them. This is because press
ing one or both of these keys may disable those programs. 

0 A dialog box like the one in Figure 9.1 appears. Click OK. 

0 A progress box appears like the one in Figure 9.2 appears. T he 
larger the bard disk and the more ftles on it, the longer the re
building process will take. When the progress box disappears, 
you can continue working. 

If you have multiple hard disks connected to your Macintosh, a dia
log box like the one in Figure 9.1 will appear for each one. Click OK 
or Cancel, whichever is appropriate. 

Rebuild the Desktop Without Restarting 
Although it isn't really a good practice, you can rebuild the Desktop of 
your hard disk without restarting your Macintosh. Here's how: 

0 With the Finder active, press Command-Option-Esc. 

0 A dialog box appears, asking if you want to force-quit the 
Finder. Press Command-Option and click Force Quit. 

0 A dialog box like the one in Figure 9.1 appears. Click OK. 

0 A progress box like the one in Figure 9.2 appears. VVhen it dis
appears, you can continue working. 
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Why isn' t it a good idea to rebuild the Desktop like this? Because 
force-quitting the Finder can corrupt RAM and cause problems later in 
the work session. It's always a good idea to restart your Macintosh after 
force-quitting a program. If you have to restart anyway, why not just 
rebuild the Desktop then? 

Miscellaneous Maintenance Tricks 

I~ 

Here are a few other maintenance tips you should consider. All of these 
will help your Macintosh run trouble-free. 

Use Disk Diagnosis or Repair Software 

Disk diagnosis or repair software can not only fix major disk problems, 
it can also fi x minor ones, thus preventing major problems from occur
ring. The "Disk Diagnosis and Repair Software Tricks" section of this 
chapter discusses a number of useful soft\vare packages, including two 
you might already have. 

Reformat Your Hard Disk 
Although time consuming to do, reformatting your hard disk is a good 
way to keep it running smoothly. The formatting and initialization proc
ess wipes the disk clean, realigning the magnetic particles on the disk 
surfaces. It removes any corruption and lets you start fresh. It also gives 
you an opportunity to add or remove disk partitions to change your 
filing strategy. Formatting and partitioning a hard disk was discussed in 
Chapter 6. 

Startup Troubleshooting Tricks 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

When your Macintosh won't start, it's frustrating if you don't know 
how to deal with it. In this section, you'll find some basic troubleshoot
ing tricks that may help you get your Macintosh started when it seems 
to want to take the day off. 



188 Macit~tosh Slick Tricks 

Check the Batteries 

You tried to start your Macintosh Ilfx but nothing happened. Every
thing is properly connected but the darn thing seems dead. What do 
you do? 

Macintosh II, IIx, and Ilfx computers use the battery to keep a ca
pacitor inside the computer charged (among other things). This capaci
tor is what starts the computer when you touch the startup key. If the 
battery is dead or extremely weak, these computers will appear dead. 

Of course, the problem could be worse. A dead Macintosh could 
indeed be a dead Macintosh. Some more serious problems to check for 
include a bad power supply or ROM problem. 

Translate Weird Startup Sounds 

You started your Macintosh and, instead of playing the regular startup 
sound, it played you a little tune. 

A strange startup sound usually indicates a hardware problem with 
RAM, video display, or a SCSI device. In rare cases, it could be a prob
lem witl1 the System file. 

Read the Sad Mac Message 

A black screen witl1 a sad Macintosh face in it is another inctication of 
serious problems. Look at tl1e two rows of hexadecimal numbers be
neath the Sad Mac and compare the top row with these for a possible 
answer: 

Top Row Number Possible Problem 

00000000 RAM Chip Problem 

00000001 ROM Chip Problem 

00000002 RAM Chip Problem 

00000003 RAM Chip Problem 

00000004 RAM Chip Problem 

00000005 RAM Chip Problem 

00000006 VIAl Chip Problem 

00000007 V1A2 Chip Problem 

00000008 Bus Problem 



Top Row Number 

00000009 

OOOOOOOA 

OOOOOOOB 
oooooooc 
OOOOOOOD 
OOOOOOOE 

OOOOOOOF 

Chapter 9: Mnintenn11ce n11d TrottblesJJooting Tt·iclts 189 

Possible Problem 

MMU Chip Problem 

Disk Partition Map Problem (You may 
be able to solve this by updating the 
disk driver.) 

SCSI Chip Problem 

Floppy Contro ller Problem 

SCC Chip Problem 

Data Bus or SIMM Problem 

Hardware failure during software re -
quest problem. (You may be able to 
solve this by replacing the System fi le.) 

As you can see from this table, a Sad Mac is indeed bad news. Pull 
out the phone book and call your nearest authorized Apple repai r center 
for help. 

Understand the Question Mark Icon 

You started your Macintosh but the desktop didn't appear. Instead, you 
see a flashing question mark icon like the one in Figure 9 .3. 

The question mark icon normally indicates that your Macintosh can't 
find the System file. The reason why it can't find the System file deter
mines how serious the problem is. 

+ If your Macintosh can't find the System file because there's no 
System file on the disk, boot from another disk. 

+ If your Macintosh can't find the System fil e because the System 
fi le is corrupted, simply reinstall the System. 

+ If your Macintosh can't find the System fi le because it can't read 
the hard disk, you may have a serious problem. First check all 
connections. (If it's an internal disk, chances are the connections 

Figure 9.3 The question mark icon 
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are okay unless you just fmished messing with them.) If the con
nections are fine, try using disk diagnosis and repair software to 
solve the problem. If the disk is gone for good, specialized repair 
software may not even be able to "see" the disk. 

+ On some systems, a question mark icon might appear if more 
than one SCSI device in the chain has the same SCSI ID number. 

Use a Boatable Floppy 
When you get a question mark icon at startup, that means your Macin
tosh can run-it just doesn't have the right software to get started. Any 
floppy disk that contains a System file and application ftle can be used 
as a boatable floppy. Your Disk Tools disk is a good candidate. The 
"emergency" disks that come with programs like Symantec's Norton 
Utilities for Macintosh and Central Point Software's MacTools may be 
even better. 

As soon as you insert a bootable floppy, the question mark should 
disappear. After a moment, your Macintosh's desktop should appear. 
(This might take a while, especially if the floppy has System 7 on it, 
since floppies take longer to read than hard disks. Be patient.) Once 
you're in the Finder, you can start tracking down the problem. 

Look for Your Hard Disk Icon 
If you got the question mark icon at startup but you can see your hard 
disk icon when you boot from a floppy, breathe a sign of relief. This 
means your hard disk has not crashed and you can probably still use it. 
If your hard disk does not appear on the desktop, however, it's time to 
use disk diagnosis and repair software to find it. 

Cure Bombs During Startup 
If your Macintosh seems to start properly but bombs as extension and 
control panel icons are being displayed across the bottom of the screen, 
you probably have a bad extension or control panel or a conflict. Pay 
attention to the icon that is displayed when the bomb occurs. Chances 
are, the program with that icon or the one that loads right after it is the 
problem. Remove it and start again. 
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Eject a Disk at Startup 
If you've got a boatable floppy disk in your disk drive but it bombs t he 

system every time you start, you may be wondering how you can get it 

out . T here are two ways: 

t Use a disk ejection tool. What? You didn't get o ne of these with 

your Macintosh? D o n' t worry- no o ne did . Take a paper clip 

and srraightcn it. Poke o ne end into the t iny ho le to the side of 

the disk drive. You sho uld be able to push back a lever there. 

Never do this while your Macintosh is running since a poke in 

the wro ng place cou ld cause a short. In fuct, although disk ejec

tion too ls arc widely used, they're really not such a good idea. 

t Hold down your mo use button as you start (or restart) your 

Macintosh. If the drive is functio ning properly, the d isk sho uld 

eject itself. 

Disk Diagnosis and Repair Software Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Be prepared. T hat's no t just a motto scouts usc. vVhcn your Macintosh 

starts acting strangely o r files start disappearing, you'll want to be pre

pared to solve problems quickly. 

T hat's where disk diagnosis and repair softwar e come in . These soft

wa re products check disks o r your entire system and repair or p rovide 

info rmatio n o n any problems they find. Some of these packages are so 

powerfu l that they can even recover files you deleted on purpose by 

accident. 

Use Disk First Aid 
Disk First Aid is p rovided on the Disk Tools disk that comes with the 

Macin tosh System software. It's designed to verify the directo ry struc

ture of most hard and floppy disks. If D isk First Aid finds problems, you 

can use it to try to repair them. Here's how you usc it. 

0 Lau nch D isk First Aid. Its window, which is il lustrated in Fig

ure 9 .4, displays all mounted volumes, an informatio n window 

·with instructions, and three butto ns. 
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-- -- Disk First Aid 
S.loot volum.(s) to vorify : Numbtr of vol<.rnu soltotod : I 

C:=J .. 
Sovon-C»l Dlllllll 

f'w'B SCSI 2 v20928<j FWS SCSI 0 v20928g 
(Stortup Disk) 

1¢1 IG 
Roviow instructions and ruults : 

n B 
Checki119 disk •Hord Disk • . ~ Chocking disk volumt. IJerify Chtoking t>ctent BTrto. 
Chocking t >ciont flit. 

( lh~t>nir J 
Chtoking catalog BTrot. 
Checking catalog file . 
Checki119 catalog hior arohy . 

( ~to t> J 
Rtohtoking t >ctont fit.. 
Checking volurnt info. 
Chtckl119 for locktd volume namt. 
Rtohecklng catalog flit . 
Tho velu.,. •Hard Dtsk• appurs to bt OK. 

to 
Figure 9.4 The Disk First Aid window 

0 Choose the volume you want to check by clicking its icon in 
the top of the window. It becomes selected. To select more 
than one disk, hold down Shift while clicking on each one. 

0 Click Verify to check the disk. The information window dis
plays the progress of the check. This process can take a few 
minutes if the disk is large. 

8 The results of the check and any additional information appears 
at the bottom of the window when the verification process is 
finished. 

If the disk has a problem, you can use the Repair button to try to fix 
it. Disk First Aid may or may not be able to fix the problem. Disk First 
Aid cannot repair a locked disk or the startup disk. 

Use MacCheck 
MacCheck is another free Apple diagnosis tool. You can find it on the 
Macintosh Software Utility Update disk discussed in Chapter 3 if it 
didn't come with your Macintosh. 

MacCheck helps you learn more about your Macintosh computer and 
can help diagnose software problems that may be caused by corrupted 
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If Your Disk First Aid Looks Different If, after selecting a disk to check, 
your copy of Disk First Aid looks 
like the one in Figure 9.5, you don't 

have the most current version. The one discussed above is version 
7.2, which is available on the Macintosh System Update 3.0 discussed 
in Chapter 3. 

If you don't have the latest version and you've got a problem, don't 
panic. The older version should work just as well as its redesigned de
scendent. Click Start to begin the check and wait for the "Test done" 
message. To display the details of the testing- press Command-S (for 
"Scavenge") to display a window like the one in Figure 9.6. 

files and d irectories. It creates a profi le of your computer that includes 
information about its processor, memory, expansion cards, and connected 
devices, as \veil as installed software on your startup disk. MacCheck can 
also perform tests of the logic board, check the ftle directories and Sys
tem fi le for corruption, and locate duplicate System folders. Here 's how 
to use it: 

0 Launch MacChcck. As it starts up, it begins gathering informa
tion about your System. I t displays it progress in its splash 
screen, which is illustrated in Figure 9 .7. Be patient, the 
startup process can take several minutes, depending on the 
speed and complexity of your system. 

0 When MacCheck's main screen (illustrated in Figure 9.8) 
appears, click Test to have MacCheck perform tests on your 
hardware and System fi les. These tests take a few minutes. As 

:::CJ-·- Disk Firs t Rid ~- -

Test done. The disk is OK. 

Uolume: Seuen-Oh 

[ Stort J ( ~top 

Figure 9.5 The "old" version of Disk First Aid 
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4/211/114 II : 17:34 PM : Scaveng ing begun. 

Checking disk va lurae . 
Checking ex tent BTree . 
Check i ng ex t ent f i l a . 
Checking ca talog BTree. 
Checking catalog fil e. 
Checking catalog hi erarch~ . 
Checking vo lume Info . 
Sc:aveng I ng t enn ina led . 

4/211/114 II : 18:00 PM : Scaveng ing ended. 

Figure 9.6 The "Scavenge" window 

the tests are done, their results appear in MacCheck's main 
scrolling window. 

0 Click the System Info button (or press Command-!) to get 
information about your Macintosh's hardware . Some of the 
information MacCheck provides is very technical. You can get 
more hardware information by choosing Additional System 
Info from the Windows menu. 

8 Choose Application and Font Info from the Windows menu 
to view a detailed list of installed fonts and applications. One 
of the great things about MacCheck is that it identifies 
whether an application is 32-bit clean. If you're running your 
Macintosh in 32-bit mode and have trouble with a specific 
application, this can tell you why. 

loodlng MocCheck ... test s ... 
Getting Macintosh Model Info ... 

MacCheck' .. profiles your system's hardware and software. 
It olso tests your computer's hordwore ond checks for 
corruption of your directories and system fil es. If 
MacCheck'" detects a problem, It will either Instruct you 
how to fiH the problem or who to contact to help you fiH 
the problem. 

To quit launching MacCheclc' .. , press 
the command and period keys (31!.) 

Figure 9.7 MacCheck's splash screen 
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~ • ;I Test Results- I 
"'~~~""'h9 or oc::~~ v~.~-,~ R¥1"1~. 

~ RtchKkinq catalog fitt 
Oirtctory fs OK. 

• Chtcklng fi~ NFindtr 11 
••• 

FHt is OK. 

Chtcl(lng fil• ,..Systtm " ... I• 

MacCheck;:.! 
Fflt fs OK. 

I 
Volu~ : .... Sf.vtn-Oh". ,I 

Chfck1ng directory . .. 
CMcki"lg disk volume. 

n Tes t I Chtcking ex tt>nt BTrtt. I 

CM<:king extent filfo . 
CMckinq c.ablo9 BTrtt. ,, 

( System Info ) Chtckin9 c•t•log ffl• . 
ChH;kinq cat.alo<j hitr~r o h y. 
Rtchtcking exh•nt filt. 

( llelp ) Chtckinc, volunw info . 
Chtd:ill9 for lock.d vobnt ~. 

( ) 
RtchKking catalog tilt . " Quit Oinotorv is OK. 

J Chfckfng file .... Findtr " ... 
Ffl• f s OK. 

f.1 
Cht cld f\9 file ""SIJstem "' ... 
FHt 1s: OK. 

No troublP found. ;!'I 
A 11 tf'sts pasnd. li,. .......................................... ~ oQ. 

<:>L'!I.I ~; ' . ,Ill . · ., [.2eJ 

Figure 9.8 MacCheck's main screen after a test 

0 To save the results o f a test, including all t he information Mac
C heck has gathered, choose Save Results (Command-S) from 
the File menu. The resulting text document can be opened by 
MacCheck or any word processing application. 

Miscellaneous Troubleshooting Tricks 

Here are a few more troubleshooting tricks you might 0nd usefu l when 
working with your Macintosh. 

Increase Application RAM 
An application's R.A1Vl allocation is the amou nt of RAM allocated to it 
by the System to run . Chapter 4 discussed application RAM in detail. 
When a program has any of these problems, you should probably use 
the Finder's Get Info window to increase its RAM allocation: 

• The program won't open as many files as you need it to. 

+ T he program won' t open large fil es, especially graphics fi les. 
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Norton Utilities and Central 
Point Mac Tools 

Disk First Aid and MacCheck are two Apple 
Computer, Inc. tools that you can get for free 
from Apple dealers, some online services, and 
many user groups. They can be helpful, but 

they're often not enough to solve serious problems. That's when it's 
time to call in the heavy hitters. 

Symantec Corporation's Norton Utilities for Macintosh and Central 
Point Software's Mac Tools are two similar software products that can 
help you when Disk First Aid can't They can check your disks for file 
and directory damage, repair many problems, and even recover files 
that your Macintosh thinks are gone for good. No serious Macintosh 
user should be without one of these products or another similar product 

+ The program is acting sluggishly, constantly reading and writing 
to disk as you work witl1 it. 

+ The program displays an Out of Memory error message. 

+ The program frequently bombs when working with large files or 
graphics. 

Cure Frequent Bombs and Error Messages 

If you often get bombs, freeze-ups, and error messages in multiple 
applications, reinstalling your System may help. Chapter 3 provides 
detailed instructions for doing this correctly. 

If the problems occur only in a specific application, try this: 

+ Check tl1e software documentation to be sure your system meets 
the software's requirements for RAM, CPU, math co-processor, 
32-bit mode, etc. 

+ Increase tl1e application's RA1V1 allocation using the Finder's Get 
Info window for the application. (Chapter 4 provides derails.) 

+ If all else fails, delete the application and its support files and 
reinstall it from scratch. There's a chance that one or more files 
could be corrupt, causing tl1c problem. 
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Back Up Your System Folder 

Many software-related problems can be solved simply by replacing the 
System software. This can be a time-consuming process. You can reduce 
the amount of time it takes to replace your System by simply including 
the System folder in your regular backup procedure-you do back up 
your documents regularly, don't you? This way, replacing the System 
can be as easy as restoring tiles from a backup. 

Zap the PRAM 

Parameter RAM or PRAM is special RAM set aside to store settings for 
the current date and time, desktop pattern, alert sound and sound vol
ume, keyboard and mouse settings, colors, and a number of other 
things. As you might have noticed, most of these things are set with 
control panels. PRAM uses battery power to store these settings so your 
Macintosh can use them when it starts up. 

Although it isn't a very common problem, PRAM settings can 
become lost or corrupted. Indications of this include incorrect date or 
time, unusual font in system dialog boxes (like the About This Macin
tosh window), and settings that keep changing. You can reset the con
tents of PRAM, bringing your System back to default settings, by 
"zapping" the PRAM. Here's how. 

+ On a System 7 Macintosh, begin by quitting all applications 
except the Finder. Hold down Command-Option-P-R while 
choosing the Restart command from the Special menu (not an 
easy task). Keep the keys held down as your Macintosh starts. 
You'll hear a first startup sound and, after a moment, your screen 
will blink and you 'II hear another startup sound. Let go of the 
keys. 

+ On a System 6 Macintosh, hold down Command-Control
Option while choosing Control Panel from the Apple menu. A 
dialog box appears, asking you to confirm that you want to Zap 
the PRAM. Click OK 

After zapping the PRAM, you 'II have to use your control panels to 
reset the System settings the way you like them. Keep in mind that 
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zapping the PRAM can also affect network settings, like those set with 
AppleTalk Remote Access. 

If you continue to have problems with the PRAM-stored settings, 
replace your Macintosh's batteries. 
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Power User 
Customization Tricks 

T his chapter is for the folks who want to roll up their sleeves and dig 
right in to their Macintosh interface. In this chapter, you'U learn 

how to customize your Macintosh with a free program called R esEdit, 
one of the most powerful programming tools Apple ever put into the 
hands of nonprogrammers. Customize the Finder, the System, and ap
plications so they work better or faster for you. Make files invisible. Add 
messages to the Get Info window. Become a sound thief. Find these 
tricks and more within the pages of this chapter. 

If you don't have ResEdit, don't skip this chapter-you'll be missing 
out o n some of the best tricks in this book. Read the chapter to learn 
what ResEdit can do for you. Then, when you're hooked, track down a 
copy and join the fun . 

199 
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About ResEdit Res Edit, the Apple Resource Editor, is a free appl ication 
available through Apple dealers, some online services, and 
many Apple user groups. It enables you to open or create a 

resource fork for a file. 
Let's take a few steps back. Macintosh files can have two parts 

or "forks:" the data fork and the resource fork. The data fork, which 
is present in all documents, contains information. The data fork for 
the word processing document containing this chapter, for example, 
would have the text of this chapter in it, as well as some special for
matting codes that Microsoft Word {the application used to write 
this book) understands. The resource fork, which is present in all 
applications, desk accessories, control panels, and other "pro
grams," contains resources or bits of programming code that can be 
used over and over by different routines within the program. For 
example, the resource fork for the Microsoft Word application con
tains icons, menus, dialog boxes, programming code, and a variety 
of other information that Word uses. 

By placing reusable code in resources, programmers can: 

• Avoid writing the same code over and over again with in a pro
gram. If a specific dialog box is used five times, for example, the 
programmer doesn't need to write instructions for that dialog box 
five times or in five different places. 

• Make a program easy to localize for different countries. For 
example, to change the menus to Spanish, simply change the 
menu resources. 

• Make a program easy to modify for updates or customization. 
Since each resource can be modified, added, or deleted at any 
time, programs are easy to change. 

That final point is what makes ResEdit such a popular software 
tool for nonprogrammers. With ResEdit and a little knowledge, you 
can customize the Finder, the System, or just about any program. 
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Don't Let ResEdit Zap You! 

ResEdit is a potentially dangerous application. With it, you can modify 
files to the point where they wil l no longer function or cannot be read. 

Never, never, never use ResEctit on your only copy of a file or on 
an original program disk. Doing so is just plain stupid . Don't be stu
pid. Back up your fi les bejo1·e opening them with ResEdit. 

File Attribute Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Every Macintosh file has attributes or settings that are part of the file . 
These include things like the name, type, and creator, creation and 
modification date and time, Finder flags, and label. ResEdit's File Info 
dialog box, which is illustrated in Figure 10.1 , lets you view and change 
these settings . The following section contains a few related tips you 
might find useful . 

See Invisible Files 
This may come as a surprise to you, but the Finder doesn't display all 
the files on your disks. Some ftles, like the Desktop files and support ftles 

· == Info for Desktop 

File: j'oesktop 

Type: IFNDR 

wL 

Creator: I ERIK 

-Jl D Locked 

0 File Locked 0 Resources Locked File In Use: No 
0 Printer Driller Multifinder Compa t ible File Protect ed: No 

Cr eated: I Sun, Apr 17, 1994 

Modified: I Fri , Jan I , 1904 

I Time: la:38: 13 PM 

I Time: 112:00:00 AM 

Size: 27 3 602 bytes in resour ce f ork 
0 bytes in dat a fork 

Finder Flags: ® 7.H 0 6.0.H 

0 Has BNDL 0 No I NITs Label: j None 
~------------~ 

18l_l nuisible 

d'use Custom Icon 
0 Shared 0 lnited 

0 Stationery 0 Alias 

Figure 10.1 ResEdit's File In fo dialog box 
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created by some applications, are invisible. Fortunately, ResEdit (as well 

as a few other applications) lets you see them. Give this a try: 

0 Choose Get File/Folder Info from ResEdit's F ile menu. 

(This exercise should also work with the Open and Verify com
mands under the File menu-any command that displays the 

Open dialog box within ResEdit.) 

0 Use the directory portion of the standard Open dialog box 
that appears to navigate to your hard disk so that the scrolling 

window displays a list of its contents. Figure 10.2 shows an 

example. 

Notice anything you don't normally see? If you' re running System 7, 
you should see the Desktop DB and Desktop DF flies that make up the 
"Desktop" file. (System 6 users will just see a single Desktop file.) You 

might also see invisible fi les created by programs like Adobe Systems' 

ATM, Symantec's Norton Utilities for Macintosh, and Aladdin System's 
Stufflt SpaccSaver. These are all examples of invisible files. T hey're in

visible for a reason: so that you don't mess with them. 

Make Files Invisible 
Out of sight, out of mind . You can usc ResEdit to cook up your own 
mini secw-ity system. Simply make the fi les you want prying eyes to keep 

away from invisible. 

I= Hard Disk ..-1 = Hard Disk 

D Applica tions ~ Ejett 
D ATM SERIAL# 
D Desktop 

1- Desktop 
D Desk top DB ., 
D Desktop OF 
D Documents ( cancel 
D Icon 
D Norton FileSauer Data [ Open 

D System Folder 
~ n Get lnf~ D Telecommunica tions 

0 Use Al ias instead of original 

Figure 10.2 Use ResEdit to see invisible files. 
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0 Choose Get File/Folder Info from ResEdit's File menu. 

0 Use the directory portion of the standard Open dialog box 
that appears to locate the file you want to malce invisible. 

0 Click Get Info. 

G In the File Info window that appears (see Figure 10.1) click 
the check box to turn Invisible on. 

8 Click the close box to close the File Info window. When asked 
to save changes, click Yes. 

Back in the Finder, the icon will be gone. If you try to open the 
document from within an application, it won't appear in the directory 
portion of the Open dialog box. In fact, it'll be downright tough to find 
it without ResEdit. 

To open the file, of course, you'll have to make it visible again. Fol
low Steps 1 through 5 above, but turn the Invisible check box off in 
Step 4 to make the file visible again. 

Make Folders Invisible 
If you want to secure multiple files using the above trick, you might find 
it easier to simply make an entire folder full of files invisible. Use the 
steps above, but get info for a Folder instead of the separate files. The 
Folder Info window that appears (see Figure 10.3) offers fewer options 
but works the same way. 

Delete the Invisible Desktop File 
If you've upgraded from System 6 to System 7 and haven't formatted 
your hard disk since, chances are you'll have Desktop flies in both Sys
tem 6 and System 7 formats. If you don't plan on using System 6 again, 
you can delete the System 6 format Desktop .file , freeing up space you 
probably didn't even realize was in use. Here's how: 

Info for folder Top Secret Stuff 

Folder: I ~Jii~te:f[§[s(\it'fJhC.ld:t~l;;;1lrr"~:tfuifu~i'lJ 0 Locked 

Finder Flags: @ 7.H 0 6.0.H 

[8] lnited ~I nuisillle Lallei: L None 
0 Use Custom Icon '---------r 

Figure 10.3 ResEdit's Folder Info window 



204 Macintosh Slide Triclls 

1;1 

0 Choose Get File/Folder Info fi:om ResEdit's File menu. 

0 Use the directory portion of d1e standard Open dialog box 
d1at appears to navigate to your hard disk so d1at d1e scrolling 
window displays a list of its contents. 

8 Locate the fi le named Desktop and click it to select it. T his is 
shown in Figme 1 0.2. Do not select Desktop DB or Desktop 
DF-these are the System 7 Desktop files! If you cannot find a 
fi le named Desktop, click cancel and skip the rest of d1ese 
steps-you don't have a System 6 Desktop file. 

0 Click Get Info. 

8 In the File Info window that appears (see Figure 10.1) click 
the check box to turn Invisible off. (Note also in Figure 10.1 
that d1e file on this particular system is a whopping 273,602 
bytes!) 

0 Click the close box to close d1e File Info window. When asked 
to save changes, click Yes. 

0 Open your hard disk icon. A plain document icon called Desk
top should be among the other icons there. Drag this icon to 
the Trash and choose Empty Trash from the Special menu to 
get rid of it . 

Change Type and Creator Codes 

ResEdit's Fil e Info window also displays type and creator codes for fi les. 
(You can see this in Figure 10.1.) These codes, which are part of every 
Macintosh fi le, identify the type of file and the application that created 
it. This info rmation is used by the Desktop file. It determines what 
icon appears for a fi le and what application opens it when you double
click it. 

In order to change the type or creator codes, you need to know what 
you want to change it to . Choose Get File/Folder Info from ResEdit's 
File menu see the type and creator codes of a file that already has dte 
codes you want to use. Then choose Get File/Folder Info from d1e 
File menu again to enter those codes into d1e file you want to change. 
Depending on the change you make, the file's icon many change. 
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Why Cha11ge Type a11d Creator Codes? Why would you want to change a 
file's type or creator code? Here 
are some reasons: 

• You want to be able to open a plain text document in your favorite 
word processor when you double-click it. 

• You want to be able to open a plain PICT document in your favorite 
grapt'lics application when you double-click it. 

• You want to convert a regular Teach Text document into a read only 
Teach Text document. 

• The type or creator code is incorrect and you need to fix it. 

• When you double-click the file, you get a message saying your 
Macintosh can't open it because the application that created it 
can't be found. You want to know what application created it. 

The following table provides some common type and creator codes 
you might find usefu l. Remember that type and creator codes are case 
sensitive-be sure to enter them correctly. 

Type 

APPL 

TEXT 

PICT 

TEXT 

ttro 

Creator 

ttxt 

tt.xt 

MSVVD 

MWPR 

XCEL 

dPro 

SPNT 

FMPR 

BOBO 

XPR3 

PPT3 

Description 

Application 

Plain text document 

Plain PICT document 

Regular TeachText or SimpleText document 

Read-only TeachText or SimpleText 
document 

Microsoft Word 

Claris MacWrite Pro 

Microsoft Excel 

Claris MacDraw Pro 

Aldus SuperPaint 

Claris Fi1eMaker Pro 

ClarisWorks 

QuarkXPress 

Microsoft PowerPoint 
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Changing Type and Creator Codes Doesn't Change Document Contents """"~ 

Menu Tricks 

Don' t think that changing a document's type and creator code is all 
you need to do to convert one application's document format to an

other's. Even if you change both type and creator codes, the actual 
contents of the fiJe will determine whether the fi le can be read prop
erly by the application you open it with . Most programs include 

header information in their document files that provide instructions 

that may not be recognized by other programs. So if you change a 

Microsoft Word document to a ClarisWorks word processing docu
ment just by changing these codes, don't be surprised if you get less 

than perfect results. 

You'll tlnd menus in just about any Macintosh application . T hat means 
ResEdit can open and edit MENU resources in almost any application. 

Usc ResEdit to add, change, o r remove keyboard shortcuts, change 

command names, and colorize your menus, like the one in Figure 10.4. 

T his section tells you how. 

Don't Distribute Altered Copyrighted Software 

C hanging the way copyrighted applications work on your Macintosh 
is fine , but disu·ibuting aJtered copies is illcgaJ . Don't make altera
tions to copyrighted software and share them with your fi·icnds or 
work associates. Doing so is most likely in violation of the licensing 

agreement you accepted when you began using the sofu:vare. If 

you' re caught, you can get into big trouble. 



n ~2 

Cut It Out ~H 

Copy it ~c 

Stic:lc h In ~~~ 

Wipe Out S€8 

Get it Rll 3€A 

.fho111 Clipboard S€K 

Figure 10.4 TeachText's 
Edit menu after some 
"ResEditing" 

Add Keyboard Shortcuts 
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As discussed way back in Chapter 1, keyboard shortcuts make it quick 
and easy to access menu commands. Commercial utility programs like 
CE Software's QuicKeys and Now Software's NowMenus enable you to 
add and change keyboard shortcuts, but they must be installed for the 
shortcuts to work. ResEdit lets you add permanent shortcuts to menus. 

0 Choose Open (Command-O) from ResEdit's File menu. 

0 Use the standard Open dialog box that appears to open the ap
plication file you want to change. (Make sure you do not open 
and change the only copy of the file!) 

0 Scroll through the resource types to find the one called 
MENU. Double-click it to open it. 

0 In the resource picker window that appears , double-click on 
the menu you want to change. The menu editor window that 
appears should look something like the one in Figure 10.5. 

0 Click on the name of the command you want to add a shortcut 
to. 

0 In the Cmd-Key edit box, type in the character you want to 

use in conjunction with the Command key to choose that 
command. 
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J i:Ji 3 MENU " Edit " 10 ~ 3 from TeachTeHt 

[Edit1 I Selected I tern: [g) Enabled 
I - Ill ·.· 0! 

•-w•w•~•w--------•-••---w•-----------
! TeHt : ®I whoops ! I 

Cut 3!: H I 
Copy 3!:C I 0 - --(sepBrator line) 

P8ste 3!:U 
Clea r 31: 8 I Color 

--·--·----··---·---·----·-·----·-·---·--- i 0 hBs Submenu TeHt: I I i Select Rll 3!:R 
·-·-·-·----------·-·------------· I Cmd-Key: II] [;;} 

Show Clipboard 3!:K i 
Mark: I ..,,. lo None 

! 

Figure 10.5 T he menu editor window 

0 Repeat Steps 5 and 6 for each of the commands you want to 
add a shortcut to. 

0 Close the menu editor window. 

0 Repeat Steps 4 through 8 for each of the menus you want to 
add sho rtcuts to. 

Cl) Choose Save (Command-S) from the File menu to save 
changes. 

CD Close all document windows. 

The next time you launch that application, the shortcuts you speci 
fied are displayed and can be used. 

Here are a few additional pointers for using this trick: 

+ Don't use a key that is used for another command. If two com
mands use the same keyboard shortcut, the application will use 
the command it fi nds first with that shortcut. 

+ You can remove a keyboard shortcut by deleting the contents of 
the Cmd-Key edit box in Step 6 above. 

+ You can change a keyboard shortcut by typing over the contents 
of the Cmd-Key edit box in Step 6 above. 

Change Command Names 
If addjng shortcuts isn't enough for you, you can also change the name 
of a command on a menu. 
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0 Choose Open (Command-O) from ResEdit's File menu. 

0 Use the standard Open dialog box that appears to open the 
application file you want to change. (Make sure you do not 
open and change the only copy of the file!) 

0 Scroll through the resource types to ftnd the one called 
MENU. Double-dick it to open it. 

0 In the resource picker window that appears, double-click on 
the menu you want to change. The menu editor window that 
appears should look something like the one in Figure 10.5. 

0 Click on the name of the command you want to change. 

8 In the Text edit box, type in a new command name. 

0 Repeat Steps 5 and 6 for each of the commands you want to 
change. 

0 Close the menu editor window. 

8 Repeat Steps 4 through 8 for each of the menus you want to 
change. 

0 Choose Save (Command-S) from the File menu to save 
changes. 

fD Close all document windmvs. 

The next time you launch that application, the command names you 
specified are displayed under each menu. 

Here are a few additional ideas for this trick: 

+ Change the name of the menu itself by clicking on the menu 
name and typing a new name into the Text edit box in Step 6 
above. 

+ Choose a style for a menu command or menu name by clicking 
on it to select it (in Step 5 above) and choosing a style fi·om the 
Style menu. 

+ If the fi le includes ICON or SICN resources, you can place icons 
in front of menu commands by choosing Choose Icon from the 
MENU menu and selecting the icon you want to use. If the ftle 
doesn't have ICON or SICN resources, you can add them. 
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Colorize Your Menus 
If your Macintosh supporrs color, you might want to bri ghten your 
menus up a bit. Here's how. 

0 Choose Open (Command-O) from ResEdit's File men u. 

0 Use the standard Open dialog box that appears to open the 
application file you want to change. (Make su re you do not 
open and change the only copy of the file!) 

0 Scroll through the resource types to find the one called 
MENU. Double-click it to open it. 

0 In the resource picker window that appears, double-click on 
the menu you want to change. The menu editor window that 
appears should look something like the one in Figure 10.5. 

0 Click on the name of the command you want to colorize. 

0 Click on the color box beside Text to display a menu of avail
able colors and choose one. This changes the color of the text 
in the menu. If this is the first time a menu has been colorized, 
a warning dialog box may appear, telling you that an mctb re
source will be created. Click OK. 

0 Click on the color box beside Cmd-Key to display a menu of 
colors and choose one. This changes the color of the command 
key indicator for that command in the menu. 

0 If the menu has a marker to indicate whether it's turned on or 
off, click on the color box beside Mark to display a menu of 
colors and choose one. This changes the color of the marker 
for that menu. 

0 Repeat Steps 5 through 8 for each of the commands you want 
to colorize. 

G) Close the menu editor window. 

G Repeat Steps 4 through 10 for each of the menus you want to 
colorize. 

G Choose Save (Command-S) from the File menu to save 
changes. 

fD Close all document windows. 
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T he next time you launch that application, the menus you colorized 
appear in colo r. 

Finder and System Customization Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
The Finder and System fi les are full of very special resources-resources 

that are used by other applications. T hat means you can customize 

many applications just by customizing a few Finder or System resources. 
Although editing the Finder and System files are not recommended , 

here are a few relatively harmless tricks you can try. 

How to Edit the Finder and System Files 
I 

There's a trick to editing the 
Finder and System files without 
doing permanent damage. 

Be sure to read this sidebar before opening either file with ResEdit! 

• Since ResEdit cannot edit an active Finder, your best bet is to start 
your Macintosh with a boatable floppy or a System folder on an
other mounted volume. Duplicate the Finder and place the Finder 
Copy in another folder for safekeeping. Then edit the original Finder 
file with ResEdit. When you're finished and have saved your 
changes, restart your Macintosh. The Finder that launches at 
startup should be the edited one. Don't delete the Finder Copy, just 
in case the edited one turns out to be bad. 

• Although you can edit the active System file, it isn't recom
mended- it can cause system bombs and permanently corrupt 
your System file. The trouble is, it's also a bad idea to have more 
than one System file on a disk. So here's what you do: Make a copy 
of the System file and editthat. Then copy the unaltered System file 
to a floppy disk or use file compression software to compress it so 
it's saved in another format on the same disk. Drag the unaltered 
System file out of the System Folder and into the Trash. Drag the 
edited System Copy to the System Folder and rename it System. 
Restart your Macintosh. If all goes well, the edited copy ofthe Sys
tem will be recognized and used for Startup. 



212 Macintosh Sticll Tricks 

Change "Welcome to Macintosh" 

The "Welcome to Macintosh" message appears on your screen-pro
vided you don' t have a StartUpScreen installed-whenever you start 
your Macintosh. The information in this screen is stored in a Resource 
inside your System file. You can use ResEdit to change it. 

0 Choose Open (Command-O) from ResEdit's File menu. 

0 Use the standard Open dialog box that appears to open the 
System file. (You've already backed it up, right? ) 

0 Scroll through the resource types to find the one called DSAT. 
Double-click it to open it. 

0 In the resource picker window that appears, locate number 0 
and double-click it to open it. 

0 The editor window appears. It should look something like 
Figure 10.6. Use the scroll bar to scroll down until you see 
"Welcome to Macintosh" in the right column. Use your mouse 
pointer to highlight this text since you will be replacing it. 

G Type in the new message. For best results, it should be exactly 
21 characters long, including the period at the end. If your 
message is shorter than that, add spaces to the end to pad it 
out. If your message is not exactly 21 characters long, the 
Macintosh icon (which is stored in cicn resource - 16396) may 
not appear in the window witl1 the message. 

0 Choose Save (Command-S) from tl1e File menu to save your 
changes. 

000068 
000070 
000078 
000080 
000088 
OOOOQO 
000098 
OOOOAO 
OOOOA8 
000080 
000088 
OClOCJCO 
OOOOC8 
000000 

Figure 10.6 Changing "Welcome 
to Macintosh" 
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0 Choose Quit (Command-Q) from the File menu to quit 
ResEdit. 

When you restart your Macintosh with the edited System file active, 
your message should appear in place of "·Welcome to Macintosh ." 

Change the Trash Name 
Ever notice that you can't rename the Trash from within the Finder? 
You can from within ResEdit. 

0 Choose Open (Command-O) from ResEdit's File menu. 

0 Use the standard Open dialog box that appears to open the 
Finder file . (You've already backed it up, right? ) 

0 Scroll through the resource types to find the one called STR#. 
Double-click it to open it. 

8 In the resource picker window that appears, locate number 
117 50 and double-click it to open it. 

8 The editor window opens. It sho uld look something like the 
one in Figure 10.7. Enter a new name for the Trash in the first 
edit box. 

0 Close the edi tor window. 

0 Choose Save (Command-S) from the File menu to save 
changes. 

~Dr - STR# 10 s 11750 from Finder -

Nu111 Strlngs 

I ) ***** 

20 

The s trIng ~.-1 T_r_as_h ___ ..:.._ _____ -J 

2) ***** 

The s tr ing IThe Tras h is e111 pty . 

3 ) ***** 

The s tring 

~) ***** 

• t fi le~ I XXs% and • 2 
fo l der~2%Xs% are in t he 
Trash=!= . = for a total af •J . 
=·1·s 

Figure 10.7 Finder STR# 11750 contains the 
name of the Trash . 

:' 
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0 Choose Quit (Command-Q ) from the File menu to quit Res
Edit. 

When you restart your Macintosh with the edited Finder file active, 
your Trash icon will have a new name. 

Change the Name of the Trash Everywhere! 
Finder STR# 11750 contains all the strings used in Trash-related dialog 
boxes. If you change the name of the Trash on yam System, why not 
change the text that goes in related dialog boxes? Just replace the word 
Trash with the name you're using in all strings of this resource. You'll 
see your changes in menus and dialog boxes throughout the system. 

Change the Font Sample Text 
When you double-click on the icon for a bitmapped or TrueType font, 
a window with some sample text in that font is displayed. You can 
change this sample text with ResEdit. Figure 10.8 shows an example of 
what you can do. 

0 Choose Open (Command-O) from ResEdit's File menu. 

0 Use the standard Open dialog box that appears to open the 
Finder file. (You've already backed it up, right?) 

=ro Rrchitect 24 
, ... Sample .................... - ...................... ................................... .. ~ 

I How many Macintosh I 
I users really care about I 
i razorback-jumping i 
I frogs & piqued I 
!gymnasts? I 
i i 

! ................................................ "'"""-"""" ............................. ..1 

Figure 10.8 Make the Font sample text say 
almost anything you like. 
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0 Scroll through the resource types to find the one called STR#. 
Double-click it to open it. 

0 In the resource picker window that appears, locate number 
14516 and double-click it to open it. 

0 The edito r window opens. An edit box displays the standard 
sample text: "How razorback-jumping frogs ... , Replace this 
text with text you want to see in the font sample window. 

C) Close the editor window. 

0 C hoose Save (Command-S) trom the File menu to save 
changes. 

0 Choose Quit (Command-Q) from the File menu to quit Res
Edit. 

When you restart your Macintosh with the edited Finder file active 
and double-click a font icon, the text you specified appears in the sample. 

Customize the Desktop Pattern 

T he General control panel offers a basic way to change your desktop 
pattern: Edit the pixels in its window and then click on the miniatu re 
desktop to lock them in . You can go a step further with ResEdit to 
create more complex desktop pattern images like the sample in Figure 
10.9. 

0 Choose Open (Command-O) from ResEdit's File menu. 

0 Use the standard Open dialog box that appears to open the 
System file . (You 've already backed it up, right?) 

0 Scroll through the resource types to find the one called ppat. 
Double-click it to open it. 

8 In the resource picker window that appears, there should be 
o nly one resource inside: 16. Double-click it to open it. 

0 The pixel editor window, which is shown in Figure 10.10, 
opens. It contains an 8 x 8 pixel image of the desktop pattern. 
This is the same size as the desktop pattern editor offered in 
the General contro l panel. 
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G To increase the size of the pattern, choose Pattern Size from 
the ppat menu. The Pattern Size dialog box, which is shown 
in Figure 10.11, appears. Select a larger square pattern. (The 
larger the pattern, the more detail you can include in your desk
top pattern.) Click Resize to change the size and close the dia
log box. 

0 Back in the pixel editor window, use the tools, color palettes, 
and pattern palettes to create your masterpiece. You can choose 
Try Pattern from the ppat menu at any time to see the results 
of your efforts. 

0 When you're finished, choose Save (Command-S) from the 
File menu to save changes. 

Figure 10.10 The ppat 
pixel editor 
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Pattern Size 

16 I Ill 1• 1 
32 I I 
64 II 
[Cancel ) G&J 

Figure 10.11 The Pattern Size 
dialog box 

0 Choose Quit (Command-Q) from the File menu to quit Res

Edit. 

\iVhen you restart your Macintosh with the edited System file active, 

you'll see your custom desktop pattern. 

Paste in a ppat 
What? You're no artist? Fortunately, there are artists out there who like 
to share their ppats with us. That's where the Cab Calloway example in 
Figure 10.9 came from . Check online services and local BBSes for ppat 

files. Open them with ResEclit and paste them into your System file . Be 

sure it's assigned resource ID 16 when pasting it in . (You can change a 

resource ID number by choosing Get Resource Info from the Re

source menu when the resource is selected.) 

AddFKEYs 
FKEYs are tiny programs that you install in your System file and access 
with Command-Shift-number key combinations. Apple has four 

built-in FKEYs, which were covered in Chapter l. The~' use the Com
mand-Shift-1 , Command-Shift-2, Command-Shift-3, and Command
Shift-a key combinations. That leaves you with 4 through 9 for your 
own. 
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You can find FKEYs on online services and BBSes. They perform a 
variety of tasks: capturing the screen, formatting clipboard text , quit
ting the Finder, etc. Once you get an FKEY, you'll need to install it. 
Here's how. 

0 Choose Open (Command-O) from ResEdit's File menu. 

0 Use the standard Open dialog box that appears to open the 
System file. (You've already backed it up, haven't you?) 

8 Scroll through the resource types to find the one called FKEY. 
Double-click it to open it. 

0 In the resource picker window that appears, you should see all 
the installed FKEYs. The ID corresponds to the number key 
you need to press with Command and Shift to activate the 
FKEY. If you have not added any FKEYs to your System ftle, 
there should be only one: ID 3 . 

8 Choose Open (Command-O) from the File menu. 

0 Use the standard Open dialog box that appears to open the 
document containing the FKEY you want to install. 

0 You should see an icon for FKEY resources. Double-click it to 
open it. The resource picker displays all the FKEYs in the file. 
There may be only one. 

0 Click on the ID for the FKEY you want to install to select it. 

0 Choose Copy (Command-C) from the Edit menu. 

Cl) Click on the System file's FKEY resource picker window to 
make it the active window. 

fD Choose Paste (Command-V) from the Edit menu. The FKEY 
is pasted into your System file. If a dialog box appears asking if 
you want to replace resources with the same ID, click Unique 
ID to have ResEdit assign a different ID number (usually 
128 ). Then choose Get Resource Info from the Resource 
menu to change the ID to an unused number between 4 and 9. 

CD Choose Save (Command-S) from the File menu to save 
changes. 
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G Choose Quit (Command-Q) from the File menu to quit Res 
Edit. 

'When you restart your Macintosh with the edited System file active, 
you'll be able to use your new FKEY. 

Remap Keyboard Keys 

It's four o'clock on a Friday afternoon and you're on United Flight 67 
from Chicago. Your PowerBook is on your tray table and you're work

ing franticaJJy on a report your secretary will pick up at the airport. After 
handing it over on disk, you're going to hop onto Flight 329 to Hono
lulu for a two-week vacation in paradise. Suddenly, your K key stops 
working. No matter what you do, you can't get your keyboard to pro
duce the let ter K. Vi/hat do you do? 

If you have ResEdit handy, you can remap the Keyboard so that the 
K key can be accessed by pressing another key, like the ' or\ key. Here's 
how: 

0 Choose Open (Command-O) from ResEdit's File menu. 

0 Use the standard Open dialog box that appears to open the 
System fi le. (You've already backed it up, right? ) 

8 Scroll through the resource types to find the one called 
KCHR. Double-click it to open it. 

8 In the resource picker window that appears, click once on the 
name of the keyboard layout you are using to select it. 

0 Choose Duplicate (Command-D ) from the Edit menu. This 
copies the keyboard layout so you can easily switch back to the 
original once the key is fixed. If desired, choose Get Resource 
Info from the Resource menu and give the resource a new 
name. Then close the Resource Info window. 

C) Do uble-click the copy of the keyboard layout to open it. The 
main KCHR editor window appears. It looks like the one in 
Figure 10.12 . 

0 With Table 0 selected on the far right side of the window, find 
the letter k (lowercase) in the large box of keyboard characters 
on the left side of the wi11dow. Use your mouse to drag the k 
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Figure 10.12 The main KCHR editor window 

to the keyboard layout of characters below it and drop the k 
onto the keyboard key you want to use to type fl. This maps 
the lowercase k to that keyboard key. 

0 Click on Table l on the fa r right side of the window. Click 
OK in the confirmation dialog box that appears. Find the let
ter K (uppercase) in the large box of keyboard characters on 
the left side of the window. Use your mouse to drag the K to 
the same keyboard key you used for the lowercase character. 
This maps the uppercase ](to that keyboard key when the shift 
key is pressed. 

8 Choose Save (Conunand-S) from the File menu to save 
changes. 

0 Choose Quit (Command-Q ) from the File menu to quit Res
Edit. 

fD Restart your Macintosh with the edited System file active. 
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G) Use the Keyboard control panel to select the new keyboard 

layout you edited. ' 'Vhen you press the key you remapped the 
character to, the character appears on your screen . 

Miscellaneous ResEdit Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
ResEdit has a lot more tricks up its sleeve. Here are a few of the more 

interesting ones. 

Check Resources 
ResEdit autontatically performs a partial test of resources when it opens 

a ri le. If it tlnds a problem, it performs a full test. To force ResEdit to 

perform a full test of every file it opens: 

0 Choose Preferences from the File menu. 

0 In the Preferences dialog box that appears (see Figure 10.13), 

turn on the check box for Verify files when they are opened. 

0 C lick OK. 

Once this is turned on, ResEdit will d isplay a progress box as it veri

ties each file it opens. 

Preferences 

Window at startup: 0 None 
®Open dialog 

[8] Show splash-screen at startup 
[8] Warning when System or ResEdit i s opened 
[g! Uerify files when they are opened 
!8tshow color r esources on best screen 

[8] Auto-size pickers Width Height 

Minimum: Type pickers: 1225 1~~ ~ piHels 

Resource picker s: ~ 11 ~ pille ls 

(( OK D 

Figure 10.13 ResEdit's Preferences dialog box 
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Verify Only Certain Files 

If you don' t want to verify every single fi le, keep the Verify files as they 
are opened check box turned off in the Preferences dialog box. In
stead, choose the Verify command from the File menu to verify a flle 
you select. The same progress box wi ll appear. 

Add Version Info to Files 

Most applications have version numbers. They are displayed in the 
Finder's Get Info window, as illustrated in Figure 10.14. Version num
bers are stored in vers resources. You can use ResEdit to edit them or 
to add vers resomces to fi les that don't have them-even document 
files! This is a great way to add "comments" that aren't lost when you 
rebuild your desktop. 

0 Choose Open (Conunand-0) from ResEdit's File menu. 

8 Use the standard Open dialog box that appears to open the 
fi le you want to edit. (Make sure you do not open and change 
the only copy of the fi le!) 

0 If the file is a document, it may not have a resource fork. In 
that case, you ' II see a diaJog box telling you that to open the 
document, ResEdit will add a resomce fork. Click OK. 

!!!105 DSAT " Welcome to Mac " lnf ~ 

I~ 
D DS.I.T "11'11<"""' to M~c'' 

I[) *2 90<"S h9rt. 

Kind: do•UMt.nt 
9'-:: 42k pn dirk (40 ,235 b~1ol orood) 

Y b-: Hord Di•l: : D6oumtn1s: M•c Slfck 
Tricks . SoramShot• . Ch~tor 10 
Ffgur<~>: 

Crut..,.t: Thu, "Jlr:28, 1994, 9:30 AM 
H•41f'letl: Thu, Apo• 29, I 994 1 4 :i ~PM 
Y...-s;iaa ; I) 'WI ()DOS' hoP' e. 

Cami'Mftia: 

I•Ot.onl:ood 

Figure 10.14 The Get Info 
window displays version 
information in two places. 
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0 Look for a resource type named vers. If you find it, double
click it to open it. Then double-click the resource with an ID 
of 1 to open it. If there are no vers resources, choose Create 
New Resource (Corn.mand-K) from the Resource menu. In 
the scrolling list of resource types, choose vers and click OK. 
ResEclit creates a new vers resource with ID 128 and opens 
the vers resource eclitor, which is shown in Figure 10.15. 

0 Enter the appropriate version information. The information in 
the bottom edit box is what appears in the Finder's Get Info 
window. When you are finished, close the eclitor window. 

G If necessary, choose Get Resource Info (Command-!) from 
the Resource menu to change the vers resource ID to 1. 
While in the Resource Info window, also turn the Purgeable 
check box on. Close the Resource Info window when you're 
finished . 

0 Follow Steps 4 through 6 to edit or create vers resource ID 2. 

0 Choose Save (Command-S) from the File menu to save the 
changes. 

0 Choose Quit (Corn.mand-Q) from the File menu to quit Res
Edit. 

When you open the Get Info window for the file in d1e Finder, you 
should see the information you entered. 

1[1~ uers 10 = 1 from DSRT "Welcome to Moe • ~ 

Uersion number: !DJ. D . ~ 
Release:! Deuelopment .,... I Non-release: [Q 

Country Code:! 00 - USR .,...I 

Short uersion string: l'-1_.2_d_1 ______ __. 

Long uersion string (ulslble in Get Info): 

110 #1 goes here. 

Figure 10.15 The vers editor window 
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Edit Icons 
ResEdi t is probably most often used by nonprogram mers as an icon edi
tor. If offers a number of tools that make icon editing easy. Give it a try. 

0 Choose Open (Command-O ) from ResEdit's File menu. 

0 Use the standard Open dialog box that appears to open the 
file you want to edit. (Make sure you do not open and change 
the only copy of the file! ) Don' t bother opening a document 
fi le looking for an icon. All icons are stored in creator's applica
tion file or System fi le. 

8 Look for one of the following resource types: idS (256-color 
icon), ic14 (16-color icon), or ICN# (black and white icon). 
Double-click on the icon for the resource you want to edit. 

8 All the icons for that resou rce are displayed. Figure 10.16 
shows all the idS resources inside the System file . Double-click 
on the icon you want to edit. 

8 The icon editor, which is illustrated in Figure 10.17, appears. 
Use its tools, color palettes, and pattern palette to ed it the icon. 

=o-= = "31 iciBs from Syst em copy ·~~ 

[%] ~ ~ ~ m ~ 
~ 

_/ ca/ .. c:::::::ID 

- 32512 -32511 - 16509 -16508 - 16507 -16506 -16505 - 16504 -1 6503 

~ Lm 1- ;;:) 1~1 ~ Q GJ D D 
-1 6502 -1 6494 - 16486 - 16485 - 16484 - 16483 -16482 - 16415 - 4000 

D u ~ ClJ [I ~ l~4t~l Q ({) 
-3999 -3998 - 3996 -3994 -3993 -3991 -3989 -3985 -3984 

cru w @] D C)j Q UID 
~ Ga cru 

-3983 -3982 -3981 -3980 -3979 -3978 -3977 -3976 -3975 

~ LQ] ~ C1J Q 'o -
- 3974 - 3973 -3971 - 3968 3 ~ 

Figure 10.16 icl8 resources in the System fi le 
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(1 

Figure 10.17 Editing the Trash icon 

[IJ~ 
ICN• 

[I] [I] 
icse 

ic18 

[1][00 
1054 

io14 

[I]!J 
Mask 

G When you've finished editing one kind o f icon, position your 
mouse pointer over it's small image o n the right side of the 
window. T here should be a dark border around it already. Drag 
this icon onto each of the other icon boxes on the right side of 
the screen, one at a time. This copies your changes to the 
other resources in the icon family without you having to 
change them all manually. Colors are adjusted accordingly 
(that's why it's a good idea to eclit the icon with the most col

o rs first). 

0 Choose Save (Command-S)from the File menu to save the 

changes . 

0 Choose Quit (Command-Q) from the File menu to quit Res
Edit. 

The changes you m::~de wi ll either appear immediately or after you 
rebuild the Desktop. 

Paste in an Icon 
Just as you can paste in ppat resources (as discussed above), you can 
paste in various icon resources. Icons are widely available on online serv
ices and BBScs. Why spend hours fiddling around with pixel eclitors 
when you can simply paste in color icons created by artists who know 
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what they're doing? Just remember to use the Get Resource Info 
(Conu11and-I ) command from the Resow·ce menu to be sure the icons 
have the proper ID and are purgeable. 

Steal Sounds 
Docs your favori te Macintosh shoot-'em-up arcade game make all kinds 
of cool sounds? Where do you think those sounds are stored? In snd 
resources , of course! You can usc R.esEdit to copy them out of applica
tions and paste them into your System file where you can use them as 
system alert sounds. Here's how. 

0 Choose Open (CollUlland-0) from ResEdit's File menu. 

0 Use the standard Open dialog box that appears to open the 
fi le containing sounds you want to steal. (Make sure you do 
not open and change the only copy of the file!) 

8 Look for a resource type called snd. Double-click on its icon. 

0 The resource picker that appears lists all the snd resources in 
the file. C lick on one to select it and choose Try Sound 
(Command-T ) from the snd menu to listen to it. 

0 To copy the sound, choose Copy (Command-C) from the 
Edit menu . 

0 Choose Open (Command-O ) from ResEdit 's File menu . 

Hints for Sound Thieves If you'd like to start collecting sounds but don't know 
where to find them other than in game files, here are 
some hints: 

• Have you ever completed the puzzle in the Puzzle DA? 

• Did you know that Res Edit can grunt like a pig? 

• Do you use America Online? Or a FirstCiass BBS with a really cool 
settings file? 

• Has anyone ever asked you to turn down the sound on your screen 
saver? 
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<:;1 Start pig- mode? 

(Cancel ] 

Figure 10.18 Start Pig Mode? 

0 Use the standard Open dialog box that appears to open a copy 
of your System file. 

0 Choose Paste (Conunand-V) from the Edit menu to paste 
the sow1d into the System file. If a dialog box appears offering 
to give the sound a unique ID, click Unique ID. 

0 Repeat Steps 4, 5, and 8 to copy sounds from one file and 
paste them into your System file. 

C/) Choose Save (Command-S) from the File menu to save 
changes. 

4D Choose Quit ( Conunand-Q ) from the File menu to quit 
Res Edit. 

Mter you restart your Macintosh with the edited System file active, 
you can use the Sound control panel to select from among your new 
sounds. 

Enter Pig Mode 
What would a chapter about ResEdit be without mentioning Pig Mode? 

Hold down Command-Option-Shift and choose About ResEdit 
from the Apple menu. Your Macintosh grunts and opens a dialog box 
like the one in Figure 10.18. Click OK Your Macintosh will grunt pe
riodically as you work. When you get tired of it, hold down Command
Option-Shift and choose About ResEdit from the Apple menu again. 
This time, the dialog box lets you turn off the oinking. 
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for finding files to 
synchronize 175 

for finding old files 46-47 
using 29 

Find File desk accessory 29 
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Finder 
customization tricks 211-221 
force quitting 186-187 
precautions for editing 211 
tricks 1-25 

FinderEdit 80 
FirstClass 

and graphic user interfaces 
120 

and online multitasking 127 
sounds 226 

FKEY resources 217-219 
FKEYs 

adding 217-219 
built-in 3-4 
for screen shots 4, 157 

floppy disk 
cleaning drives 183 
ejecting at start up 191 
ejection tool 191 
locking 148, 182 
tricks 147- 149 
using high density in low 

density drives 148- 149 
folders 

calculating sizes 16 
in the Apple menu 40-41 
making invisible 203 
printing contents 156-157 

Font/DA Mover 
to install or move desk 

accessories 58 
to remove desk accessories 

40 
fonts 

changing sample text 
214-215 

disabling substitutio n 158 
removing seldom-used 66 
tricks 63- 67 
used on screen 64 
used to print 159 
utility softw·are 67 

force quitting 
applicatio ns 106-107 
Finder 186-187 

Franco, Josh and Nick 43 
Freesoft Company 110 
function keys 2-3 
FWB Incorporated 143 

G 

General control panel 70 
GEnie 

and the Internet 116- 117 
Get Info command 

and version info 222-223 
finding o riginal files 37-38 
for changing RAM allocation 

85,87-88,195-196 
for creating templates 

(stationery) 90-91 
tricks 20-24 

Get Info comments 
adding 21 
and rebuilding the desktop 185 

GIFConverter 61 
Golden Triangle 145 
Goodman, Bill 51, 123 
GraphicConverter 61 
grid 

H 

reversing settings 12 
snap to 16 
straight or staggered 15 

HandsNET 
and the Internet 11 7 

Hara, Keisu ke 79 
Hard Disk Toolkit 143 



hard disk 
allocation blocks 142 
and SCSI rules and 

regulations 147 
compression 145 
external 146 
disposing 146 
finding and using hidden 

space 143-145 
icon 190 
internal 146 
parti tions 141- 143 
reformatting 18 7 
tri cks 141-147 
upgrading 146 

hardware 
miscellaneous tricks 152- 15 3 
tricks 139- 153 

IBM-compatible 
file compression 134-13 5 
file names 28, 131 
readi ng and writing disks 

132-133 
icl4 resources 224 
icl8 resources 224 
ICN# resources 224 
icons 

changing 23, 225-226 
changing name size 15 
cleaning up 10- 11 
copying 12 
editing 224-225 
hard disk 190 
list view size 16 
multiple tricks 12-14 
moving or copying multiple 

14 
opening 5-6 

Index 235 

renaming 5 
selecting 4- 5, 13- 14 

indents 
using co rrectly in work 

processors 96-98 
vs. margins 98 

INIT Conflicts 62 
!NITPicker 62 
Inline Design 62 
Inline Designs/Microseeds 

Publishing 174 
Inline Sync 174 
Insignia Solutions 135 
Internet 

and e-mail 116- 117 
and NewtonMail 177- 178 
fo r communicating with 

others worldwide 115 
on BBSes 112 
to contact the White House 

and Congress 118 
interrupt button 153 
invisible characters 

K 

viewing in work processing 
ftles 95 

KCHR resource 2 19- 221 
Key Caps desk accessory 64-65 
key symbols 3 
Keyboard control panel 77- 78, 

221 
Keyboard Plus 151 
keyboard 

adding keys 150- 151 
commands 3-4 
customi zing 77 
extended 2-3, 6-7, 150-1 51 
remapping keys 219-221 
shortcuts 2 
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keyboard ( co1l~d) 
skin 184 
switching key layouts 78 
tricks 1- 9, 150- 151 

Kremers, Berrie 151 

L 

Label control panel 17- 19 
labels 

changing the colors of 18- 19 
control panel 17- 19 
customizing 17 
tricks 17-19 

LaCie, Inc. 143 
LaserWriter 

disabling font substitution 
158 

page setup 166 
options 157-158 

Leader Technologies 17 4 
Lemke, Thorstcn 61 
Loodle 43 

M 

Mac Check 
getting for free 196 
using 192- 195 

MacDraw Pro 
type and creator codes 205 

macros 
in applications 103- 104 
for logging on to online 

services 114 
utility software 103 

MacTools 49, 51, 190, 196 
MacUser 181 
MacWEEK 181 

Mac World 181 
MacWrite Pro 

type and creator codes 205 
using indents correctly 96-98 
using tabs correctly 95- 96 
viewing invisible characters 

95 
maintenance 

and troubleshooting tricks 
179-198 

cleaning floppy drives 183 
cleaning plastic parts 184 
cleanup tricks 183-184 
dust 183 
miscellaneous tricks 187 

Map control panel 
adding a city 76 
colorizing 76-77 
for finding the distance 

between two cities 75 
for finding the middle of 

nowhere 77 
for localizing a Macintosh 75 
scrolling tl1rough locations 

76 
tricks 7 5-77 
zooming in 76 

MasterJuggler 67 
Maxima 74 
MCI Mail 

and the Internet 117 
Memory control panel 70- 73, 

170-171 
MENU resources 206-21 1 
menus 

adding keyboard shortcuts 
207-208 

colo rizing 210-211 
changing command names 

208-209 
customizing in America 

Online 121 
customizing in Word 104-105 



customizing with RcsEdit 
206- 211 

tricks 206- 211 
MicroMac Technologies 141 
MicroPhone 110 
Mitchell , Kevin 61 
mobile 

tricks 167 
Mode32 72 
modems 

and faxes 113 
defined 110 
for exchanging cross-platform 

information 131-132 
null 132 
speeds 112 

monitor 
tricks 67- 69 
working with more than one 

68- 69 
monitor 

avoiding static cling ISO 
screen savers 149- 150, 151 
tricks 149- 15 0 

Monitors contro l panel 67-69 
Mountlmage 83-85 
Mouse control panel 78 
mouse 

customizing 78 
keeping clean 184 
pad 151 
tricks 150- 151 
vs. trackball 151 

Mt.Image 83 

N 

network 
and AppleTalk Remote Access 

(ARA) 137 
and PRAM 198 

Index 237 

tile sharing 136 
mounting volumes with 

aliases 135 
opening folders or volumes 

with aliases 135 
tricks 135- 137 

Newton 167 
and the Internet 178 
backing up to a Macintosh 

177 
ConncctionK.it 167, 177 
Easter eggs 178 
improvi ng handwriting 

recognition 176 
in the comics 178 
reading your own 

handwriting 177 
shareware 177 
tricks 175- 178 
using NewtonMail 177-178 

Night Cou.rt 175 
Norstad, John 182 
Norton Backup 51 
Norton Utilities for Macintosh 

49, 51, 190 
Notepad desk accessory 

removing from Apple menu 40 
NovaLink Pro 

and graphic user interfaces 
120 

Now Compress 51, 124, 145 
Now Sofu:vare 41, 51, 62, 67, 

124, 129, 145, 156 
Now Utilities 41 , 62, 67, 196 
NowMenus 41 , 129, 156 

0 

O CR 
with fax modem sofuvare 

113, 130 
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OncNet 
for communicating with 

others worldwide 115 
on BBSes 112 

online service 
choosing 111 
defined 110 
practicing for free 115 

optical character recognjtion 
with fax modem softvvare 

113, 130 
Option key 

tricks 9-12 
o utlines 

expanding and collapsing 6 

p 

Patterson, Bill 43 
PC Exchange 135 
PICT 

for screen shots 4 
type and creator codes 205 

PopChar 66 
PostScript 64, 67, 159 
power 

and surge suppresser 180 
and uninterrupted power 

supply (UPS) 180 
protection tricks 179-180 
shutting down during 

thunderstorms 180 
power user 

customization tricks 199- 227 
Power Book 

adding extended keyboard 
keys 150- 151 

and AppleTaU< Remote Access 
(ARA) 137, 174 

conn ecting to a desktop 
Macintosh 173-174 

mo nitoring battery power 168 
putting to sleep 168-169 
ru nning down the battery 173 
starting from a RAM rusk 172 
synchronizing files 17 4 
tricks 168-175 
tu rning down brightness 172 
using a RAM disk 170- 171 

PowerBookcontrol panel 169-170 
PowerMerge 174 
Power Point 

type and creator codes 205 
ppat resource 

editing 21 5-217 
pasting in 217 

PRAM 
explained 197 
zapping 197-198 

preferences 
to customize applicatio ns 104 

printing 
a folder's contents 156-157 
a picture of tl1e screen 157 
and automatically shutting 

down 162-163 
automation tricks 158-163 
batches of fi les 158-160 
closer to the edge of the 

paper 157-158 
disabling font substitution 158 
faster 163-164 
in black and white 163 
in grayscale/ color 163 
in various qualities 163-164 
later 160- 161 
o utput tricks 155-158 
resource saving tricks 

163- 166 
saving ink and toner 164-165 
saving paper 165-166 
saving time 163-164 
tricks 155- 166 

PrintMonitor 



cancelling a print job 
161- 162 

described 162 
installing 56 
launching manually 162 
setting print time 160- 161 
shuttin g down after printing 

162- 163 
Prodigy 

and graphic user in terl~ccs 120 
and the Internet 117 
descri bed 110 

programmer's s·witch 153 
Publish and Subscribe 101-102 
Put Away com mand 25, 33 
Puzzle desk accessory 

Q 

customizing 42-43 
removing from Apple menu 40 
sounds 226 

Q uarkXPress 
and style sheets 99 
printing in various q uali ties 

163-164 
type and creator codes 205 

question mark icon 
and SCSI addresses 190 
why it appears 189-190 

QuicKeys 103, 129, 151, 156 
qui tting by force 106-1 07, 

186-187 

R 

RA1V1 
adding slots 140-141 
allocation 22, 195-196, 196 

Index 239 

allocation tricks 85-88 
and extensions and control 

panels 62 
and force quitting 107, 187 
and system bombs or errors 

196 
buying SI.iv1Ms 139-140 
defragmenting 74 
disks 73-74,170-171,172 
disposing 14 1 
examinin g usage 70 
fragmentation 73 
installing 140 
tricks 69-74 

RAMDoubler 73 
Read Me file 82 
Res Edit 

descri bed 200 
for adding FKEYs 217-2 19 
for adding keyboard shortcuts 

to menus 207- 208 
adding versio n in fo 222-223 
for changing command names 

o n menus 208-209 
for changing fi le attribu res 

201- 206 
for changing font sample text 

214-21 5 
for changing the name of the 

Trash 213-214 
for changing type and creator 

codes 204-205 
for changing "Welcome to 

Macintosh" message 
212-213 

for checking resources 221, 
222 

for colorizing menus 210-211 
for custo mizing menus 

206-211 
for customizing the desktop 

pattern 215-217 
for editing icons 224-225 
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Resedi t ( cont'd) 
for making files invisible 

202-203 
for making folders invisible 

203 
for making invisible files 

visible 201-202 
for pasting in icon resources 

225-226 
for remapping keyboard keys 

219-221 
for stealing sounds 226--227 
for verifying files 221, 222 
miscellaneous tricks 221-227 
Pig Mode 227 
sounds 226 

restart bu non 15 3 

s 
Sad Mac 

understanding codes 188-189 
screen savers 

built-in 151 
practical 149- 150 
reasons for using 151 

screen shot 
creating 4 
printing 157 

SCSI 
addresses 190 
rules and regulations 147 

Seinfeld 175 
Seinfeld, Jerry 175 
selecting 

all icons in a window 13 
almost all icons in a window 

13-14 
icons 4-5 
icons in oudine view 14 
multiple icons 13 

selection box 13 
self-extracting archives (SEAs) 

124 
shutting down 

automatically after printing 
162-163 

before connecting devices 152 
during thunderstorms 180 

Silverlining 143 
SIMMdoubler II 141 
SIMMs 

adding slots 140-141 
buying 139-140 
disposing 141 
installing 140 

Simple Text 
for opening PICT files 4 
for printing PICT files 157 
included with System Update 

3.0 57 
type and creator codes 205 

SITComm llO, 114 
smileys 118 
smoking 183 
snd resources 226-227 
Soft\:vare Ventures Corporation 

110 
software 

custom installation 82-83 
installation tricks 81-85 
installing without swapping 

disks 83-85 
tricks 81-107 

Sound control panel 19-20 
sounds 

and America Online 226 
and a FirstClass BBS 226 
and Puzzle desk accessory 226 
and ResEdit 226 
and screen savers 226 
at startup 188 
recording 20 · 
stealing 226-227 



t ricks 19-20 
turning off 19-20 

space character 
in file names 30 

special characters 
fi nding and using 64 
in file names 30 
uti li ty for 66 

Speed D isk 49 
Speedy Finder 7 80 
spelling checker 

for proofreading 100 
spring cleaning tricks 46-49 
start up 

and ejecting d isks 19 1 
and question mark icon 

189-190 
and Sad Mac 188-189 
and weird sounds 188 
bombs 190 
customizing "Welcome to 

Macintosh" message 
2 12-213 

disable system extensions 
at 61 

fi·om a RAM disk 172 
from the Install disk 54 
tricks 60-63 
troubleshooting u·icks 

187-19 1 
Startup D isk control panel 79 
Startup Items Folder 63 
Startup Manager 62 
startup screen 

customizing 6 1, 212-213 
statio nery pad 

creating with Get In fo 22, 
90-91 

creating with Save As 91 
in ClarisWo rks New 

Document dialog box 94 
in Microsoft Excel Ne\v dialog 

box 93 

btdex 241 

in M icrosoft Word ·work menu 
9 1-93 

Stein, Adam 80 
Stone, Judge Harry 175 
Stufflt Deluxe 51, 123 
Stufflt SpaceSaver 145 
style sheets 

in work processors 98-99 
Suitcase 67 
SuperATM 67 
SupcrDrive 132-133, 148-149 
SuperLaserSpool 162 
SuperPaint 

for creating startup screens 61 
type and creator codes 205 

surge suppressers 
for power 180 
for telephone lines 180 

Switcher 70 
Symantec Corporation 49, 51, 

190, 196 
SyQuest cartridges 44, 72 
System 

customization tricks 211-221 
precautions fo r editing 211 
tricks 53-80 

System 7 Companio n Pack! 80 
System 7 Pack! 80 
System Folder 

backing up 197 
maintaining more than o ne 79 

System software 
and question mark icon at 

startup 189-190 
custom installatio n 54-56 
deinstalling 59 
Easy Install 55 
installatio n and upgrade tricks 

53-60 
install ing o n another disk 59 
Min System 56 
o ptimizer uti lities 80 
reinstalling 57-59 
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System Update 3.0 57 
system heap 62 

T 

tabs 
types of 96-98 
using correctly in work 

processors 96-98 
Tan, Victor 80 
Teach Text 

deleting 48 
for opening PICT files 4, 205 
for printing PICT files 157 
type and creator codes 205 

telecommunications 
abbreviations 119 
and call waiting 113- 114 
and graphic user interfaces 

119-120 
and networking tricks 

109-137 
automating log on 114 
basics 110 
connection speeds 113 
file traruer protocols 124 
local echo 114 
log on tricks 111-114 
navigation commands 120 
onJjne multitasking 127 
online time tricks 120- 128 
pausing and continuing text 

streams 119 
reading and writing messages 

offline 121-123 
smileys 118 
software 110 
staying o nHne for free 

127-128 

TcleFinder 
and graphic user interfaces 

120 
templates 

creating with Get Info 90-91 
creating with Save As 91 
in ClarisWorks New 

Document dialog box 94 
in Microsoft Excel New dialog 

box 93 
in Microsoft Word Work menu 

91-93 
tricks 90-94 

The Well 
and tl1e Internet 117 

TimesTwo 145 
Toner Tuner 165 
toner 

getting more out of a 
cartridge 164 

recycled cartridges 165 
saving 164-165 

tool bars 
customizing 104-105 

trackbaU 151 
Trash 

changing the name 213-214 
emptying quickly 10 
stopping tl1e warning 22-23 

troubleshooting 
miscellaneous tricks 195- 198 

Trudeau, Gary 178 
TrueType 63, 159 
tutorials 

for learnjng applications 104 
type and creator codes 

and document contents 205 
changing 204-205 
commo nly found 205 
reasons to change 205 

type-ahead buffer 8-9 



u 

uninterrupted power supply 
(UPS) 180 

v 

view 
changing list 16- 17 
customization tricks 14-16 
list icon size 16 
menu optio ns 16 
other tips 16- 17 
specifYing for new folder 17 

Views control panel 12, 14-16, 17 
virtual memo ry 71-72 
viruses 

anti -viral software 181-182 
learning abo ut 181- 182 
locking disks to protect 

against 148, 182 
locking files to protect 

against 22 
protection tricks 181- 182 
spreading the word about 182 

w 

Weisman, Dan 80 
White Knight 110 
Windows 

file compression 134- 135 
fi le names 28, 131 
reading and writing disks 

132- 133 
windows 

closing all 10 

btdex 243 

displaying its menu 12 
moving "vvithout making 

active 12 
opening one while closing 

another 10 
scrolling with the keyboard 

6- 7 
zooming to fill the screen 11 

Word 
and Publish and Subscribe 

101- 012 
and style sheets 99 
and templates (stationery) 

91-93 
customi zing menus 104 
type and creator codes 205 
using indents correctly 96- 98 
using tabs correctly 95-96 
viewing nonprinting 

characters 95 
word processors 

and invisible characters 95 
and indents 96- 98 
and tabs 95-96 
tricks 94-100 

Working Software, Inc. 165 
VVYSfWYG Menus 67 

X 

XModem 124 

z 

Z iplt 135 
ZModcm 124 
ZTcnn 110 
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